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Preface 
 

Vocational Education is a dynamic and evolving field, and ensuring that every 

student has access to quality learning materials is of paramount importance.  

The journey of the PSS Central Institute of Vocational Education (PSSCIVE) 

toward producing comprehensive and inclusive study material is rigorous and 

time-consuming, requiring thorough research, expert consultation, and 

publication by the National Council of Educational Research and Training 

(NCERT). However, the absence of finalized study material should not impede 

the educational progress of our students. In response to this necessity, we 

present the draft study material, a provisional yet comprehensive guide, 

designed to bridge the gap between teaching and learning, until the official 

version of the study material is made available by the NCERT. The draft study 

material provides a structured and accessible set of materials for teachers and 

students to utilize in the interim period. The content is aligned with the 

prescribed curriculum to ensure that students remain on track with their 

learning objectives.  

 

The contents of the modules are curated to provide continuity in education and 

maintain the momentum of teaching-learning in vocational education. It 

encompasses essential concepts and skills aligned with the curriculum and 

educational standards. We extend our gratitude to the academicians, vocational 

educators, subject matter experts, industry experts, academic consultants, and 

all other people who contributed their expertise and insights to the creation of 

the draft study material.  

 

Teachers are encouraged to use the draft modules of the study material as a 

guide and supplement their teaching with additional resources and activities 

that cater to their students' unique learning styles and needs. Collaboration and 

feedback are vital; therefore, we welcome suggestions for improvement, 

especially by the teachers, in improving upon the content of the study material.  

 

This material is copyrighted and should not be printed without the permission 

of the NCERT-PSSCIVE.   

 

 

Deepak Paliwal 

Joint Director 

PSSCIVE, Bhopal 

Date: 7 November 2024 
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Module 1 

 

           3D Animation 

 

 

Module Overview 

 

 

This module provides a comprehensive understanding of essential skills and 

techniques in Maya, covering the core principles of 3D modelling, texturing, materials, 

and lighting effects. It offers practical knowledge to create and enhance realistic 3D 

models using Maya’s powerful tools. 

 

The module begins with Session 1, “Essential Skills Movie Window in Maya,” 

introducing Maya's interface and foundational tools through the Essential Skills Movie 

window. This interactive guide quickly familiarizes users with the software's key 

functions and navigation. 

 

In Session 2, “Introduction to 3D Modelling,” the focus shifts to core concepts of 3D 

modelling, teaching how to create both basic and complex objects using Maya’s 

modelling tools. 

 

Session 3, “Texturing Using Shaders,” covers how to apply textures to models using 

different shader types, enhancing the visual appeal by manipulating UV Maps and 

material properties. 

 

Session 4, “Maya Material,” centres on mastering Maya’s material editor, enabling the 

creation of realistic materials and applying them to 3D objects. 

 

Session 5, “Real Life 3D Model,” offers a hands-on experience where learners replicate 

real-world objects as 3D models, applying skills learned in previous class. 

 

In Session 6, “Properties of Surface Materials,” learners explore characteristics of 

various surface materials, such as reflectivity, roughness, and transparency, which 

are essential for achieving realistic textures in 3D models. 

 

Session 7, “Effect of Lighting Conditions on Surfaces,” demonstrates how different 

lighting setups affect surface materials. Natural and artificial sources create unique 

effects. This allows for experimenting with lighting to make models look more realistic. 
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Learning Outcomes 

  
After completing this session, you will be able to: 

 

• Describe the core principles and functions of 3D software, including 

modelling, rendering, and animation. 

• Navigate and utilize the interface of popular 3D software applications. 

• Apply textures using shaders to enhance the visual appearance of 3D models. 

• Describe the key responsibilities of a texturing artist.  

• Identify the textures and shaders for different texturing tasks. 

• Differentiate between 2D, 3D, and environment textures. 

• Develop a 3D model from concept to completion, applying skills in texturing 

and shading. 

• Apply translucence settings to create realistic light transmission effects. 

• Describe and demonstrate the use of ambient colour, incandescence, bump 

mapping, diffuse, and translucence in shaders. 

• Demonstrate the impact of various lighting setups on the appearance of 3D 

models. 

 

 

Module Structure 

  
 

Session 1: Essential Skills Movie Window in Maya 

  
Session 2: Introduction to 3D Modelling 

  
Session 3: Texturing Using Shaders 

  
Session 4: Maya Material 

 

Session 5: Real Life 3D Model 

 

Session 6: Properties of Surface Materials 

 

Session 7: Effect of Lighting Conditions on Surfaces 
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Session 1: Mastering the Essential Skills Tutorial  

Window in Maya 

  
 

3D animation is the art of using motion to bring characters and more to life within 

television shows, films, and games. Animators are responsible for giving objects weight 

and timing that results in the object feeling like it truly exists in the world we see 

them.  

 

Gaining an initial understanding of basic concepts is essential to learning any 

software application, including how it functions and the core skills needed to work 

effectively with it. Those who are new to three-dimensional (3D) software, it may 

initially feel different compared to 2D applications. Before moving further, let us do a 

quick introduction with 3D software i.e., Autodesk® Maya®.  

 

Maya is the premier application for creating compelling 3D digital content, including 

models, animation, visual effects, games, and simulations. It enables users to produce 

life like animations as seen in blockbuster films such as Avatar and Jurassic Park. 

Just as the driver of an automobile is familiar with the dashboard of their vehicle, it 

is important to become familiar with the Maya “dashboard”. The Maya user interface 

refers to everything that the Maya user sees and operates within Maya. The menus, 

icons, scene views, windows, and panels comprise the user interface. 

 

Through the Maya user interface, one will be allowed to access the features and 

operate the tools and editors and that will help to create, animate, and render your 

three-dimensional objects, scenes, and effects within Maya. 

 

Textures are flat images that get applied to 3D objects. They are responsible for models 

being Colourful and interesting instead of blank and boring. The overall process for 

applying a texture onto a 3D mesh involves mapping the texture (image, logo, decal 

etc.) directly onto the mesh before printing. Now let us look at some of the 

terminologies that we will be using for texturing.  

 

Image Textures 

 

Image textures are a type of Texture Map used in 3D graphics to add visual detail to 

a model. When elements like logos, text, images, or barcodes are applied to the surface 

of a 3D model, they create the appearance of those graphics directly on the object. 

This technique helps make the model more realistic or branded without having to add 

complex geometry. 

 

Image textures are mapped onto a model using UV Mapping, where the 2D image 

coordinates are wrapped around the 3D surface. This lets the texture align correctly 
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with the model's shape and contours, ensuring that the images or graphics display 

accurately in renders. 

 

Basic Texturing 

 

Starting with Bitmap-based textures is effective for learning the basics. A Bitmap is a 

type of digital image file that represents a picture as a grid of individual pixels, or dots. 

Each pixel in a Bitmap image is assigned a specific colour, and collectively, they form 

the complete image. Bitmap images are also known as raster images and are widely 

used in graphics because they offer detailed representations of photos and complex 

illustrations. Using Bitmap textures allows to create a specific look and feel for objects 

without needing complex shaders or procedural textures. Although Bitmap textures 

can be memory-intensive when used in large quantities or at high resolutions, they 

remain valuable because they are customizable. With Bitmap textures, one can paint 

directly on the image, tailoring it to the model’s unique needs. This flexibility is ideal 

for adding realistic details like wear and tear, custom colours, or hand-drawn 

elements. 

 

Bump and Displacement Mapping 

 

Bump Mapping and Displacement Mapping are both techniques in 3D computer 

graphics used to simulate surface detail on 3D models, giving textures more depth 

and realism. Although they both serve the purpose of adding detail to surfaces, they 

work differently in how they affect the geometry.  

 

Bump Mapping is a technique that simulates surface texture by altering the way light 

interacts with a model. It does this without actually changing the geometry of the 

surface. Instead, it uses a grayscale texture (called a Bump Map) to create the illusion 

of depth by adjusting the surface normal, which are used to calculate how light 

reflects off the surface. 

 

Displacement Mapping, unlike Bump Mapping, actually modifies the geometry of the 

surface. It uses a texture (often a grayscale Displacement Map) to push or pull vertices 

on the model, creating real surface depth. This results in more realistic details, 

especially for highly uneven surfaces. 

 

Mimicking real-world materials involves not just capturing colour but also emulating 

the material's physical properties to achieve realism. By using image textures beyond 

just colour, we can control various attributes to recreate how a material interacts with 

light and touch.  For photorealistic effects, several types of image textures or maps 

are commonly layered together: 

 

i. Colour or Diffuse Map: Provides the base colour of the material. 

ii. Normal or Bump Map: Adds surface detail by simulating small height 

variations, giving the illusion of texture depth without increasing geometry. 
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iii. Specular or Reflectivity Map: Controls how shiny or reflective parts of the 

material are, allowing for surfaces like glossy plastic or brushed metal. 

iv. Roughness Map: Dictates how smooth or rough a surface appears, affecting 

how light scatters. 

v. Displacement Map: Actually modifies the geometry based on grayscale values, 

giving a true sense of height and depth. 

 

These are the essential steps involved in texturing a 3D model, each with its own key 

purpose: 

 

i. Design a 3D Object: Start with a simple 3D model in software like Maya, Blender, 

or other CAD programs. Basic shapes can be extruded or transformed to create a 

foundational geometry, which serves as a base for applying textures. 

 

ii. UV Mapping and Unwrapping: UV refers to the 2D texture coordinates used in 3D 

modelling to map a 2D image (texture) onto a 3D surface. The letters "U" and "V" 

represent the axes of the 2D texture plane, similar to "X," "Y," and "Z" in 3D space. 

UV Mapping involves creating a 2D representation of a 3D model's surface, which 

allows textures to be accurately placed on the model. Unwrapping is the process of 

flattening a 3D model’s surface onto the UV plane so textures can be applied 

without distortion. 

 

Once the model is ready, UV Mapping is used to flatten the 3D surface onto a 2D 

plane. This process, known as UV unwrapping, enables textures to be applied 

accurately. A UV Map can be automatically generated or manually optimized to 

minimize seams and overlaps, making it easier to paint or project textures onto the 

model's surface. 

 
iii.Import the 2D Image Texture: Textures are typically Bitmapimages (such as JPG, 

PNG, or TIFF) created in digital art tools like Photoshop. These textures are imported 

into 3D environments (e.g., Unity for real-time projects or Maya for 3D rendering) 

where they will be mapped onto the model. 

 

iv. Align the Geometry Map and Apply the Texture: The imported texture is aligned 

with the UV Map to ensure it wraps properly around the 3D object. This step 

ensures that images and custom textures appear precisely where intended. 

 

v.UV Mapping a Polygon Object: The UV coordinates are mapped to the model's 

polygons to wrap the texture onto its geometry. Proper alignment is crucial for 

accurate texture display on complex shapes. 

 

i. Layered Texturing and Baking Lights: Layered textures allow multiple 

textures to blend, adding depth and complexity. Baking lights captures detailed 

light and shadow information directly into textures, reducing the need for real-

time calculations. This technique is especially useful for game assets, as it 

significantly lowers processing demands and enhances performance during 

gameplay. 
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ii. The Ramp Shader: The Ramp Shader is an advanced tool that allows for 

creative shading effects by blending multiple colours or textures along a 

gradient. It is ideal for creating nuanced shading, from metallic to translucent 

effects, providing flexibility in designing sophisticated materials. 

 

Essential Techniques for Maya Artists 

 

The essential skills movies window in Autodesk Maya is designed to help new users 

get up to speed quickly. This introductory series covers foundational skills necessary 

for navigating and working within Maya's interface, including basics like creating and 

modifying 3D objects, manipulating the viewport, and understanding Maya’s tools and 

settings. The videos are an excellent starting point as they provide step-by-step 

instructions, allowing users to follow along while learning essential techniques. 

 

The tutorials are available with audio in multiple languages like English, French, 

German, Italian, Japanese, Korean, and Mandarin making them accessible to a 

diverse range of users worldwide. These initial lessons help lay a strong foundation 

for more complex tasks, from basic modelling and texturing to animation and 

rendering. 

 

 

 

Accessing the Essential Skills Movies Window in Maya 

 

To open the Essential Skills Movies window in Maya, follow these steps: 

 

i. Launch Maya: Open the Maya application. 

ii. Access the Help Menu: Navigate to the top menu bar and click on Help. 

iii. Open Essential Skills Movies: From the drop-down menu, select Essential 

Skills Movies. 

iv. View Tutorials: The Essential Skills Movies window will open, providing 

access to various video tutorials that cover fundamental skills and workflows 

in Maya. 

Closing the Essential Skills Movies Window 

Closing the Essential Skills Movies window is a straightforward process. When you 

close this window, it's essential to take a moment to reflect on the insights and 

techniques you have gained and think about how you will apply them in real-life 

scenarios. The steps to be followed are:  

i. To close the window, click the close box in the upper right corner.  

 

ii. To prevent this dialog box from appearing at start up, select the "Do not show 

this at start up" checkbox (Figure 1.1). 
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iii. To close the multimedia player, select File > Exit or click the close box in the 

upper right corner of the window (this instruction may vary depending on the 

multimedia player used).  

 

iv. To watch the movies again later, go to Help > Learning Movies in Maya. This 

will open the Essential Skills Movie window. 

 

When Maya starts for the first time, the workspace opens by default in a perspective 

window, or panel, with several components. The panel is labelled "Persp" at the 

bottom, indicating a perspective camera view of the Maya scene. A menu bar at the 

top left corner of the panel provides access to tools and functions specific to this view.  

The grid includes two heavy lines intersecting at the centre of the Maya scene, known 

as the origin. The origin represents the centre of Maya's 3D world, with all object 

positions measured relative to this point.In Maya, as in many other 3D applications, 

the three dimensions are labelled as the X, Y, and Z axes, with the origin located at 

X, Y, Z coordinates (0, 0, 0). The grid lies along the X, Z plane, visualized as a flat, 

imaginary square in 3D space (Figure 1.2). 

 

 

Figure 1.1: Maya Essential Skills Movies 
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Maya labels the X, Y, and Z axes with a Colour scheme: red for X, green for Y, and 

blue for Z. Many tools that are used in Maya use this Colour scheme to indicate that 

are accessing a particular item that relates to X, Y, and Z in some way. The controls 

regarding axis is being described in (Figure.1.3). 

 

Menu Bar 

 

Tools and items are accessible from pull down menus located at the top of the user 

interface. In Maya, menus are grouped into menu sets. These menu sets are accessible 

from the Main Menu bar. 

 

Figure 1.3: Colour codes to understand transformation manipulators 

Figure 1.2: Object and it is 3-dimensional representation 
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The Main Menu bar appears at the top of the Maya interface directly below the Maya 

title bar and displays the chosen menu set. Each menu set corresponds to a module 

within Maya: Animation, Polygons, Surfaces, Rendering, and Dynamics. Modules are 

a method for grouping related features and tools. Maya® Unlimited has additional 

menu sets (For example, Maya®nClothTM). Figure 1.4  will help you to understand 

the place as well as the sub menus of main menu bar.  

 

It is easy to switch between menu sets of software by choosing the appropriate module 

from the menu selector on the Status Line (located directly below the File and Edit 

menus).  When switching between menu sets, the right-hand portion of the menus 

changes, while the left-hand portion remains consistent. The left-hand menus, which 

are common across all menu sets, include File, Edit, Modify, Create, Display, and 

Window. This is further illustrated in the figure, which clearly explains the process of 

switching between different types of menus within the software.  

 

 

Activities 
  

 

Activity 1: Using help to understand basics of 3D software, like 3DS 

Autodesk®Maya® 

 

Materials Required: Computer, and 3DS Autodesk®Maya® software 

 

Procedure  

 

• Open Autodesk Maya: Launch the Maya application on your computer. 

• Navigate to the Help Section: Go to the Menu Bar at the top of the Maya interface. 

Click on Help. 

• Access Essential Training: In the Help drop-down menu, look for and select 

• Essential Skills Movies or Learning Resources: This will open a window or direct 

you to a section containing video tutorials. 

Figure 1.4: Maya Main Menu Bar 
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• Explore the Videos: Browse through the list of videos to find those that cover the 

basics of Maya, such as navigating the interface, understanding the workspace, 

and learning about key features like modeling, texturing, and animation. 

Activity 2: Hands on UV Mapping and Texture Application 

Materials Required: Computer, and 3DS Autodesk®Maya® software 

 

Procedure  

 

1. Create a Simple 3D Object: Start with a basic shape like a cube or sphere. 

Modify the shape to get familiar with Maya's object transformation tools (move, 

scale, rotate). 

2. Apply a Basic Texture: Import a 2D texture image, such as a PNG or JPG. 

Use UV Mapping to wrap the 2D texture around your 3D object. Practice 

unwrapping the UV Map to ensure the texture aligns correctly. 

3. Experiment with Bump and Displacement Mapping: Apply a Bump Map to 

simulate surface detail without changing geometry. Try using a displacement 

map to see how it physically alters the shape by pushing and pulling the 

surface geometry. 

4. Practice Light Baking: Add basic lighting to your scene. Use the Bake Lights 

feature to capture light and shadow details directly in your texture, optimizing 

your model for real-time applications. 

5. Explore the Ramp Shader: Experiment with the Ramp Shader to create 

blended shading effects on your 3D model. Adjust colour gradients to 

understand how this shader impacts the appearance of materials. 

Activity 3: Customizing the Main Menu Bar 
 

Materials Required: Computer, and 3DS Autodesk®Maya® software 
 

Procedure  
 

1. Explore Menu Sets: Switch between different menu sets like Animation and 

Rendering to see how they modify the tool options available in the interface. 

2. Customize Shortcuts: Use the menu selector on the Status Line to quickly switch 

between commonly used menu sets. Practice accessing frequently used 

commands like File, Edit, and Modify to streamline your workflow. 

 

Check Your Progress 

  
 

A. Multiple Choice Questions 

 

1. What is the primary function of 3D animation in films, television, and games? 

a) To create two-dimensional characters 
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b) To bring characters and objects to life through motion 

c) To design still images for web design 

d) To enhance sound effects in digital media 

 

2. Which of the following software is used to create lifelike animations as seen in 

films like Avatar and Jurassic Park? 

a) Blender 

b) Adobe Illustrator 

c) Autodesk Maya 

d) SketchUp 

 

3. What is the purpose of the Maya user interface? 

a) To import 3D models 

b) To access features and operate tools to create, animate, and render objects 

c) To control lighting conditions in the scene 

d) To manage hardware resources during rendering 

 

4. What are textures in 3D animation primarily responsible for? 

a) Providing colour and making models more visually appealing 

b) Controlling the animation of objects 

c) Determining the shape and size of the 3D objects 

d) Handling the lighting and shadows in a scene 

 

5. What is a UV Map in 3D modelling? 

a) A 2D representation of a 3D model’s geometry for texturing 

b) A map used to determine the lighting in a scene 

c) A diagram showing the camera angles in a scene 

d) A visual representation of the object's physical properties 

 

6. Which term describes using an image texture to control surface height and 

reflectiveness? 

a) UV Mapping 

b) Bitmap texturing 

c) Bump and Displacement Mapping 

d) Layered texturing 

 

7. What feature in Maya allows you to generate shadows and lighting effects as a 

texture to reduce real-time rendering overhead? 

a) UV unwrapping 

b) Bump Mapping 

c) Baking lights 

d) Image textures 

 

8. How can you reopen the Essential Skills Movie Window in Maya after closing 

it? 

a) Click 'Window > Animation Movies' 
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b) Select 'Help > Learning Movies' 

c) Reinstall the software 

d) Restart the software with the default settings 

 

 

Session 2: Introduction to 3D Modelling   

  
 

In 3D computer graphics, 3D modelling involves creating a mathematical 

representation of any object's surface (animate or inanimate) in three dimensions 

using specialized software. In Maya, modelling refers to constructing virtual 3D 

surfaces for characters and objects within the scene, with surfaces playing a crucial 

role in achieving a convincing 3D image. Each surface type has distinct characteristics 

and advantages. 

 

There are three surface types in Maya: 

 

i. Polygon 

ii. NURBS 

iii. Subdivision surfaces 

 

Polygon 

 

Polygon surfaces consist of networks of three-or-more-sided flat surfaces called faces, 

which connect to form a polygonal mesh. Polygon meshes are made up of vertices, 

faces, and edges. Wireframe lines on the mesh represent the edges of each face, with 

the bounded regions being faces, and intersections of edges marking points called 

vertices. 

 

Rendered polygon meshes can display hard or smooth edges, making polygons 

adaptable to both flat and curved 3D forms. These component types are used 

extensively when modelling with polygons. Polygonal surfaces are versatile and 

favoured in applications like interactive games and web development due to their data 

efficiency and fast rendering speeds, enhancing performance. 

 

NURBS 

 

NURBS (Non-Uniform Rational Basis Spline) surfaces are created by defining a 

shape's profile with one or more NURBS curves. A specific construction method is 

then used to generate the surface. NURBS surfaces are widely used in industrial and 

automotive design for creating smooth forms with minimal data. They are also ideal 

for defining motion paths in animations. Additionally, NURBS surfaces can be 

converted into polygonal meshes. 
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Subdivision Surfaces 

 

Subdivision surfaces are hybrid surfaces that combine features of both NURBS and 

polygonal surfaces, along with additional attributes. Subdivision surfaces produce 

smooth, organic forms with a few control vertices, similar to NURBS, and allow for 

extruding specific areas and adding surface details like polygons. Working at multiple 

detail levels, a smooth, organic object can be constructed from a single primitive 

without needing to attach or stitch multiple surfaces, as required with NURBS. 

 

Compositing After Output 

 

The final composited and rendered scenes combine lighting, texturing, and animation 

outputs into a single video file (e.g., .MOV, .AVI, .MP4) or a sequence of still frames in 

TGA (Targa) or .TIF formats. These formats support alpha channels for background 

transparency. It is known for its ability to handle high-quality images and includes 

support for alpha channels, enabling transparency in graphics. These sequential files 

are later combined in video editing software like Adobe Premiere Pro, AVID Media 

Composer, or Final Cut Pro (FCP) to create a single animation sequence file. 

 

Roles and Responsibilities of a Texturing Artist 

 

A Texturing Artist plays a crucial role in the 3D content creation pipeline, focusing 

on adding detailed textures to 3D models to bring them to life. Below are the key roles 

and responsibilities of a Texturing Artist. Collaborate with the CG (Computer 

Graphics) Supervisor and Lead Texture Artist to achieve the required look for CG 

characters and objects. A Texturing Artist must understand the specifications based 

on the expectations of the compositor or art director, including knowledge of canvas 

sizes, shaders, textures, and mapping requirements across different environments, 

such as TV series, video games, or movies. 

 

Roles and Responsibilities: 

 

1. Texture Creation:  

 

• Develop high-quality textures for characters, environments, props, and other 

3D assets. 

• Use tools like Photoshop, Substance Painter, or Mari to create detailed textures 

such as diffuse, specular, normal, and Bump Maps. 

 

2. UV Mapping and Unwrapping: 

 

• Create efficient and accurate UV Maps to ensure textures align properly with 

3D models. 

• Optimize UV layouts to minimize texture distortion and maximize texture 

resolution. 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

14 
 

                                                                     Texturing Artist - Grade XII  

3. Shaders Development: 

 

• Use shaders to define material surface properties, including reflection, 

transparency, and subsurface scattering. 

• Collaborate with technical artists to ensure shaders function correctly within 

the rendering pipeline. 

 

4. Material and Surface Detailing: 

 

• Apply textures that simulate various material properties like metal, wood, 

fabric, or skin. 

• Use procedural and hand-painted techniques to achieve realistic or stylized 

effects as required by the project. 

 

5. Collaboration: 

 

• Work closely with modelers, riggers, and lighting artists to ensure textures and 

materials complement the overall look of the scene. 

• Coordinate with production and leads on scheduling and deadlines 

• Coordinate with art directors and lead artists to align with the project’s visual 

style and quality standards. 

 

6. Quality Assurance and Optimization: 

 

• Review and refine textures to ensure they meet visual and technical standards. 

• Optimize textures and materials to balance visual fidelity with performance, 

especially in game development or real-time applications. 

• Experiment with new workflows and technologies to enhance texturing 

efficiency and quality. 

• Ensure quality control of Texture Maps before publishing to maintain 

consistency 

• Meet deadlines and schedules while upholding the highest standards 

 

7. Problem-Solving: 

 

• Identify and resolve issues related to Texture Mapping, shader compatibility, 

and material performance. 

• Troubleshoot visual discrepancies or artefacts that arise during rendering. 

 

8. Research and Development: 

 

• Stay updated on the latest texturing tools, techniques, and trends in the 

industry. 

• Share techniques, reference materials, and ideas with the team 

• Stay updated with new tools, software, data, and related technologies 
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Activities 

 
 

 

Activity 1: Creating objects with the help of NURBS and Polygons on 3DS 

Autodesk®Maya® 

 

Materials Required: Computer system, and 3DS Autodesk®Maya® 

 

Procedure  

 

1. Open Maya: Launch the Autodesk Maya application. 

2. Access NURBS Primitives: 

• Go to the Menu Bar. 

• Click on Create > NURBS Primitives. You will see a list of available NURBS 

shapes, such as Circle, Square, Sphere, Cylinder, and more. 

3. Create a NURBS Object: 

• Select a NURBS primitive from the list. 

• Click in the viewport to place the object or click and drag to define its size. 

4. Editing NURBS Objects: 

• To modify the NURBS object, you can use the Control Vertices (CVs): 

• Select the object and press the 'F8' key to enter Component Mode. 

• Select the CVs (Control Vertices) and move them to reshape the NURBS 

object. 

• Use the Edit NURBS menu for additional options like smoothing, blending, 

and trimming. 

5. Converting NURBS to Polygons (Optional): 

• If you need to convert a NURBS object to polygons, select the NURBS object, 

then go to Modify > Convert > NURBS to Polygons. 

• Creating Objects with Polygons in Maya: 

• Open Maya: 

• Launch the Autodesk Maya application. 

6. Access Polygon Primitives: 

• Go to the Menu Bar. 

• Click on Create > Polygon Primitives. This will show a list of polygon shapes 

like Cube, Sphere, Cylinder, Cone, and Plane. 

7. Create a Polygon Object: 

• Select a polygon primitive from the list. 

• Click in the viewport to place the object or click and drag to define its 

dimensions. 

8. Editing Polygon Objects: 

• Switch to Component Mode by pressing 'F8'. 

• Select Vertices, Edges, or Faces to manipulate the geometry. You can move, 

scale, extrude, or merge components to refine the shape. 
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• Use the Polygon menu for additional editing options, such as smoothing, 

merging, or adding subdivisions. 

9. Using the Modeling Toolkit: 

• Access the Modelling Toolkit from the right side of the interface to utilize 

tools like Extrude, Insert Edge Loop, Bevel, and Bridge to create complex 

shapes and details. 

 

 

Check Your Progress 

  
 

A. Multiple Choice Questions 

 

1. What is the primary benefit of using polygon surfaces in Maya?  

a) Can produce smooth organic forms 

b) Can be rendered quickly due to minimal data 

c) Preferred for industrial design 

d) Allows for easy stitching of surfaces 

 

2. In which industry are NURBS surfaces most commonly used? 

a) Video game development 

b) Web development application 

c) Industrial and automotive design 

d) Animation for movies 

 

3. What is the main advantage of subdivision surfaces over polygons and NURBS?  

a) Minimal data for fast rendering 

b) Capable of smooth organic forms with extrudable areas 

c) Requires multiple NURBS curves for complex shapes 

d) Best suited for creating flat surfaces 

 

4. Why are polygonal surfaces preferred in video games?  

a) They offer smooth organic forms 

b) They require fewer vertex points 

c) They can be rendered quickly and are lightweight 

d) They offer high detail at different levels 

 

5. Which file formats are typically used in compositing for background 

transparency?  

a) .MOV, .AVI 

b) .TGA, .TIF 

c) .MP4, .AVI 

d) .JPEG, .PNG 

 

6. Which of the following is NOT a responsibility of a Texture Artist?  
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a) Collaborating with the CG Supervisor and Lead Texture Artist 

b) Ensuring quality control of Texture Maps 

c) Creating the animation rig for characters 

d) Sharing techniques and ideas with the team 

 

7. Which skill is most essential for a Texture Artist to succeed in their role?  

a) Ability to design photo-real assets 

b) Proficiency in video editing software like Adobe Premiere 

c) Understanding of modelling and texturing software 

d) Strong programming skills for asset creation 

 

8. What is the final step in compositing after rendering scenes in 3D animation?  

a) Creating a mesh using polygon surfaces 

b) Joining sequential still frames in a video editing software 

c) Converting NURBS surfaces into polygon meshes 

d) Extruding subdivision surfaces for higher detail 

 

 

Session 3: Texturing Using Shaders 

  
 

Texturing using shaders in Autodesk Maya involves applying various materials and 

surface properties to 3D models to create realistic or stylized appearances. Shaders 

define how light interacts with surfaces, affecting attributes like colour, texture, 

glossiness, transparency, and more. Now let us first understand the various terms 

that will be used in this session.  

 

Textures  

 

Textures are 2D images applied to 3D objects to add colour and visual interest, 

defining the physical appearance and tactile qualities of a surface. They make models 

more engaging and realistic, reflecting the diverse textures found in the natural and 

manufactured world, such as water, wood, metal, or fabric. 

 

Types of Textures: 

 

Environment Textures: Simulate reflections and environmental effects, enhancing 

realism by mimicking the surroundings. They include Env Ball, Env Chrome, Env 

Cube, Env Sky, and Env Sphere, often used for reflective surfaces or creating realistic 

backgrounds in 3D scenes. 

 

Layered Textures: Combine multiple textures on a single surface to create complex 

visual effects. This includes adding details like grime or wear, or using a Layered 

Shader to apply different materials, such as "phong1" and "blinn1," to geometry for 

varied surface appearances. 
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Shaders  

 

Texturing using shaders involves applying textures with shaders, which are 

programmes designed to define how surfaces interact with light. This technique adds 

details like colours and textures to models, boosting realism without affecting 

performance. 

 

Shading involves applying maps or nodes to shaders to create surface effects. For 

example, a brick wall image defines colour, while a contour image creates surface 

relief. This process is often called texturing, as textures are commonly applied to 

shaders. 

 

Layer shader nodes aid in compositing intricate details, such as aging effects or 

multiple texture surfaces, enhancing realism through surface variety. This technique 

is often used to add lifelike detail to materials, such as human skin with pores, scars, 

and wrinkles, by controlling attributes like colour, surface bumps, transparency, 

reflection, and shine. 

 

Shaders in Maya are node-based, with each node containing attributes that define the 

shader. Shader networks consist of interconnected nodes that create shading effects, 

ranging from simple to complex. A shader, or shading group, includes material nodes, 

which hold rendering details like colour, opacity, and shininess. Shading groups 

connect the surface with the defined material, and adjustments to the shader 

attributes in the Attribute Editor also update the material node. 

 

3D Graphics  

 

In 3D graphics, textures are categorized into three main types 2D Textures, 3D 

Textures, and Environment Textures each tailored to add unique visual qualities to a 

model’s surface. 

 

• 2D Textures 

 

Most 2D textures are procedural, meaning they are mathematically generated 

programs that remain resolution-independent. Unlike Bitmap-based textures, 

Procedural Maps maintain the same image quality whether viewed up close or from a 

distance, as the resolution is determined at the time of rendering rather than by the 

texture size. This approach allows for consistent detail and sharpness in rendered 

images. In the Create Render Node window, commonly available 2D textures include 

options such as Bulge, File, Grid, and others, each serving different purposes in 

texturing for visual effects and realism. 

 

2D Textures are used to create flat, detailed imagery that wraps around 3D objects. 

Common 2D textures include Bulge, Checker, Cloth, File, Fluid Texture 2D, Fractal, 
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Grid, Mountain, Movie, Noise, Ocean, Ramp, and Water, which provide various 

patterns and visual effects. 

 

• 3D Textures  

 

In 3D textures, objects gain the appearance of being carved from materials like rock 

or wood, adding realism and depth to the surface. These textures can be interactively 

scaled, rotated, and moved in the scene view to achieve precise effects. Most 3D 

textures, aside from snow, are random types, connected through a three-dimensional 

UVW coordinate manipulator that does not require existing UVW nodes. This flexibility 

allows 3D textures to be projected seamlessly, making them especially effective for 

volumetric effects, shading, and complex depth-based patterns such as marble, wood, 

and smoke. 

 

3D Textures offer volumetric detail for more depth and realism, making them ideal for 

natural or organic materials. Examples include Brownian, Cloud, Crater, Fluid 

Texture 3D, Granite, Leather, Marble, Rock, Snow, Solid Fractal, Stucco, Volume 

Noise, and Wood. 

 

• Texturing Mapping  

 

Texture Mapping or simply mapping involves assigning textures to shader attributes, 

such as mapping a texture to the colour node of a shader that is applied to a Maya 

object. In real-world terms, an object’s appearance is influenced by its material 

composition and interaction with light. Light absorption and reflection vary depending 

on surface smoothness, affecting whether the object appears shiny or matte. In Maya, 

a surface’s appearance is determined by shading, a combination of the object’s base 

material and any applied textures. 

 

Hypeshade 

 

Hypershade (Figure 1.7) is the working area for look development of scene elements. 

Here Shading networks are built and modified for rendering pixels for an image(s) or 

a movie. It offers access to shader properties, textures, lighting nodes, rendering 

utilities and custom advance sharing network setups. Steps to be followed are: 

 

• Click on the Status line (toolbar) 

• From the main menu bar: Windows > Rendering Editors >Hypershade 

• In any panel menu: Panels > Panel >Hyper shade 

 

The Hypershade is the central working area of Maya rendering, where one can build 

shading networks by creating, editing, and connecting rendering nodes, such as 

textures, materials, lights, rendering utilities, and special effects. 
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Steps to be followed are: 

 

• While opening the Hyper shade, the Create panel appears at the bottom left. 

From this panel, one can choose among nodes that allows to create different 

types of rendering effects.  

 

• Click on a node in the Create tab to add it to your scene 

 

• Select one or more sections. Only the nodes in the selected sections are 

displayed in the right panel. To clear your selection, press Enter in the search 

area. 

 

• Use the scroll bar to navigate through the Create tab and click to select the 

desired node. 

 

The Hypershade has divided the following panels by default. Hypershade is a powerful 

visual interface in Autodesk Maya that allows users to create, manage, and edit 

shaders and materials for 3D models.  

 

It serves as a comprehensive browser for organizing and visualizing all the shading 

networks in a scene, enabling artists to easily apply and manipulate textures, colours, 

and lighting effects. With its node-based system, Hypershade provides a clear 

representation of the relationships between materials, textures, and geometry. Users 

can create various types of materials, such as surface shaders, volume shaders, and 

displacement shaders, by connecting different nodes and adjusting their attributes. 

The intuitive drag-and-drop functionality simplifies the process of assigning materials 

to objects, making it easier to achieve complex visual effects (Figure 1.8). 

 

 

 

 

 

Figure 1.7: Hypershade work area 
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Figure 1.8: Hypershade browser 

 

Hypershade Browser: This panel lists your materials, textures, and lights, sorted by 

tabs (Figure. 1.9). Hypershade Browser are tabs containing the rendering 

components that contribute to the current scene; for example, your materials, 

textures, lights, and cameras. 

In every Hypershade tab, each rendering node is displayed as a node icon (a swatch) 

that visually represents the characteristics of the node. When it is edited a nodes 

attributes or assign textures or special effects, the swatch updates in the Hypershade. 

 

Figure 1.9: Node Workspace in Hypershade 
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Unsupported nodes: In Hypershade, a node is marked as unsupported by the active 

renderer in the Render Settings window, indicated by a red swatch label. For example, 

if the renderer is set to Maya Software in a scene containing a mental ray for Maya 

node, like misss_fast_shader, the unsupported misss_fast_shader will display with a 

red swatch label (Figure 1.10). Steps to be followed are: 

 

• Material Viewer: This panel renders your shader or solid material. 

 

• Create tab: Click a node in the Create tab to create and add nodes to your 

shader graph. Alternatively, one can also click Tab and enter the type of your 

node, or drag and drop a node from the Create tab to the work area. 

 

• Work area: The Hypershade panel provides a node editing interface similar to 

the Node Editor, enabling the creation and management of a shader network. 

Within the Hypershade work area, located at the bottom of the Hypershade 

panel between the Create tab and the Property Editor, nodes can be created 

and connected to build a comprehensive shader network. This workspace offers 

the same flexibility as the Node Editor, allowing for advanced shader 

adjustments and customizations. 

 

• In the Hypershade's work area, nodes can be added by selecting from the Create 

Tab, pressing the Tab key to type the node type, or dragging nodes directly from 

the Create Tab. Nodes are connected by dragging lines between them or middle-

mouse dragging one node onto another. They can be displayed in various views 

simple, connected, full, or custom—defaulting to custom mode upon creation. 

 

• The Hypershade allows attribute searches within nodes by using the search 

field in the toolbar, and node types can be filtered by right-clicking and 

selecting from the Show > Objects submenu. Default nodes displayed include 

cameras, shading groups, and shading nodes. Filtering nodes by name is 

supported, with "*" as a wildcard, and filters can be reset to show the entire 

graph by clicking the filter-clear icon. 

 

• Tabs in Hypershade enable multiple shader networks to be managed at once. 

New tabs are created by clicking "+", and they can be renamed, duplicated, or 

reordered. Tabs remain accessible even after closing Hypershade or saving the 

file. Editing features, such as adding nodes to the graph or rearranging the 

Figure 1.10: Hypershade browser showing unsupported node 
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layout, are available on the toolbar and are shared with the Node Editor. 

Additionally, the grid background can be toggled, and nodes can be snapped 

to it for precise alignment. . 

• Property Editor: View your shading node attributes in a Lookdev template view 

that is optimized for Lookdev workflows. (Figure 1.11) 

 

• Bins: Organize and track shading nodes in your scenes by separating them 

into sorting bins (Figure 1.12). Use Sorting bins, which are containers for 

shading nodes (materials, textures, and so on), to help you organize and track 

shading nodes in your scenes. 

 

A default Master bin contains all shading 

nodes in your scene. One can add any number 

of additional bins to a scene and assign nodes 

to one or more of those bins. By strategically 

naming the bins, (for example, wood, metal, 

doors, foliage), It can quickly and more easily 

locate shading assets to work with them. 

 

Note: 

• When a node is assigned to a 

bin, all the shading nodes 

upstream to this node are also assigned to this bin. 

• The Hypershade asset tabs (Materials, Textures, and so on) exist for all sorting 

bins, allowing for further organization and filtering. 

• While shading nodes can be assigned to more than one bin, they are not 

duplicated in the scene. 

• One can rename an existing bin by double-clicking it. 

 

Types of Shaders 

Figure 1.11: Property Editor Workspace with Node Connections 

Figure 1.12: Hypershade bin space 
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Here is a brief information of the shader types in Maya: 

1. Anisotropic Shader 

• Features: Simulates directional reflections, with 

irregular specular highlights and sensitivity to 

surface texture. 

• Applications: Best for materials like brushed 

metal, hair, satin, and foil. 

• Practical Uses: Essential for simulating surfaces 

with directional reflection, such as hair, metal 

textures, and satin fabrics. 

2. Surface Shader 

• Features: Provides basic control over colour and transparency without 

simulating light interaction. 

• Applications: Useful for special effects, backgrounds, or materials where 

light interaction is not needed. 

• Practical Uses: Can be used for objects like labels, decals, or simple 

backgrounds. 

3. Blinn Shader 

• Features: Offers softer highlights compared to 

Phong, with a focus on specular reflections. It is 

computationally more intensive than Lambert and 

Phong. 

• Applications: Ideal for shiny and metallic surfaces 

(Figure 1.14).  

•  

• Practical Uses: Used for polished metals, 

glass, and glossy finishes where softer, more 

realistic specular highlights are desired. 

4. Lambert Shader  

• Features: A simple, non-reflective shader that 

simulates diffuse surfaces. It scatters light uniformly 

in all directions. 

• Applications: Ideal for matte surfaces like paper, 

unpolished wood, and ceramics (Figure 1.15).  

• Practical Uses: Perfect for non-reflective materials 

like chalk, stone, or matte finishes. 

Figure 1.13: Sample of 
Anisotropic Shader 

Figure 1.14: Samples of Blinn 
Shader 

Figure 1.15: Sample 
of Lambert shader 
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5. Phong Shader 

• Features: A shader that combines diffuse and specular reflections, producing 

sharp specular highlights.Applications: Suitable for glossy materials like 

plastics, glass, and polished metals (Figure 1.16). 

• Practical Uses: Best for simulating shiny surfaces with distinct, hard 

reflections. 

 

 

 

 

6. Layered Shader 

• Features: Combines multiple shaders to create complex materials with 

different properties. 

• Applications: Ideal for materials with multiple layers, such as aged surfaces, 

labels, and decals. 

• Practical Uses: Texturing vehicles, character skin, and environmental 

textures like moss or dirt. 

7. Ocean Shader 

• Features: Simulates realistic water surfaces with dynamic response to light 

and camera angle interaction. 

• Applications: Designed for ocean, lake, and water simulations. 

• Practical Uses: Useful for creating realistic water surfaces in outdoor scenes. 

8. Ramp Shader 

• Features: Creates smooth gradients in colour, transparency, incandescence, 

and specular highlights. 

• Applications: Allows for the creation of varied properties across an object's 

surface. 

• Practical Uses: Ideal for materials like skin, fabrics, or metallic surfaces and 

for creating smooth transitions in special effects like magical spells or 

animated trails. 

9. Shading Map Shader 

• Features: Creates cartoon-style "cell" shading, simulating a 2D painted effect. 

Figure 1.16: Samples of Phong Shader 
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• Applications: Originally used for traditional cartoon shading but now 

replaced by the Ramp shader for enhanced capabilities. 

• Practical Uses: Used for cartoon-style 3D rendering or illustrations. 

10. Surface Shader  

• Features: Provides control over an object’s basic colour, transparency, and 

glow. 

• Applications: Useful for creating glowing objects or simple texturing needs. 

• Practical Uses: For dynamic colour changes based on object movement, or 

creating basic objects with simple transparency. 

• change colour based on their position or other environmental factors, adding a 

layer of interactivity to animations. 

• Basic Object Texturing: It can be employed for basic object texturing where 

advanced material properties are not required, making it suitable for 

prototyping and testing. 

• Visual Effects: The shader can be used in visual effects to create glowing 

elements or transparent surfaces, enhancing the overall aesthetic of the scene. 

 

Activities 

  
 

Activity 1: Applying a Shader in Autodesk®Maya® 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure 

1. Open Hypershade: Navigate to the top menu and select Window > Rendering 

Editors > Hypershade. This opens the Hypershade window where you can access 

various shading nodes. 

2. Create a New Shader: In the Hypershade window, locate the Create section for 

Maya nodes. Click on the desired material type (e.g., aiStandardSurface, Lambert, 

Blinn, etc.) to create a new surface shader. This action will add the shader to the 

work area and generate its associated shading group. 

3. Select Your Model: In the viewport, select the 3D model to which you want to 

apply the shader. 

4. Assign the Shader: Right-click on the newly created surface material in the work 

area of the Hypershade. 
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Choose Assign Material to Selected from the context menu. This step assigns the 

material shading group to the model’s shape node, effectively applying the material 

to the selected object. 

5. Adjust Shader Properties (Optional): 

After assigning the shader, you can adjust its properties in the Attribute Editor 

(usually on the right side of the interface) to fine-tune its appearance, such as 

colour, transparency, reflectivity, and Texture Mapping. 

Activity 2: Exploring Shader Types in Texturing 

Materials Required: 3D software (e.g., Maya) and 3D models (simple objects like 

spheres or cubes) 

Procedure 

1. Introduction: 
• Brief overview of shaders (Diffuse, Specular, and Special Effect 

shaders). 
2. Hands-On Application: 

• Diffuse Shader: Apply a Lambert shader to a model and observe its 
matte effect. 

• Specular Shader: Apply a Blinn or Phong shader to simulate reflective 
surfaces (metal, glass). 

• Effect Shader: Apply Surface and Layered shaders for stylized or 
complex material effects (e.g., rust, water). 

3. Shader Comparison: 
• Compare the visual results of each shader. 
• Discuss which shader suits specific materials (e.g., matte, shiny, 

complex surfaces). 
4. Reflection : 

• Discuss shader choices and their applications in 3D projects. 
• Consider how different shaders behave with light and materials. 

 

Check Your Progress 

  
 

A. Multiple Choice Questions 

 

1. What is the primary purpose of applying textures to 3D models in Maya? 

a) To make the model lighter 

b) To define the physical appearance and feel of a surface 

c) To increase the rendering speed 

d) To reduce the file size of the model 
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2. Which type of texture allows you to apply multiple layers of textures to a material 

in Maya? 

a) 2D Texture 

b) 3D Texture 

c) Layered Texture 

d) Environment Texture 

 

3. In Maya, which of the following textures can be used to create realistic water 

effects? 

a) Noise Texture 

b) Ocean Texture 

c) Cloud Texture 

d) Ramp Texture 

 

4. What is the main characteristic of procedural textures in Maya? 

a) They are resolution-dependent 

b) They require external image files 

c) They are mathematically based and resolution-independent 

d) They can only be used at a distance 

 

5. Which shader would you use to create a glossy, reflective surface like water or 

polished metal? 

a) Diffuse Shader 

b) Specular Shader 

c) Glossy Shader 

d) Transparent Shader 

 

6. You need to apply a shader that results in a matte, non-reflective surface, such 

as concrete or wood. Which shader should you use? 

a) Phong Shader 

b) Diffuse Shader 

c) Glossy Shader 

d) Reflective Shader 

 

7. Which shader type is best suited for simulating materials like glass, which need 

to reflect and refract light? 

a) Emissive Shader 

b) Refractive Shader 

c) Transparent Shader 

d) Diffuse Shader 

8. What effect does applying a Specular Shader to a surface have? 

a) Adds a glowing effect 

b) Makes the surface highly reflective 

c) Applies a transparent effect 

d) Gives a matte finish 
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9. Which shader would be appropriate to simulate a surface with both rough and 

smooth areas, such as rust on metal? 

a) Subsurface Scattering Shader 

b) Bump Map Shader 

c) Roughness Shader 

d) Procedural Shader 

 

10. If you want a material to have a high level of reflectivity but low diffuse 

properties, which shader would you choose? 

a) Lambert Shader 

b) Glossy Shader 

c) Phong Shader 

d) Emissive Shader 

 

Session 4: Maya Material Nodes  

  
 

In Autodesk® Maya®, material nodes are essential components that determine how 

surfaces interact with light, enabling artists to replicate the properties of real-world 

materials within a 3D environment. These nodes provide the tools necessary for 

manipulating the visual attributes of surfaces, leading to realistic rendering effects. 

Here is an overview of the significance and functionality of material nodes in Maya: 

Importance of Material Nodes 

i. Light Interaction: Material nodes control how light reflects, refracts, and 

absorbs when it hits a surface. This interaction is vital for creating realistic-

looking materials, as different materials behave differently under light. 

ii. Realism in 3D Rendering: By using various material nodes, artists can 

simulate a wide range of surface properties such as glossiness, transparency, 

texture, and colour, enhancing the overall realism of 3D models. 

iii. Customizability: Maya provides a variety of material nodes, each with unique 

attributes that can be customized. This flexibility allows artists to create 

specific visual effects tailored to the needs of their project. 

Types of Material Nodes 

In Autodesk® Maya®, material nodes are essential components of the shading and 

texturing process. These nodes define the appearance of the surfaces of 3D objects, 

controlling their properties such as colour, reflectivity, transparency, and how they 

interact with light. Understanding how material nodes work is crucial for creating 

realistic or stylized 3D models. Below are some key material nodes in Maya: 
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1. Lambert 

• Type: Diffuse material 

• Properties: This material is non-reflective and ideal for matte surfaces. It’s 

commonly used for surfaces that don’t reflect light, like chalk or fabric. 

2. Phong 

• Type: Specular material 

• Properties: This material has a reflective surface and is commonly used for 

shiny surfaces like plastic or metal. 

3. Blinn 

• Type: Specular material (like Phong, but with a different reflection model) 

• Properties: Often used for materials with softer reflections, such as skin, 

rubber, or satin. 

4. PhongE 

• Type: Specular material 

• Properties: Similar to Phong, but provides a more energy-efficient reflection 

model, making it suitable for rendering high-quality results. 

5. Anisotropic 

• Type: Reflective material 

• Properties: This material is used to simulate materials like brushed metal, 

hair, or satin that have directional specular highlights. 

6. Lambert 2 

• Type: Enhanced Lambert shader 

• Properties: This shader offers more control and is used in cases where basic 

Lambert doesn’t suffice, offering enhanced control over diffuse reflections and 

other properties. 

7. Standard Surface (Arnold) 

• Type: Physically-based rendering material (PBR) 

• Properties: This is the standard material in Arnold for Maya and is used to 

create realistic materials. It combines diffuse, specular, and other complex 

properties into one shader. 

8. Use Background 

• Type: Special-purpose material 
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• Properties: Used in compositing and matte painting setups. This material is 

often used for creating invisible background objects that receive shadows but 

don’t show up in reflections or other visual elements. 

9. Surface Shader 

• Type: Custom material 

• Properties: This shader is used to create a completely flat or unique material 

that can be customized by combining other shaders, providing flexibility for 

complex shading setups. 

10. Car Paint 

• Type: Advanced reflection material 

• Properties: This material simulates the complex layers in automotive paint, 

including clear coat and metallic flakes for more realistic results in 

automotive design. 

11. Subsurface Scattering (SSS) 

• Type: Translucent material 

• Properties: Used to simulate materials like skin, wax, or marble where light 

penetrates the surface before being scattered inside. 

12. Ocean Shader 

• Type: Specialized material for water 

• Properties: Used for simulating oceans, lakes, or other large bodies of water 

with detailed surface waves and reflections. 

13. Wireframe Shader 

• Type: Visualization material 

• Properties: Used for creating a wireframe effect on 3D models, which helps 

with debugging and visualizing geometry. 

14. aiStandardSurface (Arnold) 

 

• Type: A versatile shader in Arnold that supports a wide range of material types, 

including metals, plastics, and skin.  

• Properties: It combines multiple shading properties into a single node.  It is 

excellent for realistic rendering of complex materials, such as character skin, 

car paint, and reflective surfaces. 
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15. Arnold's aiStandard Hair 

 

• Type:It is specifically designed for hair and fur, this shader allows for realistic 

rendering of hair strands, providing control over attributes like colour, 

glossiness, and transparency.  

• Property: It is used in character creation and animation for realistic hair 

rendering. 

 

16. aiStandardVolume 

 

• Type: This shader is used for creating volumetric effects like fog, smoke, or 

translucent materials. It allows for scattering and absorption of light within the 

volume. 

• Property: It is useful for creating atmospheric effects in scenes or rendering 

materials like wax or jelly. 

 

17. ShaderFX 

 

• Type: A node-based shader creation tool that allows artists to create custom 

shaders visually.  

• Property: ShaderFX can create various effects, from cartoonish styles to 

complex surface textures.  It is ideal for game assets and stylized renders where 

unique visual effects are required. 

 

18. Texture Shader (File Texture) 

 

• Type: Although not a surface shader per se, file textures can be applied to any 

surface shader to give it a specific look by using image files (e.g., JPG, PNG).  

• Property: It is used in combination with other shaders to create detailed 

surfaces, like wood grain, brick patterns, or skin textures. 

19. Use Background Shaders 

 

• Type: This shader is applied to objects to ensure their interactions with the 

background are visually coherent.  

• Property: It is particularly useful for integrating 3D models into a scene with 

background images. Allows objects to cast shadows onto the background and 

creates "holes" in the alpha channel where the material appears, enhancing 

realism. 

 

20. Ocean Shaders 

• Type: Specifically designed for simulating water surfaces, allowing users to 

define colour schemes and depth.  
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• Property: It creates visually appealing water effects that respond dynamically 

to lighting and camera angles. 

21. Hardware Textures  

• Type: These are optimized for rendering performance, particularly in real-time 

applications or game engines. Examples: Lambert Shader. 

• Property: Provides a matte finish and is commonly used for non-reflective 

surfaces. 

22. ShaderFX 

• Type: A node-based shader creation tool for advanced material effects and real-

time rendering.  

• Property: It helps to create complex effects like subsurface scattering, 

reflections, and PBR.  

23. Volume Shaders 

• Type: Designed for rendering volumetric effects, such as smoke, fog, and fire.  

• Property: These shaders simulate how light interacts with particles or fields 

within a volume rather than on a surface. 

 

Activities 

  
 

Activity 1: Create double-sided shading texture 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure  

• Begin by applying a Phong material to the surface you want to use for double-

sided shading. 

• Open the Hypershade and find the textures you’ll be using. For this activity, 

use a checker texture and a crater texture. 

• In the Hypershade, create a Condition node. This node will control the colour 

output based on the side of the surface. 

• Connect the Checker’s out Colour attribute to the Condition node’s colour. 

This will set the checker texture to display on one side of the surface. 

• Connect the Crater’s out Colour attribute to the Condition node’s colour, If 

False attributed. This assigns the crater texture to the opposite side. 

• Create a Sampler Info node, which will determine which side of the surface is 

facing outward. 

• Connect the Sampler Info’s flipped. Normal attribute to the Condition node’s 

first Term or second Term attribute. This setup controls when each texture will 
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appear based on the surface orientation. 

• Connect the Condition node’s out Colour attribute to the Phong material’s 

colour attribute. This link allows the Phong material to alternate textures based 

on the Condition settings. 

• Perform a test render. Each side of the surface should display a different 

texture (checker on one side and crater on the other), creating a double-sided 

shading effect. 

Activity 2: To apply material nodes for realistic 3D rendering in Maya. 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure  

1. Prepare the Scene 

• Open Maya and load a model (e.g., sphere, cube). 

• Set Arnold as the renderer. 

2. Apply Material Nodes 

• Lambert: Create a Lambert node for matte surfaces (e.g., fabric). Adjust the 

colour. 

• Phong: Create a Phong shader for shiny surfaces (e.g., metal). Adjust 

specular and reflectivity. 

• aiStandardSurface: Apply this Arnold shader for complex materials like skin 

or metal. Adjust roughness and specular. 

3. Use Specialized Shaders 

• Subsurface Scattering: Apply for materials like skin or wax. Adjust 

scattering radius. 

• Ocean Shader: Apply to simulate water surfaces and adjust wave height and 

reflection. 

4. Customize with ShaderFX 

• Use ShaderFX to create custom shaders with a node-based interface for 

unique effects. 

5. Test Light Interaction 

• Set up lighting and observe how materials reflect light: 

o Lambert: Soft, no reflections. 

o Phong: Reflective highlights. 

o aiStandardSurface: Realistic rendering with reflections and 

subsurface effects. 

6. Render the Scene 

• Adjust camera angles and render settings. 

• Review the final render to see the material effects. 
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Check Your Progress 

  
A. Multiple Choice Questions 

1. Which material node is most suitable for creating a non-reflective, matte surface 

like fabric or chalk in Maya? 

a) Phong 

b) Lambert 

c) aiStandardSurface 

d) Ocean Shader 

 

2. For simulating a glossy, reflective surface like plastic or metal, which material node 

should be used? 

a) Phong 

b) Lambert 

c) aiStandardSurface 

d) Subsurface Scattering 

 

3. When rendering a character's skin with realistic translucency and light scattering, 

which shader is the best choice in Maya? 

a) aiStandardSurface 

b) Subsurface Scattering (SSS) 

c) Blinn 

d) aiStandard Hair 

 

4. To simulate an ocean's surface with dynamic wave behavior and reflective 

properties, which shader should be applied? 

a) PhongE 

b) Ocean Shader 

c) aiStandardSurface 

d) ShaderFX 

 

5. Which material node would you use for creating realistic car paint with complex 

layers like clear coat and metallic flakes? 

a) aiStandardHair 

b) Car Paint 

c) Phong 

d) Surface Shader 

 

6. For applying complex, custom shader effects in a real-time game engine, which 

node-based tool in Maya would be most useful? 

a) aiStandardVolume 

b) ShaderFX 

c) Lambert 2 

d) Use Background 
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7. To render materials that scatter light through a surface, such as skin, wax, or 

marble, which material node should be used? 

a) aiStandardSurface 

b) Subsurface Scattering (SSS) 

c) Blinn 

d) Phong 

 

8. Which material node is best for creating a highly reflective surface that can simulate 

brushed metal or satin? 

a) Lambert 

b) Anisotropic 

c) Surface Shader 

d) PhongE 

 

9. When creating a simple, flat surface without any shading complexity, which shader 

would be most suitable? 

a) aiStandardSurface 

b) Surface Shader 

c) aiStandardVolume 

d) Lambert 

 

10. For creating volumetric effects like smoke or fog that scatter light, which material 

node should be used? 

a) aiStandardVolume 

b) aiStandardSurface 

c) Subsurface Scattering 

d) Ocean Shader 

 

 

Session 5: Real Life 3D Model 

  
 

Creating a 3D Realistic Shark in Autodesk® Maya® Using Subdivision Surfaces 

 

3D models are digital representations of physical objects, constructed with points in 

3D space connected through geometric elements like triangles, lines, or curved 

surfaces. In this activity, we will create a lifelike 3D shark in Maya using Subdivision 

Surfaces a unique modelling approach that combines the smooth, organic qualities of 

NURBS with the flexibility and detail control of polygons. 

 

Workflow Overview: Creating a realistic shark model involves several stages: 

 

i. Modelling 

ii. UV Mapping 

iii. Texturing 
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iv. Rigging  

v. Rendering.  

Each step is integral to achieving a believable, lifelike 3D model.  

 

Step 1: In Maya, Subdivision Surfaces are designed to bridge the characteristics of 

Polygon and NURBS surfaces: 

 

NURBS-Like Smoothness: Subdivision surfaces enable smooth, flowing shapes with 

minimal control vertices, ideal for organic forms like animals. They offer polygon-like 

detail control, allowing intricate refinements by extruding specific areas and adjusting 

detail levels as needed. This multi-level control makes it easy to switch between 

different detail levels on the same surface. Additionally, Maya allows seamless 

conversion between NURBS, polygons, and subdivision surfaces, enhancing modelling 

flexibility. 

 

Step 2: Setting Up the Scene with Reference Images 

To accurately shape the shark, start with polygon modelling and later convert to a 

Subdivision Surface to leverage its controls. Use reference images for guidance in 

achieving realistic proportions. 

 

Steps for Setting Up Reference Images: 

 

i. Open the View menu in the panel menu bar. 

ii. Select Import Image under the Image Plane submenu to load the side, top, and 

front views of the shark as background images (Figure 1.18). 

iii. By positioning these references in your viewport, one can begin shaping the 

shark using polygonal geometry, which will later be refined with Subdivision 

Surface controls for smoothness and detail.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1.18: View menu on the panel menu bar 
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Using this method, one has to imported all three reference images into the background 

(Figure 1.19). One can adjust the attributes of each image by going to View > Image 

Plane > Image Plane Attribute (Figure 1.20). 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.20: Adjusting attribute of images 

Figure 1.19: Showing Perspective and other angles (Front, Top and Side) 
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In the Image Plane Attribute settings, use the Centre X, Y, Z and Width values as 

needed to match the images (Figure 1.21). 

 

 

The interface should look like this after matching the reference images (Figure 2.22). 

 

 

Modelling the Body 

 

Step 1 

 

Now to begin the modelling process, create a Cylinder poly primitive in the Front view. 

(Figure. 1.23)  

 

 

 

Figure 1.22: Interface after matching the reference image 

 

Figure 1.21: Adjusting Properties 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

40 
 

                                                                     Texturing Artist - Grade XII  

 

 

 

Step 2 

 

Now with the polyCylinder selected, press Control-A to open its Channels 

Settings attributes. Go to the INPUTS tab and keep the Sub Divisions Axis value at8, 

and the Subdivisions Height value at 4 (Figure 1.24). 

 

 

 

 

 

 

Figure 1.24: Setting value of subdivision axis and subdivision height 

 

Figure 1.23: Create Cylinder for Modelling process 
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Step 3 

 

Then press the F9 key to jump into Vertex selection mode, and arrange the vertex 

according to the Front and Side reference images (Figure. 1.25). 

 

 

Arrange the vertex according to the Top reference image also (Figure. 1.26). 

 

 

 

 

 

Figure 1.26: Arrangement of vertex according to top reference image 

 

Figure 1.25: Vertex arrangement according to front and Side reference 
images 
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Step 4 

 

Now in the Perspective view and with the polyCylinder mesh still selected, 

pressF11 to jump into Face selection mode, and select the front and the back cap 

faces. Then press the Delete key to delete the selected faces (Figure. 1.27). 

 

 

Next, jump into the Front view and select half of polyCylinder mesh. And press the 

Delete key to delete the selected faces (Figure. 1.28). 

 

 

 

 

 

 

Figure 1.28: Front view of poly cylinder mesh 

 

Figure 1.27: Perspective view of the poly 

cylinder mesh 
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Step 5 

 

After deleting half of the side faces, select the remaining half and press F8 key to jump 

into Object selection mode. Then go to the Edit menu and click on the Duplicate 

Special options box (Figure. 1.29) 

 

 

 

Step 6 

 

In the Duplicate Special Options, turn on the Instance radio button and keep the 

Scale value for the X Axis at -1.00, and then click on the Duplicate Special button. 

(Fig. 1.31) 

 

 

 
Figure 1.30: Set scale value for the X Axis at -1.00 

 

Figure 1.29: Click Edit menu and also click on the duplicate 
special options box. 
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Step 7 

 

In this step, an instanced copy of the mesh has been created along the -X axis. This 

means that any adjustments made to the original mesh will be mirrored on the 

instanced copy in real time (Figure. 1.31). 

 

Instancing is particularly useful for symmetrical modelling tasks, like creating 

characters or objects with bilateral symmetry, as it allows you to focus on modelling 

one half while the mirrored side updates automatically. This approach is both efficient 

and ensures that any modifications maintain symmetry across the -X axis. 

 

Step 8 

 

 

 

 

 

 

 

 

Figure 1.31: Instanced duplicate of the mesh 
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Now press F10 to enter Edge selection mode, and select one half of the border edge 

on the front left side (Figure 1.32). 

 

 

 

 

Step 9 

 

Jump into the Side view, go to the Edit Mesh menu and click on the Extrude 

command (Figure 1.33). 

 

 

 

Figure 1.33: Extrude command 

 

Figure 1.32: Selection of one half of the border edge 
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Step 10 

 

Following the same approach, the border edge has been extruded five times moving 

gradually toward the shark's head. Each extrusion step brings additional geometry to 

shape the body, allowing finer control over the form and contours of the shark's 

structure. This method ensures a smooth transition along the body, helping to capture 

the natural, organic shape of the shark as it narrows towards the head (Figure 1.34). 

 

 

 

Step 11 

 

While still in the same Side view, press the 4 key to convert the selected mesh into 

Wireframe mode, and also press F9 to jump into Vertex selection mode. Then try to 

arrange the vertex according to the reference image, as shown (Figure. 1.35). 

 

 

Step 12 

 

Once done, go to the Edit Mesh menu and select the Split Polygon Tool (Figure 

1.36). 

 

Figure 1.35: Arrangement of vertex according to the reference image 

 

Figure 1.34: Extruding of border edge towards shark’s head 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

47 
 

                                                                     Texturing Artist - Grade XII  

 

 

Step 13 

 

With the Split Polygon Tool selected, split and divide the faces indicated below for 

the upper and lower parts of the shark's mouth (Figure 1.37). 

 

 

Step 14 

 

Press F11 to jump back into Face selection mode, and then with the four lower 

unnecessary faces selected (marked below), press the Delete key to delete them 

(Figure 1.38). 

Figure 1.37: Upper and lower parts of the shark's mouth. 

 

Figure 1.36: Clicked edit mesh menu and selected the split polygon tool 
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After deleting the faces, it should look something like this (Figure 1.39). 

 

 

Step 15 

 

Also jump into the Top view and arrange the vertex by pressing F9 (Figure 1.40). 

 

 

 

 

Figure 1.40: Arrangement of the vertex at top views 

 

Figure 1.39: Image after deletion of selected faces 

Figure 1.38: Face selection mode 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

49 
 

                                                                     Texturing Artist - Grade XII  

Step 16 

 

Once again press the F11 to enter Face selection mode, and then select the faces 

inside the mouth (indicated below), and Delete them (Figure 1.41). 

 

 

 

 

 

 

 

Step 17 

 

Now we need to insert several edge loops to add more detail. Go to the Edit Mesh 

menu and select the Insert Edge Loop Tool (Figure 1.42). 

 

 
Figure 1.42: Insertion of several edge loops 

 

Figure 1.41: Selection of the faces inside the mouth 
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With the Insert Edge Loop Tool selected, insert two edge loops along the upper and 

lower body as shown in the image below (Figure 1.43). 

 

 

 

 

Step 18 

 

Jump into the Side view and insert four more edge loops around the mouth area, as 

shown (Figure 1.44). 

 

 

Modelling the Tail 

 

Step 1 Now Extrude the back border edge three times for the shark's tail (Figure 

1.45) 

Figure 1.44: Four more edge loops around the mouth area 

 

Figure 1.43:  Two edge loops along with the upper and lower body 
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Step 2 

 

Press F9 for Vertex selection mode, and then arrange the tail vertex according to the 

reference image (Figure 1.46). 

 

 

 

Also jump into the Top view, and arrange the vertex here too according to the 

reference image (Figure 1.47). 

 

 

 

Figure 1.47: Top view and arranged vertex according to the reference image 
 

Figure 1.46: Vertex selection mode 

Figure 1.45: Extruded back border edge of the shark's tail. 
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Step 3 

 

Now Extrude the tail edges three more times to the end corner, as shown in the 

following image (Figure 1.48) 

 

 

 

Step 4 

 

Press F9 to enter Vertex selection mode, and then expand and arrange the vertex 

according to the reference image (Figure 1.49). 

 

 

Step 5 

 

Jump into the Perspective view now and press F11 to enter Face selection mode. 

And then select the both top faces (Figure 1.50). 

 

 

 

 

 

 

 

Figure 1.49: Expansion and arrangement of the vertex 
 

Figure 1.48: Extruded tail edges three more times to the end corner 
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Step 6 

 

With the top faces selected, jump into the Side view and then using the Extrude 

command, Extrude them two times towards the end of the tail fin (Figure 1.51). 

 

 

 

Do the same with the lower tail faces also (Figure 1.52). 

 

 Figure 1.52: Extrude two times towards the end of the lower tail fin 

Figure 1.51: Extrude two times towards the end of the upper tail fin 
 

Figure 1.50: Perspective view of both top faces 
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Step 7 

 

After extruding, press the F9 key to enter front left side Vertex selection mode and 

arrange the tail fins according to the shape shown on the reference image (Figure 

1.53). 

 

 

 

 

Step 8 

 

Now go back to the Perspective view and focus on the back of the tail mesh. Here we 

need to fill the gap between the polygons, so first press F10 for Edge selection mode 

and then select the two border edges, as shown in the image below (Figure 1.54). 

 

 

 

Step 9 

 

With the edges selected, Extrude them two times while maintaining the edge loops. 

(Figure 1.55). 

 

 

 

 

 

Figure 1.54:  Focus on the back of the tail mesh 
 

Figure 1.53: Click Front left side Vertex selection mode and arrangement of 
the tail fins 
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Step 10 

 

Now we need to weld the vertex. With both of the vertex selected, go to the Edit 

Mesh menu and choose the Merge command to weld the selected vertex together 

(Figure 1.56). 

 

 

 

Step 11 

 

Following the same process, weld the vertex of the lower tail also (Figure 1.57). 

 

 

Figure 1.57: Use merge command to weld the vertex of lower tail 

 

Figure 1.56: Use merge command to weld the selected vertex together 

 

Figure 1.55: Extruded two times while maintaining the edge loops 
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Creating the Fins 

 

Step 1 

 

We need some more faces to create the dorsal fins. With the Insert Edge Loop 

Tool selected, insert three edge loops around the fin areas as shown in the image 

below (Figure 1.58). 

 

 

Step 2 

 

Now in the Side view, press F11 to enter Face selection mode and select the top faces 

around the area of the dorsal fin (Figure 1.59). 

 

 

 

 

 

 

 

Figure 1.59: Select the top faces around the area of the dorsal fin. 

Figure 1.58: Inserting of three edge loops around the fin 
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Step 3 

 

With the faces selected, Extrude them upward two times as shown (Figure 1.60). 

 

 

 

Step 4 

 

Again press F9 to access Vertex selection mode, and then arrange the vertex 

according to the background image (Figure 1.61). 

 

 

 

Step 5 

 

While in the Perspective view, select half of the shark model. Then go to the Show 

menu, and check on the View Selected check box inside the Isolate Select sub 

menu. This will isolate the selected half of the shark body (Figure 1.62).   

 

 

 

Figure 1.61: Vertex arrangement 
 

Figure 1.60: Extruded selected faces upward two times 
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Step 6 

 

 

This step is essential to remove unwanted faces hidden within the body structure. 

The dorsal fin faces are still present internally, which could lead to issues later on. 

To address this, press the F11 key to enter Face selection mode, select the dorsal fin 

faces from the interior, and press the Delete key to remove them (Figure 1.63). 

 

 

 

Step 7 

Now we will make the anal fins of the shark. Select the top and bottom faces around 

these fins according to the reference image (Figure. 1.64). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.64: Making of anal fin of the shark 
 

Figure 1.63:  Process of deleting of unwanted faces hidden inside the body 

 

Figure 1.62: View selected check box inside the Isolate sub menu 
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Step 8 

 

With the faces selected, apply the Extrude command and then Extrude them once 

(Figure. 1.65). 

 

 

Step 9 

 

Back in Vertex selection mode, arrange the vertex properly (Figure 1.66). 

 

 

Step 10 

 

Back in the Perspective view. Select the inside faces of the anal fins and then 

Delete them, as we did previously with the dorsal fin (Figure. 1.67). 

 

 

Figure 1.66: Arrangement of vertex in the vertex selection mode 

 

Figure 1.65: Extrude command applied on the selected faces 

Figure 1.67: Selection of inside faces of the anal fins 
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Step 11  

After that, bring the vertex closer to each other and make the required adjustments 

(Figure 1.68). 

 

 

Step 12 

 

Now we will make the pelvic fin of the shark. Select the bottom face around the pelvic 

fin area according to the reference image (Figure 1.69). 

 

 

Step 13 

 

And Extrude the selected face once (Figure 1.70). 

 

 

Figure 1.70: Extrude the selected face  

 

Figure 1.69: Pelvic fin of the shark 
 

Figure 1.68: Adjustments of vertex closer to each other 
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Head back to the Perspective view, and properly arrange the vertex of the pelvic fin 

(Figure 1.71). 

 

 

Also, jump into the Top view, and then try to maintain the shape according to the top 

reference image (Figure 1.72). 

 

 

Step 14 

 

Now we will make the pectoral fins of the shark. Select the two bottom faces around 

the pectoral fin area following their placement on the reference image (Figure 1.73). 

 

 

 

 

Figure 1.73: Making of Pectoral fin of the shark 

 

Figure 1.72: Adjustment of the shape according to top reference image. 

Figure 1.71: Process of arrangement of vertex of the pelvic fin. 
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Step 15 

 

With the faces selected, go to Edit Mesh and select the Extrude tool (Figure 1.74). 

 

 

Step 16 

 

In the Top view, Extrude the faces two times as shown (Figure 1.75). 

 

 

Step 17 

 

Also try to arrange the vertex according to the reference image (Figure 1.76). 

 

 

 

 

 

Figure 1.76: Arrangement of the vertex according to the reference image 

 

Figure 1.75: Extrude the faces two times in the top view 
 

Figure 1.74: Selection of the Extrude tool 
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Step 18  

To make the fin curved, we need to add several edge loops. Again go to the Edit Mesh 

menu, and then select the Insert Edge Loop Tool (Figure 1.77). 

 

Step 18 

To make the fin curved, we need to add several edge loops. Again go to the Edit 

Mesh menu, and then select the Insert Edge Loop Tool (Figure 1.77). 

 

Step 19 

Here we have inserted one edge loop, and then arranged the vertex according to 

reference image (Figure 1.78). 

 

 

 

 

 

 

 

 

 

Figure 1.78: Arrangement of the vertex according to reference image 

 

Figure 1.77: Making of fin curved 
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Step 20 

 

Next, jump in the Front view and then try to match the fin’s outline to the reference 

image (Figure 1.79). 

 

 

Creating the Nose and Mouth 

Step 1 

 

Now we'll work on the tip of the nose. Select the edge of the nostril and then Extrude it 

once, as shown in the image (Figure 1.80). 

 

Step 2 

 

With the help of the Insert Edge Loop Tool, insert one edge between the extruded 

faces as shown (Figure 1.81). 

 

 

 

Figure 1.81: Inserting one edge between the extruded 
faces 

 

Figure 1.80: Extrude the edge of the nostril 

 

Figure 1.79: Matching the fin’s outline 
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Step 3 

 

Now select the two corresponding vertex and go to the Edit Mesh menu, and 

choose Merge (Figure 1.82). 

 

 

Step 4 

 

Using this method, complete the merging operation on the remaining pair of vertex. 

Now select the eight boarder edges (Figure 1.83). 

 

 

Step 5 

 

With the edges selected, Extrude them once towards the inside to fill the gap (Figure 

1.84). 

 Figure 1.84: Filling gap between eight border edges 

 

Figure 1.83: Merging operation of the remaining pair of vertex 
 

Figure 1.82: Merging of two corresponding vertex 
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Step 6 

 

We'll do the same thing for the lower jaw. Select the three edges of the lower jaw, as 

shown in the image (Figure 1.85). 

 

 

Step 7 

 

With the lower jaw edges selected, Extrude these inside the same as we did with the 

upper jaw’s edges (Figure 1.86). 

 

 

 

Step 8 

 

Now let us isolate half of the shark's body. So with exactly half of the shark’s body 

selected, go to the Show menu (in the menu bar), and then check on the View 

Selected check box, from inside the Isolate Select submenu (Figure 1.87). 

 

Figure 1.86: Filling gap between eight border edges 

 

Figure 1.85: Filling gap between three edges of the lower jaw 
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Step 9 

 

Now go to the Edit Mesh menu and select the Append to Polygon Tool (Figure 1.88). 

 

 

 
Figure 1.88: Append to polygon tool selected 

 

Figure 1.87: Isolating half of the shark’s body 
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With the Append to Polygon Tool selected, click on the parallel border edges to 

create a face to fill the gap. Then press Enter to apply and finish with the Append to 

Polygon Tool (Figure 1.89). 

 

 

Step 10 

 

Now we need to split some faces to add more detail. Go to the Edit Mesh menu and 

select the Split Polygon Tool (Figure 1.90). 

 

 

Step 11 

 

With the Split Polygon Tool selected, split the mouth border faces as shown in the 

image below (Figure 1.91). 

Figure 1.90: Splitting the faces of image 

 

Figure 1.89: Creating face to fill the gap 
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Also split the corner faces, to eliminate the triangulated faces (Figure 1.92). 

 

 

 

Step 12 

 

Now, select the faces inside the mouth (Figure 1.93). 

 

 

 

 

 

Figure 1.93: Face inside mouth selected 
 

 

 

Figure 1.92: SplitIing the corner faces 
 

Figure 1.91: SplitIing the mouth border faces 
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Step 13 

 

With the inner mouth polygons selected, Extrude them once, as shown in the image 

(Figure 1.94). 

 

Step 14 

 

After extruding the faces, select the unneeded border faces (as shown in the image.) 

and Delete them (Figure 1.95). 

 

 

Step 15 

 

After deleting the faces, press F9 for Vertex selection mode and then arrange the 

vertex to form a gap inside the mouth (Figure 1.96). 

 

 

 

 

Fig.1.92: Unneeded border  

 

Figure 1.94: Polygons extruded 

Figure 1.95: Unneeded borders 
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Step 16 

 

Also insert an extra edge loop with the Insert Edge Loop Tool, as shown in the image 

(Figure 1.97). 

 

Step 17 

 

We have now completed the blocking of the shark mesh. Now we can convert it into 

Sub div mode to add more details, or we can convert it later after completing the 

modelling of the eyes and nostrils (Figure 1.98). 

 

 

Refining the Head 

 

Step 1 

 

In this case, we will complete the eye and nose parts first, and then convert it to 

subdivision later, to add extra detail with sculpting. Select the two faces around the 

eye area, and then Extrude them inwards to make the eye socket (Figure 1.99). 

 

 
Figure 1.99: Completing the eye and nose parts 

 

Figure 1.98: Blocking of the shark mesh 
 

Figure 1.97: An extra edge loop inserted 
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Step 2 

 

Also add an edge loop to make the nose hole, as shown in the image (Figure 1.100) 

below. 

 

Step 3 

 

Will do the same thing for the nostrils as well. 

 

Step 4 

 

Select the two faces around the nostril area, and Extrude them inwards to make a 

hole (Figure 1.101). 

 

 

Adding the Gills 

Step 1 Now will make the gill slits for the shark. With the help of the Insert Edge 

Loop Tool, insert three edge loops around the gill area, according to the reference 

image (Figure 1.102). 

 

 
Figure 1.102: Making the gill slits for the shark 

Figure 1.101: Making of hole 

 

Figure 1.100: Making of nose hole while adding an edge loop 
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Step 2 

 

Using the Split Polygon Tool, split each gill slit edge to add more detail (Figure 

1.103). 

 

Step 3 

 

Now press F11 for Face selection mode, and with all the split faces selected, 

Extrude them inside to create a cavity (Figure 1.104). 

 

Step 4 

 

We have now completed the base model of the shark. But we still need to add more 

detail to it (Figure 1.105). 

 

 
Figure 1.105: Base model of the shark 

 

Figure 1.104: Creating cavity 

 

Figure 1.103: Spliting each gill slit edge 
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Combining Meshes 

 

Step 1 

 

Now will use subdivision conversion to do sculpting and detailed modelling. First 

select both side meshes, and then go to the Mesh menu and choose Combine, to 

attach the selected polygon meshes together (Figure 1.106). 

 

 

Step 2 

 

Now select a pair of border vertex along the centre, and then go to the Edit Mesh 

menu and select Merge, to weld the selected vertex (Figure 1.107). 

 

 
Figure 1.107 Welding the selected vertex 

Figure 1.106: Subdivision conversion 
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Step 3 

 

In this way, select and Merge all the centre border vertex one by one (Figure 1.108). 

 

 

Initial UVs 

 

Step 1 

 

Before converting from polygon to a subdivision surface, we need to apply UV Mapping 

for texturing. With half of the shark body mesh selected, go to the Create UVs menu, 

and click on the Planar Mapping options box (Figure 1.109). 

 

 

 

 

 

 

 

Figure 1.109: Applying UV Mapping for texturing 

Figure 1.108: Merging all the centre border 
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In the Planar Mapping Options box, turn on the Fit projection: Best Plane radio 

button, as shown in the image below (Figure 1.110). 

 

Step 2 

After applying a Planar Map, go to the Edit UVs menu and select UV Texture Editor 

to see the UV Map (Figure 1.111). 

 

  

 

 

 

Figure 1.111: Applying a planar Map 

 

Figure 1.110: Turning on the fit projection 
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You can see the result of the applied Planar Map from a side view of the shark body 

mesh (Figure 1.112). 

 

 

Step 3 

 

To apply the Planar Map to the other side, first select the half with the applied Planar 

Map, and then go to the Edit menu and select Invert Selection (Figure 1.113). 

 

 

 

Figure 1.113: Applying the Planar Map to the other side 
 

Figure 1.112:  Result of the applied Planar Map 
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With the other side’s faces selected, go to Create UVs and select Planar Mapping 

(Figure 1.114). 

 

 

You can see the result in the UVs Texture Editor window (Figure 1.115). We will edit 

it later. 

 

 

 

 

 

 

Figure 1.115: Result in the UVs Texture editor window 

Figure 1.114: Selecting Planar Mapping 
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Mesh Clean-up 

 

Step 1 

 

Now with the shark body mesh selected, go to the Edit menu and select History, from 

inside the Delete by Type submenu to delete the history (Figure 1.116). 

 

 

Step 2 

 

Now go to the Mesh menu and select Clean-up (Figure 1.117). 

 

 

 

Figure 1.117: Selecting clean-up option 

 

Figure 1.116: Selecting shark body mesh and Deleting history 
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Step 3 

 

In the Clean-up Options window, check on the No manifold geometry option and 

then click on the Clean-up button, to clean up the selected polygon mesh (Figure 

1.118). 

 

 

Converting to Subdivision 

 

Step 1 

 

After this, select the shark mesh and go to the Modify menu and click on the Polygon 

to Subdiv option box, from inside the Convert submenu (Figure 1.119). 

 

 

 

Figure 1.119: Selecting the Polygon to Subdiv option 
 

Figure 1.118: Clean up the selected polygon mesh 
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Step 2 

 

In the Convert NURBS/Polygon to Subdiv Options window, keep the Maximum 

base mesh faces value at 10000, and then click on the Create button (Figure 

1.120). 

 

 

 

 

When we convert a polygon mesh to a subdivision surface, it may delete its shader 

node. In this case, we may need to apply the shader node again (Figure 1.121). 

 

 

 
Figure 1.121: Applying shader notes 

 

Figure 1.120: Selecting Maximum base mesh faces value at 10000 
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Step 3 

 

With the shark polygon mesh selected, Right Click in the viewport and 

select Blinnfrom inside the Assign Favorite Material fly-out menu (Figure 1.122). 

 

 

Step 4 

 

Once again, you can see the surface shader has been applied to the selected shark 

mesh (Figure 1.123). 

 

 

 

 

Figure 1.123: Surface shader applied 

 

Figure 1.122: Blinn selected 
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Step 5 

 

With the shark body selected, Right Click and hold, and then chooses the Polygon 

option (Figure 1.124). 

 

Step 6 

 

Again, Right Click on the shark body and choose Standard mode. You will see some 

changes in the Standard mode; the refore we can always interchange between both 

Standard and Polygon mode to use their tools as needed. So, here we have 

selected Standard mode to use subdivision tools (Figure 1.125). 

 

 

 

Figure 1.125: Using subdivision tools 

 

 

Figure 1.124:  Polygon selected 
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Step 7 

 

Again Right Click and select Vertex mode, to select the vertex (Figure 1.126). 

 

 

Again do a Right Click and select Display Finer, to display the finer components, as 

shown in the image below. 

 

Step 8 

 

After this, you'll see the finer vertex close to the subdivision surface as control vertex. 

Now select some vertex around the lip outline and then change the mode to Surface, 

as shown in the image below (Figure 1.127). 

 

 

 

Figure 1.126: Vertex selected 

 

Figure 1.127: Changing mode to surface 
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Step 9 

 

With the same vertex selected, go to the Subdiv Surfaces menu and select Refine 

Selected Components (Figure 1.128). 

 

 

You can see some changes after using the Refine Selected Components command. 

Now you can arrange the vertex or sculpt the area as you need (Figure 1.129). 

 

 

 

 

Figure 1.129: Changes occurred 
 

 

Figure 1.128: Select Refine Selected Components 
 

Fig.1.124:SelectRefine Selected Components 
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Step 10 

 

Now you may notice that several vertexes are not displayed properly. After selecting 

those vertexes, try to adjust them a bit so you can see the finer vertex, as shown in 

the image below (Figure 1.130). 

 

 

Adding Detail to the Mouth 

 

Step 1 

 

Now select a row of vertex around the lip outline and move them up a bit (Figure 

1.131). 

 

 

If you want to check to see how it look, just click on the Current Render Frame 

button on the main tool bar (Figure 1.132). 

 

 

Figure 1.132: Observing view 

Figure 1.131: Moving vertex towards lip outline 

 

Figure 1.130: Adjusting vertex 
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You can then see the result in a rendered frame. Moving the row of the vertex has 

made a space for the teeth and gums (Figure 1.133). 

 

 

Step 2 

 

Just like this, keep arranging the vertex to sculpt the mesh as you need, and to add 

more detail (Figure 1.134). 

 

 

It will take a bit of time and your own creativity for you to come up with the teeth and 

gums space (Figure 1.135). 

 

 

 

Figure 1.135: Space between teeth and gums 

Figure 1.134: Arranging vertex 

 

Figure 1.133: Result in a rendered frame 
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Creating and Positioning the Teeth 

 

Step 1 

 

Now it’s time to create the teeth for the shark. Go to the Create menu and select the 

Cone tool, from inside the NURBS Primitives submenu (Figure 1.136). 

 

Step 2 

 

Now draw a cone shape in the viewport with the following values: Sections: 4, Span: 3. 

And also don’t forget to delete the bottom cap face (Figure 1.137). 

 

 

Step 3 

 

With the cone mesh selected, press F9 to enter Vertex selection mode and then 

arrange the vertex to form a shark’s tooth (Figure 1.138). 

 

Figure 1.137: Drawing a cone shape 
 

Figure 1.136: Creating shark’s teeth 
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Step 4 

 

Make several copies of the tooth mesh and distribute them with random scale values 

onto the lower and upper gum areas (Figure 1.139). 

 

 

 

Step 5 

 

We are now done with the teeth arrangement (Figure 1.140). 

 

 

 

 

 

Figure 1.140: Teeth job done 

 

Figure 1.139: Several copies of shark’s tooth  

 

Figure 1.138: Formation of a shark’s tooth 
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Creating the Eyes 

 

Step 1 

 

Everything is almost complete, except for the eyes. Go to the Create menu and 

select Sphere, from inside the NURBS Primitives menu (Figure 1.141). 

 

 

Jump into the Side view and draw a Sphere around the eye area, as shown in the 

background image (Figure 1.142). 

 

Step 2 

 

Finally position the sphere properly, so it looks like an eyeball (Figure 1.143). 

 

Figure 1.142: drawing a Sphere 

 

Figure 1.141: Eyes making process started 
 

Figure 1.143: Sphere position adjusted accordingly 
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Conclusion 

 

Finally, we have completed the modelling of the shark (Figure 1.144). In the next part 

of the tutorial, we will learn about proper unwrapping and texturing. I hope you 

enjoyed this part. 

 

 

 

Activities 

  
 

Activity 1: Creating a Realistic 3D Model in Autodesk® Maya® 

 

Objective: - Create a real live 3D model using Autodesk®Maya® and try to texture 

the same model as the real live version looks like. Examples of real live models are 

Table, Chair, Scooter, Motorcycle etc.  

 

Materials required: Computer system, and Autodesk®Maya® 
 

Procedure 

• Import the reference images for the chosen model (e.g., table, chair, scooter, or 

motorcycle) from various angles: front, side, top, and any other relevant 

perspectives. 

• Go to the Create menu and select Polygon Primitives > Cylinder. 

• Switch to Front View and position the cylinder as the main base of your model. 

• Press F9 to enter Vertex Selection Mode. 

• Using the Move Tool (W), adjust vertices to match the shape of the reference 

images in both the Front View and Side View. 

• Continue adjusting the vertices in the Top, Left, Right, and Front Views until 

the shape aligns with the references. 

• For more complex models, add additional geometry as needed, such as 

additional cylinders, cubes, or other primitives. 

• Extrude faces or add edge loops to create finer details, making sure to check 

from multiple angles for accuracy. 

Figure 1.144: The final result of modelling of the shark 
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• Open Hyper shade to access material nodes and create new materials such as 

Phong, Blinn, or Lambert, depending on the surface characteristics. 

• Use real-life textures (e.g., wood grain for a table, metal for a motorcycle frame) 

and apply them to the model. 

• Adjust attributes like Colour, Specularity, and Reflectivity to enhance realism. 

• Review the model from various angles and make final adjustments to textures 

and lighting. 

• Perform a Test Render to evaluate the appearance and make further 

refinements if needed. 

 

  

Check Your Progress 
  

 

A. Multiple Choice Questions 

 

1. Which of the following attributes would you adjust to control how a 3D object 

reflects ambient light in Maya?  

a) Incandescence 

b) Diffuse 

c) Ambient Colour 

d) Bump Mapping 

 

2. What is the primary purpose of Bump Mapping in Maya’s surface material 

settings?  

a) To adjust the transparency 

b) To give the appearance of a bumpy or rough surface 

c) To change the colour of the object  

d) To control ambient lighting 

 

3. In Maya, what happens to the background of the material’s Hypershade swatch 

when Transparency is increased from its default setting?  

a) It turns red 

b) It becomes a checkered pattern 

c) It becomes fully opaque 

d) It shows a gradient pattern 

 

4. If you want to make a 3D object appear to emit light without actually illuminating 

other objects, which attribute should be used?  

a) Translucence  

b) Transparency 

c) Incandescence 

d) Diffuse 
 

5. To create a glowing effect on a backlit leaf without it appearing washed out when 

front-lit, which translucence property should be adjusted?  
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a) Translucence Focus 

b) Diffuse 

c) Bump Mapping 

d) Incandescence 

 

6. What effect does increasing the translucence depth attribute have on a translucent 

object?  

a) Allows light to penetrate deeper  

b) Increases object’s opacity 

c) Controls the object’s reflection 

d) Changes the object’s colour 

 

7. Which material attribute would you adjust to simulate a frosted glass effect by 

diffusing light across a surface?  

a) Translucence 

b) Ambient Colour 

c) Incandescence 

d) Transparency 

 

8. If you want a 3D object to look like wax with light shining through it, what 

combination of settings is recommended?  

a) Low transparency and high incandescence 

b) High translucence depth and low focus 

c) High specular and low Bump Mapping 

d) Low translucence focus and high diffuse 

 

B. Subjective Questions 

 

1. Explain the advantages of using Subdivision Surfaces in Maya for modelling 

organic forms like a shark. How do they differ from traditional polygon and 

NURBS surfaces? 

 

2. Describe the process of setting up reference images in Maya for modelling. Why 

is it important to align these images accurately during the modelling process? 

 

3. Detail the steps involved in creating the initial shape of the shark's body using 

a cylinder poly primitive. What are the key modifications you must make to the 

cylinder to match the reference images? 

 

4. Discuss the significance of using vertex and face selection modes in Maya while 

modelling. How does switching between these modes facilitate the shaping of 

complex forms like a shark? 

 

5. After modelling half of the shark’s body, you use the Duplicate Special 

function. Explain the process and reasoning behind using the Instance option 

and setting the Scale value for the X Axis to -1.00. What is the outcome of this 

operation? 
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Session 6: Properties of Surface Materials  

 
 
 

The colour, shininess and reflectivity attributes of a 3D object are controlled by its 

surface material (also called as a shader, or shading material). Material Attributes 

refer to how the object is created by simulating light that naturally exists using Maya 

Software’s 3D Digital Environment. 

 

Maya assigns a default shading material called “Lambert” to all objects when they are 

first created. This section, is focused on how to assign a new material to objects. The 

following properties are common to most of the surface materials: 

 

i. Type: The material’s basic type (such as Phong). When you change a material’s 

type, only those attributes common to both types retain their previous values 

or settings. 

 

ii. Colour: The default material colour. 

 

iii. Transparency: A material’s colour and level of transparency are defined in the 

following ways: 

• If the Transparency Value is 0 (black), the surface is totally opaque and if 

the Transparency value is 1 (white), the surface is totally transparent. 

• To make an object semi-transparent, one can set the Transparency Colour to 

a shade of grey or to the same Colour as the material Colour. The default value 

is 0 (black). 

• If you change Transparency from the default black (0), the background of the 

material’s Hyper shade swatch becomes a checkered pattern. This is a visual 

aid and is not rendered. 

 

Note: 

 

If the material has specular highlights the transparency setting does not affect the 

highlights. Therefore, animating the transparency attribute to make an object 

disappear can be achieved by animating the specular highlight attributes instead. 

 

Ambient Colour 

 

The ambient colour of a material determines how it will reflect various wavelengths 

of ambient light. Ambient colour is generally set to be the same as the diffuse colour.  

 

Set to black by default, which means it does not affect the materials colour. As 

the ambient colour becomes lighter, it affects the material’s colour by lightening it and 

blending the two colours. If there are ambient lights in the scene, the colour and 
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brightness of those lights are used to control how much the ambient colour 

contributes to the final colour of the material. 

 

Incandescence 

 

• The Colour and brightness of light that material appears to be emitting. 

• The Incandescent objects do not illuminate other objects.  

• To create a lava, use a bright red Incandescence. The default Colour value is 0 

(black). 

• Although incandescence opinion makers a surface appear to glow, it does not 

actually act as a source of light in the scene. 

• One can use a little Incandescence for vegetation to make it look organic. 

 

Bump Mapping 

 

Bump Mapping is a Texture Mapping technique in computer graphics for simulating 

bumps and wrinkles on the surface of an object. This makes the surface appear rough 

or bumpy by changing the surface normal, during rendering, according to the 

intensity of the pixels in the Bump Maptexture. A Bump Map does not alter the surface 

in reality but just gives it a look (texture). A silhouette of the surface appears smooth. 

 

Diffuse 

 

This Option gives the material the ability to reflect light in all directions. 

The Diffuse value acts like a scaling factor applied to the Colour setting—the higher 

the Diffuse value, the closer the actual surface Colour is to the Colour setting. The 

valid range is 0 to infinity. The slider range is 0 (no light is reflected in all directions) 

to 1, but you can type in a higher value. The default Colour value is 0.8. 

 

Translucence 

 

Gives the material the ability to transmit and diffuse light. Light falling on a 

translucent surface is first absorbed beneath the surface, and then diffused in all 

directions. If set to 0, the default, no light shows through the object. If set to 1, all the 

light shows through. The default value is 0. Use translucence to simulate clouds, fur, 

hair, marble, jade, wax, paper, leaves, flower petals, or frosted light bulbs. 

 

Note 

• The Translucence value of a surface lit by a non-shadow-casting light is zero or 

infinite (all non-zero values). 

• If the scene combines a translucent surface with a shadow casting spotlight, faint 

grid-like artefacts may become visible. If this happens, increase the 

spotlight Filter Size or lower the Resolution. 

• For high values of translucence, lower diffuse accordingly to avoid washout. 
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• A surface’s actual translucence is based on the illumination it receives from lights, 

and is not related to its transparency. However, as an object becomes more 

transparent, its translucent (and diffuse) illumination gets dimmer. 

 
Translucence Depth 

 

Simulates the way light diffusely 

penetrates through translucent 

objects. For example, when light 

shines on one side of the object, the 

other side is partially illuminated. 

This can be used for effects such as 

clouds, fur, hair, marble, jade, wax, 

paper, leaves, and so on (Figure 

1.145). (To see this effect, turn on 

raytraced shadows for the light 

shining on the object.) 

 

Translucence depth is based on 

world space. If it is set to 0 (the 

default), no light shows through the object. If set to 10, light penetrates through the 

surface, 10 units past the point where the object is in shadow. 

 

To see the effects of translucence depth, set the transparency to a non-zero value. If 

the surface is supposed to be opaque, set the transparency to a very small value, such 

as 0.0001. 

 

Translucence Focus 

 

The Translucence Focus value controls how much translucent light is scattered 

depending on the direction of the light (Figure 1.146). 

 

 

 

 

 

 

 

 

 

 

Figure 1.146: Working of Translucence light scatter 

 

Figure 1.145: Sample showing 
Translucence Depth 
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For example, use a high 

value for very thin 

materials, such as wax 

paper or steam, where most 

of the light is scattered over 

a small angle relative to the 

light’s direction (Figure 

1.147). The object looks 

brightest with the light 

source directly 

behind it. 

 

Note: 

 

When a spotlight is used to light an object with 

a translucent material, the light does not scatter 

past the light's cone of influence, even 

if Translucence Focus is lowered (Figure 1.148). 

 

Use a mid-range focus value for items such as 

leaves. The leaves glow when backlit, but do not 

wash out when lit from the front.  

Use a low focus value for thicker objects, such 

as wax. To compensate for the added light and 

avoid a washed out result, lower the diffuse 

value, or lower the overall Colour (which also 

affects ambient lighting). 

 

Note: 

 

Lower the Colour value for very shiny objects that have a bright specular 

component. 

 

 

Activities 

  
 

Activity 1: Texture the same model as developed in earlier session to the real live 

version looks like. Examples for a real live models are Table, Chair, Scooter, 

Motorcycle etc.  

 

Material required: Computer system, and Autodesk®Maya® 

 

 

 

Figure 1.147: Sample showing Translucence light 
scatter 

Figure 1.148: Another Sample 

showing Translucence light 

scatter 
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Procedure 

• In the perspective view, click the torso and select assign new material from the 

pop-up menu. 

• Select lambert, attribute editor and select the lambert tab. 

• In the attribute editor, click the folder icon next to the image name field. 

• In the attribute editor, navigate to the mat torso tab, click the box next to Bump 

Mapping. 

• Normal Maps appear on the soldier’s chest. Normal Maps give the flat portions of 

the texture the illusion of 3D bumps. 

 

 

Check Your Progress 

  
 

A. Multiple Choice Questions 

 

1. What does the Transparency attribute of a material control in Maya? 

a) The material’s ability to reflect light 

b) The opacity level of the material 

c) The colour of the material 

d) The shininess of the material 

 

2. Which material type is the default in Maya when an object is created? 

a) Phong 

b) Lambert 

c) Blinn 

d) Plastic 

 

3. What does the Incandescence property of a material represent? 

a) The material’s reflectivity 

b) The colour and brightness of light that the material appears to emit 

c) The smoothness of the surface 

d) The material's transparency 

 

4. Which attribute is responsible for how light reflects in all directions from a 

material’s surface? 

a) Diffuse 

b) Transparency 

c) Specularity 

d) Bump Mapping 

 

5. What is the function of Bump Mapping in Maya? 

a) It changes the surface material’s reflectivity. 

b) It simulates bumps and wrinkles on the surface without altering the actual 

surface. 
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c) It alters the shape of the object. 

d) It affects the transparency of the material. 

 

6. How does the Ambient Colour of a material affect its appearance? 

a) It determines how much the material absorbs light. 

b) It changes the material's reflectivity in response to ambient light. 

c) It creates the illusion of glowing light. 

d) It makes the material appear transparent. 

 

7. What does the Translucence Depth attribute simulate? 

a) The way light scatters on a material’s surface. 

b) The way light penetrates and diffuses through translucent objects. 

c) The brightness of the material's reflection. 

d) The transparency of the material at a distance. 

 

8. What effect does setting the Translucence Focus value to a high number have? 

a) It increases the amount of light that passes through the material. 

b) It causes light to scatter over a small angle, making thin materials appear 

brighter when backlit. 

c) It makes thick materials like wax more opaque. 

d) It reduces the brightness of the material when backlit. 

 

9. Which of the following materials would benefit from using a high value for 

Translucence Focus? 

a) Wax paper 

b) Steel 

c) Marble 

d) Water 

 

10. In Maya, how does changing the Transparency value from 0 (black) to 1 (white) 

affect the object? 

a) The object becomes more reflective. 

b) The object becomes completely transparent. 

c) The object appears more opaque. 

d) The object will have a shinier surface. 

 

B. Subjective Type Questions 

 

1. What is Translucence Depth and translucence focus? 

2. What are common properties of the surface materials? 

3. Explain Ambient Colour, Incandescence, Bump Mapping, Diffuse and 

Translucence. 
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Session 7: Effect of Lighting Conditions on Surfaces  

 
 

 

It depends upon the types of surfaces that react to varying lighting conditions to 

control the appearance of glows produced from light reflecting off surfaces, or from 

surface incandescence. 

  

Special Effects attributes are available for Anisotropic, Blinn, Lambert, Phong, 

and PhongE material types. 

 

Hide Source 

 

Makes the surface invisible when rendered (if the glow intensity value is non-zero) 

showing only the glow effect. Hide Source is off by default. 

 

Glow Intensity 

 

The brightness of the surface glow effect. The slider range is 0 to 1, but one can type 

in higher values to create a ‘blown out’ or ‘burn in’ effect. The default value is 0. 

Mapping a texture to the Glow Intensity can create very interesting effects. Turn 

on Hide Source to view the results (Figure 1.149). 

Matte Opacity 

 

The mask value for individual objects can be controlled. Matte Opacity attributes are 

available for material types such as Anisotropic, Blinn, Lambert, Layered Shader, 

Phong, PhongE, Shading Map, and use background. 

 

Matte Opacity Mode 

 

It is a rendering technique used in 3D graphics to control the transparency or opacity 

of an object’s surface. It allows the background or other objects behind the surface to 

be visible through it, while the surface itself remains partially or fully transparent. 

Now select from the list of modes in the drop-down list. For best results when 

adjusting these attributes, select the Display Alpha Channel icon in the Render 

View to view the mask channels when re-rendering the scene. 

 

Figure 1.149: Sample showing glow intensity with various materials 
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Opacity Gain 

 

This is the default Matte Opacity Mode. This mode produces both reflections and 

shadows (Figure 1.150). 

 

The matte channel is first calculated, and 

then multiplied by the specified Matte 

Opacity value. The Opacity Gain value is 

used as a multiplier on the matte value 

produced by this material. 

 

The Matte Opacity Mode value is also 

keyable. The Opacity Gain range is from 

completely invisible to no effect (rendered 

as usual). 

 

Solid Matte 

 

Solid Matte makes the value of the matte channel constant for the material. The value 

you specify in the Matte Opacity slider is used, instead of the default value. 

Use Solid Matte to adjust the overall density or visibility of the use background 

material (Figure 1.151). 

 

Black Hole 

 

When the Black Hole mode is selected, 

the matte channel for the material is set 

to 0 (fully transparent). This creates a 

black hole in the alpha output where 

the object assigned shader renders the 

matte ‘knocked out’ (Figure 1.152). In 

this mode, the Matte Opacity slider is 

disabled and its value ignored. 
 

Note:  

 

For the Opacity Gain and Solid Matte modes, if an object has non-zero Transparency, 

objects behind it make their usual contribution to the matte channel’s values. This is 

Figure 1.150: Sample showing 

Opacity Gain 

Figure 1.151: Sample showing Rendered Solid Matter 

Figure 1.152: Rendered result with 
Matte Opacity Mode set to Black 
Hole 
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the difference between setting Matte Opacity to 0.0 in these modes, and choosing 

the Black Hole mode. 

 

Matte Opacity 

 

This value depends on Matte Opacity Mode is selected (Opacity Gain or Solid Matte). 

For example, for Opacity Gain, the Matte Opacity value indicates the multiplier 

amount for the alpha channel. The default is 1, which means that any opaque material 

registers an unaffected alpha value. 

 

Any values between 0 and 1 act as a multiplier to the alpha channel value to arrive at 

modified value. Use the slider or enter a value to adjust the density or visibility of the 

mask channels (Figure 1.153). 

Raytrace Options 

 

The Raytrace Options attributes to control the appearance of a surface during 

raytracing only. Raytrace options attributes are available for Anisotropic, Blinn, 

Lambert, Phong, and Phong E material types. 

 

Refractions 

 

Refraction is the change in direction of a wave passing from one medium to another 

medium. Refraction of light is the most commonly observed phenomenon, but other 

waves such as sound waves and water waves also experience refraction. When 

enabled, rays that are traced through transparent or semi-transparent objects are 

refracted, or bent according to the material’s refraction index. 

 

Refractive Index 

 

Refractive index, also called index of refraction, measure the bending of a ray of light, 

when passing from one medium into another. Refractive index is also equal to the 

velocity of light c of a given wavelength in empty space divided by its velocity v in a 

substance, or n = c/v. 

 

The amount that light rays bend when passing through a transparent object. 

A refractive index value of 1 does not bend light rays at all, so it is required to set the 

Figure 1.153: Rendered result with Matte Opacity Gain at value 1.0 

& 0.5 
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index value higher than 1. Refractive Index values for common materials are: glass 

(1.6), air (1), water (1.333), crystal (2), diamond (2.417).  

 

The valid range is 0.01 to infinity. The slider range is 0.01 to 3, but you can type in a 

higher value. The default setting is 1.6. 

 

Notes: 

• The material’s Hyper shade swatch only approximates the effect of the refractive 

index attribute. 

• Surfaces must have a thickness for refractive index to have any effect. If a surface 

does not have thickness (for example, a plane or face element), set the Refractive 

Index value to 1. 

• For best results, make sure there are suitable objects in the background to be 

refracted. 

 

Refraction Limit 

 

The Refraction Limit determines the maximum number of times a surface allows a 

light ray to be refracted. For instance, if the Refraction Limit is set to 10, the surface 

will refract light rays that have been refracted or reflected up to 9 times. However, it 

will not refract rays that have been refracted or reflected 10 or more times. The valid 

range for this value is from 0 to infinity, with the slider range between 0 and 10. The 

default setting is 6. Increasing this value can greatly extend render times. 

 

You must also consider the Render Settings Window Raytracing refractions attribute 

too (Figure 1.154). Maya uses the lower value of the 2. For instance, if your limit is 

set to 9 on the material and 6 in the Render Settings window, a value of 6 is being 

used. 

 

In the following example, a glass sits in front of a mirror. 

 

 

The number of refractions includes both the entry and exit of a light ray from a surface 

having a thickness. 

The physical property of Total Internal Reflection (TIR) can make some transparent 

objects appear not to refract light. This is caused by light rays reflecting inside the 

thickness of the object. If this occurs, increasing refraction limit has no effect because 

Figure 1.154: Showing Refraction Limit 
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the reflection limit is stopping light rays before they can exit the surface. However, 

because TIR is a real-world property, one may want to keep this effect. 

 

Note: To simulate realistic looking glass, set the Refraction Limit value to 9 or 10. 

 

Reflection Limit 

 

The maximum number of times the surface allows a light ray to be reflected. For 

example, if the reflection limit value is 4, the surface reflects light rays previously 

reflected (off itself or off other surfaces) 3 times or less; the surface does not reflect 

light rays previously reflected 4 or more times. The valid range is 0 to infinity. The 

slider range is 0 to 10. The default value is 1. 

 

Set the reflection limit value according to the material’s reflectivity value. For 

example, if the reflectivity value is between 0 and 0.5, set the reflection limit value 

between 1 and 2. If the reflectivity value is between 0.5 and 1, set the reflection 

limit value between 2 and 5. 

 

High values for reflection limit greatly increase rendering time. Test render the scene 

using various settings, and use the lowest values that give acceptable results. Even 

highly reflective surfaces rarely need a Reflection Limit value as high as 10 or more. 

 

Reflection Specularity 

 

This attribute is available for Blinn, Anisotropic, Phong, and PhongE materials. 

Reduce this value to avoid highlight aliasing artifacts produced in reflections during 

raytracing because of very thin or small highlights. Maya adds reflection specularity to 

each material to control the contribution of the specular highlights in reflections. The 

valid range is 0 to 1. The default is 1 (full contribution). 

 

Light Absorbance 

 

A material with an absorbance of 0.0 transmits completely. The higher the value, the 

less light passes through. 

 

Transparent materials generally absorb an amount of the light which passes through 

them. The thicker the material, less light gets through the thinner the material, more 

light gets through. 

 

Surface Thickness 

 

The simulated thickness (in world space) of transparent objects created from single 

surfaces (for example, a NURBS plane, or polygon face). 
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Using surface thickness does not produce the same results as building a surface with 

actual thickness the effect works well when the edges of the surface are not visible 

(for example, closed surfaces, or bounded shapes, like a car windshield). 

 

Shadow Attenuation 

 

Shadows of transparent objects are brighter in the center, simulating a light’s focus. 

A setting of 0 results in constant intensity shadows. The focusing increases as the 

parameter increases from 0 to 1. The default value is 0.5. The amount of attenuation 

for a given light ray depends on the angle between the light ray and the surface normal 

of the transparent object: the greater the angle, the greater the attenuation. To turn 

off the shadow attenuation completely, set shadow attenuation to 0.  

 

Chromatic Aberration 

 

Different wavelengths of light refract at different angles when passing through a 

transparent surface during raytracing. Chromatic Aberration only affects light rays as 

they pass through the second surface of a transparent object (the first exit ray). 

 

 

Activities 

  
 

Activity 1: Adjusting Glow Intensity and Surface Brightness Using Blinn Material 

 

Materials required: Computer system, and Autodesk®Maya® 

 

Procedure 

• These attributes control the appearance of glows produced from light reflecting 

off surfaces, or from surface incandescence. Special Effects attributes are 

available for Anisotropic, Blinn, Lambert, Phong, and PhongE material types. 

• For best results when adjusting these attributes, select the Display Alpha 

Channel icon in the Render View to view the mask channels when re-rendering 

the scene 

• The matte channel is first calculated, and then multiplied by the specified Matte 

Opacity value. The Opacity Gain value is used as a multiplier on the matte value 

produced by this material. 

• Solid Matte makes the value of the matte channel constant for the material. The 

value you specify in the Matte Opacity slider is used, instead of the default value. 

• Matte Opacity Mode is selected (Opacity Gain or Solid Matte). For example, for 

Opacity Gain, the Matte Opacity value indicates the multiplier amount for the 

alpha channel. 

• Matte Opacity Mode is selected (Opacity Gain or Solid Matte). For example, for 

Opacity Gain, the Matte Opacity value indicates the multiplier amount for the 

alpha channel. 
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Check Your Progress 

  
 

A. Multiple Choice Questions 

1. What is the effect of "Hide Source" in the Special Effects attributes? 

a) Makes the surface visible in render 

b) Makes the surface invisible when rendered, showing only the glow effect 

c) Increases the glow intensity 

d) Reduces the glow intensity 

 

2. What does the "Glow Intensity" slider control? 

a) The opacity of the surface 

b) The brightness of the surface glow effect 

c) The colour of the glow 

d) The transparency of the glow 

 

3. Which material types have available "Matte Opacity" attributes? 

a) Only Blinn 

b) Only Phong 

c) Anisotropic, Blinn, Lambert, Phong, PhongE, Shading Map, and Use Background 

d) Lambert and Phong only 

 

4. What is the effect of the "Black Hole" Matte Opacity mode? 

a) It increases the opacity of the material 

b) It creates a fully transparent matte channel, resulting in a "knocked out" effect 

c) It reduces the transparency of the material 

d) It makes the material fully visible 

 

5. What does the "Refraction Limit" control? 

a) The maximum number of times light can be reflected 

b) The maximum number of times light can be refracted through an object 

c) The amount of light that passes through the material 

d) The angle at which light is refracted 

 

6. What happens when "Refraction Limit" is set to 10? 

a) It will stop refracting light after 10 times 

b) It will allow light to be refracted up to 9 times 

c) It has no effect on light refraction 

d) It will refract all light without any limit 

 

7. What is the default value of the "Refraction Limit"? 

a) 1 

b) 6 

c) 10 

d) 0 
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8. What is the "Reflection Specularity" attribute used for? 

a) To control the intensity of reflections in raytracing 

b) To control the amount of absorption in transparent materials 

c) To reduce light absorption in the material 

d) To simulate thickness of transparent surfaces 

 

B. Subjective Questions 

 

1. Explain application of the various lighting conditions. 

2.  What is Matte Opacity? 
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Module 2:  

 

Surface Shading and Maps  

 

 

 

Module Overview 

 

 

The module on Surface Shading and Texturing in 3D Modelling begins with Session 

1, which introduces surface shading and its properties, emphasizing the interaction 

between light and surfaces and exploring various shading models such as Phong and 

Lambert. 

 

Session 2 is about shading networks, learning to construct complex node-based 

workflows that enhance the realism of their models.  

 

Session 3 focuses on the creation and assignment of materials, detailing different 

material types and how to edit their attributes for desired visual effects.  Session 4 

deals with Texture Maps are examined, highlighting their critical role in adding detail 

and realism to 3D objects.  

 

Session 5 introduces UV Texture Mapping, teaching how to effectively unwrap UVs 

and apply textures accurately to their models.  

 

Session 6, covers Bump Mapping, demonstrating how to simulate surface details 

without modifying geometry.  

 

Session 7 focusses on the creation and application of Specular Maps, which control 

the shininess and highlights on surfaces, contributing to a model's overall realism.  

 

Session 8 will equip you with the skills to create seamless textures in Adobe 

Photoshop, enabling them to design high-quality textures that can be easily integrated 

into their 3D projects.  

 

 

Learning Outcomes  

  
 

After completing this module, you will be able to: 

 

• Demonstrate surface material shading. 

• Explain and demonstrate the procedure to create and assign material using 

shader on different objects. 
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• Demonstrate the knowledge of networking between shaders 

• Differentiate between various types of maps in texturing; and  

• Explain the purpose of various types of maps in texturing. 

• Explain and demonstrate the use of UV texture  

• Explain and understand the process to create Bump Maps  

• Demonstrate the process of creating Specular Maps 

• Describe about the seam and how to create a seamless texture using Photoshop 

tools   

 

 

Module Structure 

  
Session 1: Surface Shading and its Properties 

  
Session 2: Shading Network 

  
Session 3: Creating & Assigning Material to Surface 

  
Session 4: Texture Maps 

 

Session 5: UV Texture Mapping 

 

Session 6: Creating Bump Map 

 

Session 7: Specular Map 

 

Session 8: Creating Seamless Textures in Photoshop 

 

 

 

Session 1: Surface Shading and its Properties 

  
 

In Autodesk® Maya®, shading and texturing work together to control the visual 

characteristics of a 3D object by defining its colour, transparency, shininess, and 

other surface details. Here is a breakdown of the key concepts and how they are 

applied: 

 

Shading and Texturing in Maya 

 

i. Shaders (Materials): Each new object in Maya starts with a default shader 

called Lambert1, a neutral grey, non-reflective material that allows objects to 

render visibly. Shading applies colour, surface bumps, transparency, and shine 
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to an object, and is distinct from texturing, which adds details to these 

attributes. 

 

ii. Texture Mapping: Texture Mapping adds detailed surface attributes by 

applying images or patterns to a shader’s attributes. For instance: 

• Adding a scanned photo of a brick wall to the colour attribute is 

considered a texture. 

• Applying a Bump Map to simulate brick wall contours is another form 

of texturing. 

 

iii. Shader Networks: These are interconnected nodes that define material 

attributes. Texturing is often informally referred to as part of shading since 

textures are applied to shaders. 

 

iv. Material Attributes: Material attributes simulate how an object naturally 

reacts to light in a 3D environment. Common attributes include: 

• Colour: The base colour of an object. Colours can be basic or controlled 

by advanced shaders (e.g., Ramp Shader). 

 

• Transparency: Ranges from fully opaque (0) to fully transparent (1). 

Textures can also define varying transparency in regions of the material. 

 

• Specular Highlights (Shininess): Available in certain shaders (e.g., 

Phong, Blinn), this controls the shiny reflection on an object. One can 

adjust both the intensity and colour of these highlights. 

 

• Bump Mapping: Creates the illusion of texture by altering the way light 

interacts with the surface. 

 

v. Surface Shading vs. Surface Texture 

 

• Surface Shading: Defines an object’s basic appearance (e.g., colour, 

transparency, shine) based on its material and light interaction. 

 

• Surface Texture: Adds detailed surface qualities like relief (bumps, 

grooves) or atmospheric reflections. Textures can be Colour Maps, 

Transparency Maps, or Bump Maps. 

 

vi. Colour and Transparency Manipulation 

 

• Colour: Adjust directly through the colour attribute or apply Colour 

Maps. Additional utilities like Blend Colours and Gamma Correct enable 

blending, contrast adjustment, and colour conversions. 

 

• Transparency: Change transparency directly or use a Transparency 

Map to control specific transparent and opaque areas. 
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vii. Specular Highlights 

 

• Specular attributes add glossy reflections that vary depending on the type 

of material (e.g., Blinn or Phong). Adjusting the Specular Shading 

attributes affects highlight size and colour, creating a shiny effect visible 

as a white glow on the material’s surface. 

 

Note: Only materials with specular attributes (Anisotropic, Blinn, Phong, 

and PhongE) have surface highlights. The specular highlight is the white shiny 

glow on the material (Figure 2.1). 

 

Specular Highlight? 

 

Some surfaces are shinier than others (for example a wet fish has a shinier surface 

than a dry leaf). Depending on how shiny a surface is, it reflects light in different ways. 

 

Shiny objects reflect light directly; matte objects diffuse light. Specular highlights 

show the places on the object where the light sources are reflected at consistent 

angles; reflections on an object show, among other things, light bounced from 

surrounding objects (Figure 2.2 and 2.3). 

 

Specular highlights depend directly on the view (camera), not the position of the light, 

like diffuse shading does. 

 

Note:  

The Blinn material is recommended for shiny 

surfaces in animations. Highlights on other 

specular materials, like Phong and PhongE, 

may flicker when animated. 

 

Figure 2.1: Preview of applied shaders on default object 

Figure 2.2: Preview of 
applied Highlights 
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Highlights 

The size of a specular highlight on a surface makes the surface look either flat or 

shiny. 

 

Highlight Colour 

The colour of highlights on surfaces can be 

controlled and is an important aspect of 

realistic shading in 3D texturing. 

 

Reflections 

You can control the degree of reflectivity as well 

as other surface properties like refracted 

Colour. 

 

 

Activities 

  
 

Activity 1: Define Specular on object  

 

Objective: The objective of this activity is to understand and apply the concept of 

specular highlights in 3D modelling using Autodesk® Maya®. 

 

Materials Required: computer system, Autodesk®Maya® 

 

Procedure 

• Create Basic Shapes: Start by creating a few simple shapes (e.g., spheres, 

cubes, or cones) in the Maya workspace. 

• Experiment with Shaders: Explore different shaders such as Phong, Blinn, and 

Lambert to observe how each shader affects the object's surface. Note how each 

shader type impacts the appearance of highlights and colours on the object. 

• Apply Specular Mapping: 

• Select one of the shapes and open the Material Attribute Editor. 

• Locate the Specular Attribute section. 

• Map a texture to the Specular attribute to create a Specular Map. This map will 

control where and how the highlights appear on the object’s surface, allowing 

you to adjust the shine and intensity of reflections. 

• Observe the Effects: Adjust the settings of the Specular Map to see how 

different textures affect the shininess and highlight size on the object. 

Experiment with different colours and intensities for the highlights to better 

understand how Specular Mapping affects the overall material appearance. 

 

 

 

 

Figure 2.3: Preview of 
colour control on 

Highlights 
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Check Your Progress 

  
 

A. Multiple Choice Questions  

 

1. What is the default shader applied to new objects in Autodesk® Maya®? 

a) Phong 

b) Blinn 

c) Lambert1 

d) Anisotropic 

 

2. Which of the following attributes is not typically part of basic surface shading? 

a) Colour 

b) Specular Highlight 

c) Texture Bump Map 

d) Animation Keyframes 

 

3. What does a Bump Map simulate on a surface? 

a) Surface colour 

b) Transparency changes 

c) 3D contours and surface irregularities 

d) Specular highlights 

 

4. Which shader type is recommended for creating shiny surfaces in animations to 

avoid flickering? 

a) PhongE 

b) Blinn 

c) Lambert 

d) Anisotropic 

 

5. How can you control the transparency of an object in Maya? 

a) By adjusting only the colour attribute 

b) By modifying the specular shading attribute 

c) By using a Transparency Map or adjusting the transparency attribute 

d) By changing the diffuse attribute 

 

6. Which statement about specular highlights is true? 

a) They depend on the position of the light only. 

b) They are independent of the camera view. 

c) They are controlled by the specular shading attributes and can be coloured. 

d) They are only visible on Lambert materials. 
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7. What is a common use for the Blend Colours utility in Maya? 

a) To adjust the transparency of a material 

b) To simulate Bump Mapping 

c) To blend two different colours or maps on a material 

d) To change the surface reflectivity 

 

8. Which shader types have specular highlights by default? 

a) Lambert and Anisotropic 

b) Phong, PhongE, Blinn, and Anisotropic 

c) Lambert and Blinn only 

d) Only Phong 

 

9. What can affect the size and intensity of a specular highlight on a material? 

a) The object's position only 

b) The camera angle and material attributes 

c) Only the light’s distance from the object 

d) The shader type and Diffuse Map 

 

10. Why might highlights on Phong and PhongE materials flicker during 

animations? 

a) They do not reflect light accurately. 

b) The specular shading is unstable during camera movement. 

c) The highlights are too diffused. 

d) They lack reflective attributes. 

 

 

Session 2: Shading Network 

 
 
 

The colours and textures that define the look of the material, can be represented as 

a shading network. In this example, a rock texture defines the colouring for the Phong 

material, while the mountain texture defines the incandescence. 

 

About Shading Networks 

 

A shading network is a collection of connected rendering nodes that defines how 

colours and textures contribute (usually with lights) to the final look of surfaces 

(materials). A shading network typically consists of any number of connected 

rendering nodes plugged into a shading group node.  

 

A good portion of your time building shading networks is spent connecting node 

attributes to each other and adjusting node attributes to describe what a surface 

should look like and how it should be positioned. 
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Importing Shading Networks 

By default, when you import a file more than once into Maya, the geometry and 

shading networks are duplicated. These redundant shading networks and 

reassignment of geometry inflate the scene size and load time, and clutter your 

working scene. You can prevent the duplication of a shading network (unless, of 

course, you need it) when you import a scene, or you can delete any duplicated 

network from within your working scene (Figure 2.4). 

To prevent redundant shading networks on import, when you import a scene (File > 

Import>), turn on Remove Duplicate Shading Networks. 

 

To delete a redundant shading network, in Hypershade, select Edit > Delete Duplicate 

Shading Networks. 

 

Shading Group Node 

 

Shading networks are designed as a data flow network, where data streams from the 

left side of the network toward a final shaded result that emerges from the right node. 

 

The rightmost nodes (which are not always visible by default; click the Input and 

Output Connections button in the Hypershade to see it) are the Shading Group for 

that particular network. The Shading Group is a collection of materials, textures, and 

lights that efficiently describe all the necessary attributes required to shade or render 

an image. All of the nodes connected upstream (that is, further to the left of the node) 

of the shading group contribute to the final look of surfaces in the scene. Adjusting 

any node’s attributes or connections causes a downstream (that is, farther to the right) 

reaction that can be seen in the final rendered image. It is not recommended that you 

manually try and edit the shading group connections. Instead, always use the higher-

level interfaces, like the Hypershade and shading group editors, to ensure the 

connections do not become inconsistent which will result in the surface not appearing 

when rendered. 

 

Render Nodes 

 

Render nodes are individual components that interconnect to serve as building blocks 

for producing all rendering effects. Like other nodes in Maya, render nodes can be 

Figure 2.4: A view of Shading Network 
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animated or mapped to the parameters of other nodes. Texture nodes, placement 

nodes, and material nodes, along with their input and output connections (attributes), 

define all aspects of the final rendered images, including surfaces, lights, and 

shadows. 

 

Nodes can be connected to create the desired effects. Additionally, nodes can be 

shared to establish visual relationships and improve rendering efficiency. For 

instance, two objects can share a single texture, making them appear the same while 

reducing memory usage and processing requirements. 

 

Render Node Attributes 

 

A node attribute describes one 

aspect of the node. When an 

attribute of a node is adjusted, 

one aspect of its description is 

modified. For example, the 

Colour attribute can be 

changed from red to blue, or an 

opaque object can be made 

transparent by adjusting the 

transparency attribute (Figure 

2.5). 

 

Although some attributes can be adjusted interactively, precise numerical values are 

typically verified and entered using the Attribute Editor. Node attributes can also be 

displayed and adjusted in the Attribute Spread Sheet or the Channel Box. Only some 

attributes are displayed in the Channel Box, while all attributes are visible in the 

Attribute Editor and Attribute Spread Sheet. 

 

Render Node Connections 

 

Connections between node attributes are shown by coloured arrowed lines in 

the Hypershade. The connection lines between nodes indicate what type of data flows 

through the connection. Depending on the types of nodes and connections used, 

different information is passed. That is, values may be of colour, distance, position, 

and angle or object ID. 

 

Some information can come as a single value (for example, Out Alpha is a single value) 

or as a triple (for example, an RGB value or an XYZ value). Triple connections are 

represented by green connection lines. 

 

Single, double, triple, data, and array data each have an assigned default colour 

(Figure 2.6). The colours and their meanings can be customized to suit specific 

preferences or needs. 
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Figure 2.6: A View of Render Node Connection    

 

Note: Pointing to one of the lines connecting two nodes by their attributes will display 

information about the connection. 

 

The Connection Editor 

 

Each node has a default attribute and a list of commonly connected attributes that 

allow for interactive node connections (dragging and dropping in Hypershade). The 

Connection Editor is the most efficient tool for fine-tuning a shading network and 

making non-default connections (Figure 2.7). 

 

The Connection Editor displays node network information in a side-by-side layout, 

enabling the user to view two connected nodes at once. This layout facilitates easy 

navigation between nodes, allowing the user to see the outputs or inputs of each node. 

Connections can be made in either direction within the node network, simplifying the 

process of creating complex node relationships. 

 

The blending mode, specified in the options bar, controls how pixels in the image are 

influenced by a painting or editing tool. Understanding the blending mode helps 
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visualize how colours interact and affect the final result of the applied image 

adjustments. 

 

Figure 2.7: A View of Connection Editor 

 

 

Activities 

  
 

Activity 1: Apply different texture on a 3D model like Doll. 

 

Objective: The objective of this activity is to practice applying various textures to 

different parts of a 3D doll model using Autodesk® Maya®. 

 

Materials Required: computer system, Autodesk®Maya® 

 

Procedure: 

 

• Develop Texture Mapping Skills: Enable participants to effectively apply and 

adjust textures on different parts of a 3D model, enhancing their 

understanding of Texture Mapping. 

• Enhance Realism in 3D Models: Encourage participants to create realistic 

representations by using specific shaders tailored to each part of the doll, such 

as skin for the face, fabric for the dress, and more. 

• Foster Creativity: Allow participants to express their creativity through the 

choice of colours, patterns, and textures that define the doll's appearance. 

• Understand Shader Properties: Help participants explore various shader 

properties and their impact on the final rendered appearance, emphasizing how 

different materials can affect the look of surfaces. 
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• Gain Experience in 3D Modelling Workflow: Provide participants with hands-

on experience in the workflow of creating and texturing a 3D model, 

reinforcing their skills in using Autodesk® Maya® effectively. 

 

 

Check Your Progress 

  
 

A. Multiple Choice Questions 

1. What is a shading network in Autodesk® Maya®? 

a) A collection of lighting setups in a scene 

b) A group of connected rendering nodes defining how surfaces look 

c) A tool for animating objects 

d) A set of key frames for object movement 

 

2. How can you prevent redundant shading networks when importing a scene? 

a) Turn on Remove Duplicate Shading Networks during import 

b) Use Edit > Delete Shading Networks 

c) Manually delete each duplicate network in the Outliner 

d) Adjust settings in the Render View 

 

3. What does the Shading Group Node represent in a shading network? 

a) A node that generates final rendered images 

b) A combination of materials, textures, and lights for shading 

c) A node to create new materials 

d) A node that connects directly to the geometry 

 

4. What should you do if you need to adjust connections in a shading group node? 

a) Manually edit the shading group connections 

b) Delete and recreate the shading group 

c) Use the higher-level interfaces like Hypershade  

d) Edit using the Outliner 

 

5. Which of the following best describes a render node? 

a) A node used only for animating objects 

b) A building block used for rendering effects 

c) A type of Texture Mapping tool 

d) A lighting node 

 

6. How can you connect nodes in Maya’s Hypershade? 

a) By using the Connection Editor or dragging and dropping  

b) Only by using default attribute connections 

c) Only through the Attribute Spread Sheet 

d) By scripting in MEL 
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7. What information does the Connection Editor in Maya provide? 

a) Only the colour of a node 

b) The side-by-side view of connected nodes' inputs and outputs 

c) The frame rate of the scene 

d) The shading group hierarchy 

 

8. Which tool is best for fine-tuning non-default connections in a shading network? 

a) Attribute Editor 

b) Outliner 

c) Connection Editor 

d) Graph Editor 

 

9. What type of information is passed through a green connection line in Maya’s 

Hypershade? 

a) Single values (e.g., Out Alpha) 

b) Triple values (e.g., RGB or XYZ) 

c) Boolean data 

d) Array data only 

 

10. What does the blending mode in the options bar control? 

a) The render speed of an image 

b) How pixels in the image are affected by a painting or editing tool 

c) The transparency of 3D objects 

d) The animation path of an object 

 

 

Session 3: Creating & Assigning Material to Surface 

  
To create a new material, attach a surface shader and assign it directly to an object. 

For comprehensive details on creating materials, refer to the sections on applying 

colour and shading to objects, as well as building materials using Hypershade. 

 

Creating a Material 

Use one of the following methods to create a material in Hypershade: 

 

i. Right-click in Hypershade, then select a material from the pop-up menu (Create 

> Materials). 

ii. Select a material from the Create menu in the menu bar. 

iii. In the Create Bar, middle-drag a material swatch into Hypershade. 

iv. Choose a material from the Create Render Node window. 

v. Opening the Create Render Node Window. 

 

Assigning a Material to Surfaces 

 

Multiple methods exist for assigning a material to one or more surfaces. 
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Option 1: 

• Right-click the object(s). 

• Select Assign Existing Material, then choose among the existing materials in 

the scene. 

 

Alternatively: 

• Right-click the object and select Assign New Material, which opens the Assign 

New Material window to choose from available materials. 

• Right-click the object and select Assign Favorite Material to choose from the 

Favorites list. 

 

Option 2: 

• In the scene view, select the surface(s) for material assignment. 

• In Hypershade, middle-drag the material swatch over the selected surface(s). 

 

Option 3: 

• In the scene view, Shift-select the object, then click the material swatch in 

Hypershade. 

• Right-click the material swatch in Hypershade and select Assign Material to 

Selection from the pop-up menu. 

 

Option 4: 

• Middle-drag and drop a Hypershade swatch onto an object in the IPR Render 

View. 

• Assigning a Material to Multiple Surfaces 

 

Select the surfaces in the view. 

 

In Hypershade, right-click the material swatch and select Assign Material to Selection 

from the pop-up menu. 

Assigning a Material to a Group of Faces on Polygonal Surfaces 

Several methods are available for assigning materials to faces on polygonal surfaces. 

 

Option 1: 

 

Right-click the surface. 

Select Face from the marking menu. 

Choose Select by Component Type icon (or press F11). 

Assigning a Material to Selected Faces: 

 

i. Select the faces by dragging or Shift-clicking. 

ii. In Hypershade, right-click the material and select Assign Material to Selection 

from the pop-up menu. 

iii. Maya applies the material to the selected faces (Figure 2.8). 
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Assigning Shaders to Polygon Faces 

 

A shader can be assigned to faces on a polygonal surface using a Maya Artisan brush. 

This feature is useful for applying different shaders to different faces of the same 

model, such as texturing a building that is part brick and part glass. 

 

Assigning a Shader to Faces with an Artisan Brush: 

 

In the view, select the object for material assignment. 

In Hypershade (Window > Rendering Editors > Hypershade), right-click the material 

swatch and select Paint Assign Shader from the marking menu. 

An Artisan brush appears in the scene view. Drag the brush over the faces to apply 

the shader (Figure 2.9). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.8: Hypershade window    

Figure 2.9: Example on how Paint assign shader allows you to assign a 
shader to faces using artisan brush. 
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Activities 

  
 

Activity 1: Explain the process of creating material 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure  

 

• Open Hypershade: Launch Autodesk Maya and navigate to the Hypershade panel, 

which is where you create, modify, and manage materials and textures. 

• Create a Material: Right-click in the Hypershade workspace and select a material 

from the pop-up menu by going to Create > Materials. Alternatively, you can also 

use the Create menu from the menu bar to choose a material. 

• Use the Create Bar: In the Create Bar, find a material swatch, then middle-drag it 

into the Hypershade workspace. This action places the material into the 

workspace, ready to be adjusted. 

• Open the Create Render Node Window: You can also open the Create Render Node 

window to select a material. This window allows you to choose from various 

material types and options to create the material suitable for your project. 

 

 

Check Your Progress 

  
A. Multiple Choice Questions  
 

1. Which of the following is NOT a method to create a material in Hypershade?  

a) Right-click in Hypershade and select a material 

b) Drag and drop a material swatch from the Create Bar 

c) Select a material from the Assign Material menu 

d) Choose a material from the Create Render Node window 

 

2. How can a material be assigned to multiple surfaces in Maya?  

a) By right-clicking and selecting "Assign New Material" 

b) Middle-drag the material swatch over the selected surface(s) in Hypershade 

c) Using the Channel Box 

d) By adjusting the material's properties in the Attribute Editor 
 

3. To assign a material to a selected group of faces on a polygonal surface, which of 

the following is the correct order?  

a) Right-click the object, select "Assign New Material," and choose faces 

b) Shift-select the faces and then drag the material to the selection 

c) Right-click the material and choose "Assign Material to Selection" 

d) Press F11, select faces, and apply the material using the Attribute Editor 
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4. When using an Artisan brush to assign a shader to polygon faces, what is the first 

step?  

a) Select the shader in the Attribute Editor 

b) Select the object for material assignment 

c) Right-click and assign a material from Hypershade 

d) Use the Paint Assign Shader option from the marking menu 

 

5. Which method is used to assign a material to an individual face on a polygonal 

surface in Maya?  

a) Use the Channel Box to assign material 

b) Right-click the face and assign material from the marking menu 

c) Right-click the object and select "Assign Existing Material" 

d) Use the "Assign Material to Selection" from the Hypershade menu 

 

6. In which scenario would you use the "Assign Favorite Material" option in Maya?  

a) To assign a shader to a polygonal surface 

b) To quickly apply a frequently used material to an object 

c) When you need to apply different shaders to different faces 

d) When importing a new material into the scene 

 

7. Which of the following is the purpose of the "Assign Material to Selection" option 

in Hypershade?  

a) To assign a material to a group of faces on a polygonal surface 

b) To create a new material in the scene 

c) To delete a material from the scene 

d) To duplicate a material from one object to another 

 

8. What happens when a material is middle-dragged over a selected surface in 

Hypershade?  

a) The material is applied to the entire scene 

b) The material is assigned to the selected surface(s) 

c) The material is copied to the clipboard 

d) The material properties are adjusted in real-time 

 

9. What is the primary benefit of using the Artisan brush for assigning shaders to 

polygon faces? a) It allows automatic Texture Mapping 

b) It enables the application of different shaders to different faces of a model 

c) It creates a realistic lighting effect for each face 

d) It assigns a single shader to all faces in the scene 

 

10. Which method can be used to apply materials to multiple objects simultaneously?  

a) Right-click on each object and assign the material separately 

b) Middle-drag the material over each object individually 

c) Use the "Assign Material to Selection" option after selecting all objects 

d) Use the Attribute Editor to apply the material to each object 
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Session 4: Texture Maps 

 
 

 

Texture Maps are used on the surfaces of 3D models to add repeating textures, 

patterns, or unique visual effects. They help define intricate details and surface 

characteristics on computer-generated graphics or 3D models. 

 

Types of Map 

 

Diffuse Map 

 

i. This is the most commonly used Texture Mapping technique, which 

projects a Bitmap image onto a 3D geometry surface, preserving its original 

pixel colours. 

ii. Any Bitmap image, including scanned photos or images taken with a digital 

camera, can serve as a Diffuse Map to achieve a photorealistic quality. 

iii. Image editing software can also be used to create pre-rendered texture 

effects like shadows, bevels, bumps, lighting, or weathering. This method 

efficiently simulates real-world 3D effects while significantly reducing 

system resources and rendering time. 

 

Opacity Map 

 

i. Make transparency and cut-out effects from grayscale images. The black 

part will get cut out; the white part will be fully displayed; the gray values 

determine the transparency (alpha) level of the object (Figure 2.10 and 

2.11). 

 

 

 

 

Figure 2.11: Props with different 
textures  

Figure 2.10: Props with no texture 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

126 
 

                                                                     Texturing Artist - Grade XII  

• Use bright gray RGB (253,253,253) on the Opacity Map to make 2-sided 3D 

Surface from the Plane mesh (Figure 2.12 and 2.13). 

Bump Map 

 

Bump Mapping uses the grayscale 

values of an Image Map to create 

variations in the shading of the 

surface to which the map is applied. It 

adds details to 3D models without 

increasing the number of polygons. 

White areas of a Bump Map are shown 

as high and black areas are shown as 

low (Figure 2.14). 

 

By moving around the light source 

we can see how the angular light 

projection changes the bump look. 

If the light is facing the surface from a straight 90 degrees angle it the bump effects 

are the least noticeable. Bump is an edge blur from the bump source image causes a 

softer bevel effect. 

 

Bump Maps are grayscale textures applied to 

objects to create the illusion of surface relief 

such as elevations and depressions on a flat 

surface. Unlike Displacement Maps, Bump 

Maps do not alter the actual geometry of the 

surface. Instead, they simulate depth by 

adjusting the direction of the surface's 

normals according to the Bump Map’s Alpha 

gain value (Figure 2.15). This effect 

makes the surface appear textured 

without increasing the polygon count or 

modifying its shape. 

Figure 2.14: Sample showing Bump Map 

on an object  
 

Figure 2.15: Prop with texture and an 
image as the bump 

 

Figure 2.12: Prop with texture and an 
image as the mask 

 

Figure 2.13: Transparent prop 
masked out 
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Use Bump Maps to create very shallow reliefs. For example, one can make objects 

look like they are embossed, have shallow rolling hills, and so on. Because Bump 

Maps are not true surface relief, they 

 

• cannot cast or receive shadows 

• cannot be seen if you silhouette the mapped object 

• take less time to render than Displacement Maps 

 

Note: 

 

File textures that are used for Bump Mapping are usually connected via their out 

Alpha attribute. If the corresponding texture image file does not provide an alpha 

channel, then the bump effect may be missing when using certain image formats. 

To avoid this, turn on the 

Alpha is Luminance attribute 

in the Colour Balance section 

of the File Texture node 

(Figure 2.16). 

 

Map surface relief (bumps or 

displacements) to the Blinn 

surface material to reduce 

highlight roping or flickering. 

The soft highlights on Blinn 

surfaces are less likely to 

cause roping or flickering 

than the harder highlights on 

Phong surfaces. Although scratches are like little depressions, 2D textures can be 

easily achieved. 

 

Normal Map 

 

• Clicking the Import Bump button opens options to import a map. If the map 

being loaded is a Normal Map, check the designated box. 

• A Normal Map (used with pixel shaders only) is generated from a high-polygon 

model. It impacts the surface’s appearance similarly to a Bump Map but offers 

finer levels of detail. 

• iClone supports importing Normal Maps created in software like ZBrush or 3D 

Studio Max. Using Normal Maps allows simple, low-poly models to display as 

highly detailed 3D objects. 

• If the image being loaded is not a specifically designed Normal Map, the 

resulting effect may be less effective. 

 

 

 

 

Figure 2.16: Example of an object without and 
with Normal Map 
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Displacement Maps 

 

Displacement Maps are 

grayscale textures applied to 

objects to create actual surface 

relief such as elevations and 

depressions on a flat surface. 

Unlike Bump Maps, 

displacement maps modify the 

object’s geometry, producing a 

realistic 3D effect by physically 

altering the surface (Figure 2.17). 

 

With Displacement Maps, depressions and elevations become part of the geometry of 

the object, changing the topology, unlike Bump Maps that only create the illusion of 

surface relief. 

 

Note: 

 

• Because displacement changes the geometry of an object, Displacement Mapped 

objects usually require further tessellation (more triangles, which the renderer uses 

to approximate the smoothness of the surface). By default, Maya uses Feature-based 

Displacement Mapping to automatically add more triangles where required (Figure 

2.18). 

• File textures that are used for Displacement Mapping are usually connected via their 

outAlpha attribute. If the corresponding texture image file does not provide an alpha 

channel, then the displacement effect may be missing when using certain image 

formats. To avoid this, turn on the Alpha is Luminance attribute in the Colour 

Balance section of the File Texture node. 

 

 

 

Displacement Maps move an object’s vertex. By default, the height of the 

displacement is determined by the Alpha Gain value in the Displacement Map’s 

Attribute Editor (Figure 2.19). When Alpha is Luminance is enabled, the 

transparency effect is determined by the brightness or intensity of the pixels, rather 

than by their colour information. Use Displacement Maps to create shallow or deep 

surface relief. For example, creating embossing, mountain peaks and valleys, spikes, 

and so on. Because Displacement Maps create true surface relief, they: 

Figure 2.18: Another example of Displacement Map 
 

Figure 2.17 Displacement Maps 
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• can cast or receive shadows 

• can be seen if you silhouette the object 

• take more time to render than Bump Maps, 

which create the illusion of surface relief. 

 

Note:  

 

A texture can be used as a Displacement Map by 

connecting it to the displacement mat attribute 

within the material’s shading group. This setup 

allows the texture to modify the surface 

geometry, creating realistic surface relief effects. 

 

Specular Map 

 

This Texture Mapping method allows parts of an object to have a Specular effect. 

 

Glow Map 

 

A Glow Map is a type of Texture Map used in 

3D graphics to simulate areas of an object or 

scene that appear to emit light. This Texture 

Mapping technique allows users to control the 

glow shape, Colour and strength (Figure 

2.20). 

i. Glow Maps will blend with your 

original Diffuse Maps, so the lighter 

the diffuse Colour (or glow Colour), the 

stronger the glow effect. 

ii. A bright Diffuse Map in combination with a bright Glow Map might cause 

overexposure. 

 

Note: 

 

To create a subtle and effective glow effect: 

 

• Choose a diffuse image which could ideally glow in the real world. 

• Prepare the Glow Map, pattern, and Colour design 

• Start by testing from a darker Glow Map, then increase the brightness step by step 

to see the best brightness setting 

• Decrease the overall ambient light 

 

Reflection Map 

 

Reflection Map is also referred to as Environment Map. The Image Map is projected 

onto a 3D surface to represent a reflection of the environment (Figure 2.21). 

Figure 2.19: Prop with Texture 
and a specular image 

 

Figure 2.20: Prop with Glow Map   
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Notes: 

 

To create a good Reflective effect, one should start by using an object that has high 

specular highlight and gloss values. Then apply black or darker images as the Diffuse 

Map to help to make the surface work like a mirror which can fully reflect the 

Reflective Map content. If the Diffuse Map itself is too bright the front light plus 

reflective setting could cause the result to be overexposed. 

 

Adjust the camera and light direction to see the natural changes to the reflective 

surface. Placing a reflective object on a simple 2D background can be enhanced by 

using high-contrast scenery images imported as a Reflection Map to mimic the 

reflective appearance. This technique involves applying a Reflection Map to the 

reflective object, which simulates reflections of the environment in the object's 

surface. The high-contrast nature of the scenery images helps to create a more 

realistic and dynamic reflection effect. 

 

 

Activities 

  
 

Activity 1: Create a Texture Map an object 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure 

1. Create a 3D Object: 

• Launch Autodesk® Maya®. 

• Design a Steel Kettle as your 3D object. Use the appropriate modeling 

tools to shape it into the desired form. 

2. Apply Texture Map: 

• Select a Texture Map (e.g., a steel or metallic texture) and apply it to 

the surface of the 3D steel kettle model. 

Figure 2.21: Props with Reflection Map   
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• Adjust the texture coordinates and mapping to ensure proper 

alignment on the object. 

3. Composite with 2D Textured Background: 

• Import a 2D textured background image (e.g., a kitchen or countertop 

image). 

• Position the 3D kettle in the scene to match the perspective of the 

background. 

• Composite the 3D kettle onto the 2D background, ensuring realistic 

blending of shadows, light, and reflections. 

4. Render the Scene: 

• Set up the camera and lighting to enhance the scene’s realism. 

• Render the final composition with both the 3D kettle and 2D 

background. 

 

 

Check Your Progress 

  
 

A. Multiple Choice Questions   

 

1. Which of the following describes the Diffuse Map in Texture Mapping?  

a) It creates transparency and cut-out effects. 

b) It simulates surface relief by changing the geometry. 

c) It applies a Bitmap image to a 3D surface, preserving original pixel colours. 

d) It adds actual surface relief to the geometry. 

 

2. What is the primary function of an Opacity Map?  

a) To simulate light reflections on a surface. 

b) To create transparency and cut-out effects using grayscale images. 

c) To define the colour of a 3D object. 

d) To add bumps and dents to a 3D surface. 

 

3. Which of the following is a characteristic of Bump Maps?  

a) They modify the geometry of a surface. 

b) They use grayscale values to simulate surface relief without increasing polygon 

count. 

c) They require more rendering time than Displacement Maps. 

d) They cast shadows and receive light like actual surface relief. 

 

4. What is the key difference between Bump Maps and Displacement Maps?  

a) Bump Maps alter the geometry, while Displacement Maps simulate surface relief. 

b) Displacement Maps modify geometry, while Bump Maps simulate surface relief 

without changing geometry. 

c) Both Bump and Displacement Maps modify surface geometry. 
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d) Displacement Maps are only used in 2D images, whereas Bump Maps are used in 

3D models. 

 

5. Which of the following maps uses grayscale images to modify the surface of a model 

and creates the illusion of depth?  

a) Diffuse Map 

b) Specular Map 

c) Normal Map 

d) Bump Map 

 

6. What does a Normal Map do in 3D graphics?  

a) It modifies the actual geometry of a surface. 

b) It uses pixel shaders to simulate fine details and surface appearance. 

c) It adds lighting effects based on the intensity of pixels. 

d) It alters the specular highlights on a surface. 

 

7. Which map is used to create actual surface relief by altering the geometry of a 3D 

model?  

a) Bump Map 

b) Displacement Map 

c) Opacity Map 

d) Specular Map 

 

8. What effect does turning on the "Alpha is Luminance" attribute have on a Texture 

Map?  

a) It makes the surface appear more reflective. 

b) It alters the transparency effect based on pixel intensity, not colour. 

c) It creates a bump effect on the surface. 

d) It enhances the specular highlights. 

 

9. Which of the following is true about Reflection Maps?  

a) They modify the geometry of a 3D object. 

b) They simulate the reflection of the environment on a surface. 

c) They add glow effects to the surface. 

d) They are used to create shadows on objects. 

 

10. To create a subtle glow effect in 3D graphics, what should be done?  

a) Increase the brightness of the Glow Map rapidly. 

b) Use a bright Diffuse Map with a bright Glow Map. 

c) Start with a darker Glow Map and gradually increase the brightness. 

d) Decrease the Diffuse Map's brightness significantly. 
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Session 5: UV Texture Mapping 

 
 

 

UV Mapping is the 3D modelling process of projecting a 2D image to a 3D model's 

surface for Texture Mapping. UV Maps or the Texture coordinates decide where the 

2D Texture Map will fit into the 3D Object. It is a 2D representation of a 3D Object 

to be more precise.  

 

By default, most 3D software automatically UV Maps the 3D objects we create. 

However, to gain more precise control over the placement of textures, it is necessary 

to manually map the UVs (Figure 2.22).  

 

i. Create a Polygon Cube using Create/Polygon Primitives/ Cube. 

ii. This box is a cube measuring 1 foot which will results in 30 centimeters after 

the conversion of foot into the centimeters. 

iii. One Foot = 30 Centimeters 

iv. Set the height, width and depth parameters to 30 each. 

v. Now we will apply, the texture for the wooden box as we have planned.  

vi. To assign the textures on to the POLY CUBE, we need to examine the UVW 

Map coordinates.  

vii. UVW Map coordinates will help in analyzing the texture placement for each 

side of the cube.  

viii. Open up UV texture editor using window/UV texture editor. Select the cube 

to see the default UV coordinate points.  

ix. One can see that software has already mapped the cube for you. It is because 

every Primitive Geometry is mapped with default set of UV coordinates 

(Figure 2.23). 

  

NOTE: Since the Maya application's default unit setup is in centimeters, we have 

calculated the same unit setup for measurement. 

 

Figure 2.22: Example of a box 
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NOTE: Observe the UV points in the UV Texture Editor. There are six quads. each 

representing side of the cube. To know the particular side and its UV points highlight 

the Face or UV points in the viewport. So whatever texture information will be filled 

into the UV points spacing. Same will be displayed in the viewport. 

 

i. To map a desired texture Bitmap, various techniques can be employed. UV 

coordinates can be saved as a Bitmap, allowing each square of the UV space to 

be painted with a custom design or texture. Alternatively, texture Bitmaps from 

other files can be cut and pasted. When a single texture Bitmap is assigned to 

a poly cube, it is shared across each side, resulting in partial visibility of the 

Bitmap image (Figure 2.24). 

ii. Let us work on the approaches to texture the Cube. Go to Hypershade, under 

Window/Rendering Editors/ Hypershade. Select the Lambert surface shader. 

Figure 2.24: A view of Hypershade to assign material on the cube   

Figure 2.23: A view of UV texture editor (on Left) with opened UV’s of 

the cube (on right) 
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iii. To assign the texture Bitmap, there are two ways, first open the Lambert 

surface attributes and choose texture using Colour attribute and second, click 

on the File Node under 2D Texture nodes. Use the MMB, drag the File texture 

node onto Lambert surface shader node and select the Colour attribute channel 

from the options (Figure 2.25). 

iv. To assign the texture, double click the File texture node and browse the wooden 

texture file. 

v. One can assign the Surface shader along texture to the Poly Cube in two ways, 

first select the Poly Cube in the viewport and assign the Poly Cube in two ways, 

first select the Poly Cube in the viewport and assign the texture by LMB (Left 

Mouse Button) and Assign material to selection or second MMB (Middle Mouse 

Button) drag the lambert node to the poly cube in the viewport. 

vi. Open UV texture window and compare the UV points placement and texture 

placement in the viewport. 

vii. If we observe the viewport for texture display on the Poly Cube, it's completely 

stretched on the whole Cube surface. To correct it we can either increase the 

tiles or translate the UV placement or scale and fit the each of the square space 

onto UV co-ordinate area (0-1). To do that, select the UV points in the UV 

Texture Editor and Split the UVs by going to menu Polygons/Split UVs. Scale 

up the each of the square up to 0-1 UV space (Figure 2.26). 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.26: A textured box 

Figure 2.25: A view of UV texture window to compare UV points    
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viii. Go to step 5 and capture the UV’s placement coordinated using UV snapshot 

under polygons menu of UV texture editor. Under the UV Snapshot settings 

specify the target path for saving the Bitmap.  

ix. Set the desired resolution, (we have set it to 1024x1024 for medium quality). 

Keep the aspect ratio for square texture (you can change it for other 

proportions). Anti –Alias techniques is used for softer thin lines. Image file 

formats PNG (according to project requirement it can be changed) and UV range 

to 0-1 (Figure 2.27). 

x. Open the UVs Bitmap snapshot image in the Photoshop and map the desired 

texture Colours (Figure 2.28). 

 

 

 

Figure 2.27: Displacement of UVs 

Figure 2.28: A view of UV texture editor to capture UV snapshot 
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We have completed the basic learning on how to map a texture on standard primitive 

geometry (Figure 2.29). This procedure can be repeated for any other form of box. 

 

The processes of the digital and matte painting are already well known to you as it is 

described earlier. Now, texturing in Photoshop is just like painting the required Colour 

Information on the right place according to the UV snapshot. 

 

 

 

 

 

 

 

 

 

 

 

Here, an image of creating diffuse or Colour Map in Photoshop is given for you. 

 

 

 

Figure 2.29: Edited captured UV snapshot applied on 3D cube 

Figure 2.30: 3D cube final 

output  

Figure 2.31: Colour Map in Photoshop 
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Get your UV and create the textures 

 

Open the UV snapshot in Photoshop. 

 

If saved in PNG format, the transparency information is embedded within the image. 

Otherwise, the blending mode must be set to "Screen" to view only the UV. 

 

Create a new layer. 

 

Paint or apply realistic texture images to the appropriate sections based on the UV 

Mapping. 

 

Use multiple layers for different texture parts, allowing for easy modification, colour 

correction, and transformation if necessary. Gather and analyze a wide range of 

images related to the model and texture to achieve a realistic and accurate result. 

 

The Importance of Pixels 

 

Pixels define the resolution and clarity of textures applied to 3D models, and their 

management directly affects both the visual quality and performance of a scene. When 

creating textures in Maya, texturing artists rely on high-resolution images to capture 

fine details such as bumps, creases, and surface imperfections. The more pixels 

available, the sharper and more detailed the texture will appear. However, higher pixel 

resolutions, like 2K or 4K, can increase rendering times, memory usage, and can 

potentially slow down the viewport performance. Efficient use of pixels is crucial, as a 

texturing artist must strike the right balance between resolution and performance, 

ensuring that textures are detailed enough for realism while keeping the project 

manageable for rendering and editing (Figure 2.32 and 2.33). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.32: Example of UV Map of objects 

Figure 2.33: Example of UV Map of a character 
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Activities 

  
Activity 1: Create UV Texture Map on box 

 

Materials Required: Computer system, and Autodesk®Maya® software 

 

Procedure: 

• Create 3 to 4 wooden boxes, each made from textured wood planks.  

• Stack the boxes on top of each other, ensuring that the bottom box is the largest 

in size. 

• Position the bottom-most box on the floor, which should be textured with a 

marble surface. 

 

 

Check Your Progress 

  
A. Multiple Choice Questions  
 

1. What is the purpose of UV Mapping in 3D modeling? 

a) To increase the polygon count of a model 

b) To define how a 2D texture will be applied to a 3D model 

c) To create a light source for the model 

d) To adjust the size of a 3D model in the scene 
 

2. When assigning textures to a 3D model in Maya, what is the first step after creating 

the geometry? 

a) Apply the texture directly to the object 

b) Open the UV Texture Editor to view the UV coordinates 

c) Adjust the lighting setup in the scene 

d) Create a material shader for the object 

 

3. What happens when a single texture Bitmap is applied to a cube in Maya without 

adjusting UVs? 

a) The texture will perfectly fit each face of the cube 

b) The texture will be stretched across the entire cube, distorting it 

c) The cube will become invisible 

d) The texture will appear in grayscale 

 

4. In Maya, which tool allows you to adjust the placement of UV coordinates for better 

texture alignment? 

a) Hypershade 

b) UV Snapshot 

c) UV Texture Editor 

d) Polygon Split Tool 
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5. Why would you use the “Split UVs” function in Maya? 

a) To merge multiple UV islands into one 

b) To break the UVs apart and scale them for better texture fitting 

c) To convert UVs into polygons 

d) To rotate the entire 3D model 

 

6. What is the significance of using a 1024x1024 resolution when taking a UV 

snapshot in Maya? 

a) It results in the highest possible texture resolution 

b) It balances texture quality with rendering performance 

c) It is the default setting for all 3D models 

d) It produces the smallest file size 

 

7. In Photoshop, when working with a UV snapshot, what should you do to ensure 

transparency is preserved? 

a) Save the image in JPEG format 

b) Use the "Screen" blending mode if not saved as PNG 

c) Apply a gradient layer 

d) Set the image mode to RGB 

 

8. When texturing a 3D model in Maya, why is it important to use multiple layers for 

different texture parts in Photoshop? 

a) To make the texture process faster 

b) To allow easy modifications, colour corrections, and transformations 

c) To reduce memory usage during rendering 

d) To prevent UV distortion on the model 

 

9. How does the resolution of the texture (e.g., 1K, 2K, 4K) affect the final result in 

Maya? 

a) Higher resolutions improve rendering speed 

b) Higher resolutions provide more detail but can slow down performance 

c) Lower resolutions result in more detailed textures 

d) Texture resolution does not affect render time 

 

10. What should a texturing artist focus on when managing pixel density in a 3D 

scene? 

a) Maximizing the resolution for the entire scene 

b) Striking a balance between texture detail and system performance 

c) Using only low-resolution textures 

d) Ignoring the resolution to focus on other aspects of modeling 
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Session 6: Creating 3D Bump Map 

 
 

 

Bump Mapping is a Texture Mapping technique in computer graphics for simulating 

bumps and wrinkles on the surface of an object. 3D Bump Maps are maps used in 

3D modelling to artificially create raised textures without having to model the 

individual details. Trying to model detailed textures can create a mess of thousands 

of extra polygons, multiply the time to model exponentially, create unrealistic looking 

models, and increase rendering time and processing power to ridiculous amounts. 

Without realistic 3D textures, though, 3D models look flat and lifeless. 

 

Bump Maps are used as layers 

beneath fully painted colour 

Texture Maps and employ 

grayscale to instruct 3D 

modeling programs on how to 

extrude polygonal surfaces 

(Figure 2.34). White indicates 

the highest level of extrusion, 

black signifies the flattest areas, 

and various shades of gray 

represent intermediate levels. 

For instance, when texturing a 

lizard's skin, a Bump Map might 

use mid-level gray as a baseline for the skin surface, black for deep cracks, and lighter 

gray spots to show raised, pebbled areas achieving detailed surface effects without 

modeling each bump or crack. This technique can also enhance facial highlights and 

shadows, as well as add realistic details like folds and wrinkles to clothing or armor. 

Visual difference between the two steps, before and after applying Bump Map to model 

 

Creating a Bump Map in Photoshop is easy, especially if already created a Texture 

Map with highlights and shadows painted in Colour. The basic steps are: 

 

i. Either open your existing Coloured Texture Map or create one in Photoshop 

using paint tools. If you are just looking for a generic texture and not something 

specific like facial shading, you can use layer styles such as the Pattern Overlay 

to generate a repeating texture.  

 

ii. For specifically painted detail, you will need the exact Map to make sure that 

the Colour-painted highlights and shadows line up with the bump Map's 

texture extrusions. 

 

Figure 2.34: Sample Bump Map to create a 
wall texture      
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iii. Save a grayscale copy of the map. To turn a Colour version into a grayscale 

version, use the Desaturate function under the Image->Adjustments menu. If 

you have generated your texture using layer styles and pattern overlays, you 

may need to flatten the layer so your adjustments affect the texture and not 

just the base Colour underneath. 

 

Applying desaturase command on Colour map 

 

One may need to tweak the Bump Map to increase the contrast between lighter and 

darker areas. Using it as is may not create the depth of detail that you are looking for 

in your texture. One can use the Brightness / Contrast tool under the Image-

>Adjustments menu to sharpen the image and increase the contrast (Figure 2.35). 

Finally, you can apply High Pass filter to the final bump Map, going under the filter 

menu-> Other -> High Pass, as it will help to show only the difference between the 

contrast areas. Bump Map cannot help in case of extreme displacement, as it is only 

for the making of minute details on the surface. Therefore, a large area of black or 

white Colour in the Bump Map does not mean to push or pull that area in an extreme 

manner. 

 

Applying High Pass filter to one de-saturated image, we can get only the minute detail 

information of the surface. 

 

Save the file-preferably in a lossless format with a high level of detail, like TGA/ PNG. 

Once you have created your Bump Map, all you need to do is import it into your 3D 

animation program. Different programs have different ways of integrating Bump Maps 

into a model or polygon surface, but the controls for the Bump Map should allow you 

Figure 2.35: A view of editing Bump Map in Adobe Photoshop      
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to define a range to make sure the raised textures and depressions donot extrude to 

extremes or scale down so small that they hardly show. 

 

 

Activities  
 

Activity 1: Explain Bump Mapping on human face  

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure 

• Model a 3D human face in Autodesk® Maya®. 

• Apply realistic Texture Mapping to the 3D face using the UV Mapping 

technique. 

• Integrate Bump Mapping to enhance the surface detail, simulating the fine 

details and imperfections of a real human face. 

 

 

Check Your Progress 

  
 

A. Multiple Choice Questions  

 

1. What is the primary purpose of Bump Mapping when applied to a 3D model? 

a) To add realistic surface details without altering the geometry 

b) To change the shape of the model 

c) To create a wireframe of the model 

d) To reduce rendering time 

 

2. Which mapping technique is used to apply a texture accurately onto a 3D face in 

Maya? 

a) Vertex Mapping 

b) UV Mapping 

c) Procedural Mapping 

d) Shader Mapping 

 

3. What does Bump Mapping simulate on a 3D surface? 

a) Colour variations 

b) Transparency 

c) Surface roughness and depth 

d) Lighting effects 

 

4. When creating a 3D human face and texturing it, which tool in Autodesk® Maya® 

helps visualize the UV layout? 

a) Outliner 
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b) UV Texture Editor 

c) Hypershade 

d) Attribute Editor 

 

5. What file format is commonly used for exporting a UV snapshot for further editing 

in software like Photoshop? 

a) .obj 

b) .mp4 

c) .fbx 

d) .png 

 

6. Which attribute should be modified to link a Bump Map to the texture of a 3D 

model in Maya? 

a) Colour attribute 

b) Bump Depth attribute 

c) Transparency attribute 

d) Specular attribute 

 

7. Why is it essential to use high-resolution images when texturing a 3D face? 

a) To decrease file size 

b) To ensure detailed and realistic textures 

c) To reduce modeling time 

d) To increase render speed 

 

8. What should you do if the Bump Mapping effect on the face appears too 

exaggerated? 

a) Increase the model's polygon count 

b) Decrease the bump depth value 

c) Apply a different UV Map 

d) Change the camera angle 

 

9. In the context of Bump Mapping, what type of image file is typically used to create 

the effect? 

a) Grayscale image 

b) RGB colour image 

c) Transparent image 

d) Vector image 

 

10. Which of the following techniques can enhance the realism of a 3D human face 

in Autodesk® Maya®? 

a) Using only Colour Maps 

b) Adding Bump and Normal Maps 

c) Applying low-resolution textures 

d) Ignoring the UV layout 
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Session 7: Specular Map 

  
 

Specular Map 

 

Specular Maps are the maps used to define a surface's shininess and Highlight 

Colour. The higher the value of a pixel (from black to white), the shinier the surface 

will appear in-game. Therefore, surfaces such as dry stone or cotton fabric would tend 

to have a very dark Specular Map, while surfaces like polished chrome or plastic would 

tend to have lighter Specular Maps. 

 

The Colour of a pixel is also used, to calculate the resulting Colour of the surface. A 

very saturated specular Map will have a very different visual effect than a Gray 

specular Map. If you need a more "neutral" highlight on a surface, your specular Map 

should use the inverse of the Diffuse Map's colour. Using the same colour on the 

specular as on the diffuse will result in a more saturated highlight when viewed in the 

game. 

 

Contrasts in specular can make a surface appear more visually interesting in the 

game. For example, a door with a very dark specular for the wood and lighter metal 

parts will make the metal stand out as a shinier surface when light hits it. This type 

of contrast helps make surfaces in the game appear more realistic. 

 

Creating a Specular Map in Photoshop 

 

Here we will study about a quick and easy way to generate a Specular Map for your 

objects in some easy steps using the Colour Map. 

 

i. Open up the Colour Map for your object in Photoshop (Figure 2.36). 

 

 
Figure 2.36: A view of editing map in Adobe Photoshop      
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ii. Add a channel mixer and check the option box for Monochrome (Figure 2.37). 

 

 

 

 

 

 

 

 

 

 

 

iii. To make a Specular Map for this object, we have to create a Gray scale where 

white will produce the most intense specular reflection, Grays produce a little 

specular reflection and black produces no specular reflection. Just like creating 

a Bump Map. 

iv. Add a Brightness /Contrast channel and a Levels Channel using the same 

button that we used earlier to add a Channel Mixer. Try and bring out the 

blacks and dark Grays more (Figure 2.38). 

 

v. Select the dodge tool. Make sure that the exposure is not too high. Using this 

tool, paint out the areas where you want more specularity. Keep in mind that 

the corners and sharp edges of objects will always have specularity (Figure 

2.39). 

 

Figure 2.38: A view of editing map to reduce secularity in Adobe Photoshop 
 

Figure 2.37: A view of editing map and adding channel mixer in Adobe 
Photoshop      
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Now, this is your final Specular Map (Figure 2.40). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.39: A view of editing map by using channel mixer in Adobe 
Photoshop      

Figure 2.40: A view of final Specular Map (on left) and secularity 

output (on right) 

http://1.bp.blogspot.com/-_0t7pM6sh8g/UDEaOSOgizI/AAAAAAAAAJs/zVKtLRgBygk/s1600/Tutorial3.jpg
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Activities 

 
 

 

Activity 1: Creating a 3D Model with Specular Mapping 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure 

• Design a 3D model of a metal door, including detailed components such as 

hinges, handles, and latches, each using metallic textures. 

• Apply a reddish wooden texture to the main door structure. 

• Ensure that the components are textured using the UV Mapping technique for 

accurate texture placement. 

• Demonstrate the use of Specular Mapping to highlight the reflective properties 

of the metal parts, creating realistic contrasts between the wood and metal 

surfaces. 

 

 

Check Your Progress 

 

A. Multiple Choice Questions  

 

1. Which function in Photoshop is used to convert an image layer to grayscale when 

creating a Specular Map?  

a) Brightness/Contrast 

b) Hue/Saturation 

c) Desaturate 

d) Invert 

 

2. What is the purpose of duplicating the layer before starting the Specular Map 

creation?  

a) To save memory space 

b) To maintain a non-destructive workflow 

c) To apply filters faster 

d) To increase contrast 

 

3. When adjusting brightness and contrast for a Specular Map, what are you primarily 

trying to highlight?  

a) The colour accuracy of the texture 

b) Areas of the image with varying levels of reflectivity 

c) Shadows and midtones 

d) Edges and outlines only 
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4. Which Photoshop tool or adjustment is used to tweak the levels of brightness and 

contrast in an image?  

a) Gradient Map 

b) Levels 

c) Brightness/Contrast 

d) Curves 

 

 

Session 8: Creating Seamless Textures in Photoshop 

 
 

 

In this session, the concept of seamless textures 

is explored in depth. By examining the image, 

insight into its visibility and texture is gained, 

which are essential for ensuring proper 

application and utility. 

First, examine the image carefully. Notice if one 

side appears significantly darker than the other. 

In this example, the top right corner is noticeably 

darker than the rest of the image. This uneven 

lighting can make it challenging to create a 

seamless texture, so the next step is to trim t he 

image to focus on the more uniform sections.  

 

i. It is trimmed it down to the lower left 

portion of the image (Figure 2.42), which 

all looks pretty uniform in Colour. If you 

are not sure how to trim an image, the 

easiest way is going to be to use the 

Rectangular Marquee Tool (hit M) to select 

the part of the image that you want 

to keep. Then choose Image > Trim 

from the main menu. It should look 

something like this (but doesn’t need 

to be exact). 

 

The parts of the image that are keeping our 

sample from being seamless are where the 

edges meet up, right? So, let us move those 

edges so that we can see them better 

(Figure 2.43). Yes, we can do that! 

Photoshop has this wonderful feature for 

creating seamless textures, 

called “Offset.” It is found under 

the main menu: choose Filter > 

Other > Offset 

Figure 2.41: Example of a 
texture    

 

Figure 2.42: Example of edited 

texture to remove darker offset 
site     

Figure 2.43: Settings view to use in 
texture to remove darker offset site     



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

150 
 

                                                                     Texturing Artist - Grade XII  

 

ii. Use settings similar to those that you see in my image here. What this is doing 

is taking the edge of the right side of the image and wrapping it around to the 

left side (and wrapping the bottom around to the top), effectively moving the 

previous “edges” into the middle of the image! 

 

iii. See those lines where things don’t meet up? That’s where our old edges were. 

The new edges came from the middle of the image somewhere, so they’re now 

entirely seamless. All we have to do is fix up those visible ones, and we’re good 

to go! 

 

iv. Now comes the hardest part. We need to clean up those visible edges 

somehow, and the Clone Stamp Tool is the way to do it. It’s on your tools 

window where I highlighted it in red, or you can just hit “S” to make it active. 

 
v. The brush that you choose to use with it is very important, as well. Do NOT 

just use a standard round brush, or anything with edges that are too “soft.” 

Here are a few suggestions. Under “Natural Brushes 2,” any of the 3 chalk 

brushes work well. Just about any of the brushes in “Natural Brushes” work. 

I tend toward a few of the brushes in the “Wet Media Brushes” set, as well. 

Drippy Water, Dry Brush on Towel, Paint on Rough Texture, and Rough Dry 

Brush are some of my favorites.  

 
vi. Especially if you’re working on an earthy texture, like this is. What brush you 

use will depend upon how rough your texture is. If it’s something fairly soft, 

then you may be alright with a softer brush. I would still stay away from the 

round ones, though. They leave some very definable edges (Figure 2.44). 

 
vii. Make sure that your opacity is set somewhere between 50-85%, as you see 

here. 50% works good for those softer textures and up closer to 85% works 

great for those rough ones, like this one. I’m going to be using the “Rough Dry 

Brush” from the “Wet Media Brushes” set. As you can see here, I have the size 

at about 29, and my opacity is set at 82%. 

 

 

viii. If you have never used the Clone Stamp Tool before, it can be kind of fun. 

What it does is takes from one part of the image and paints a replica of it 

somewhere else on the image. So, what you are going to want to do is find a 

nice, clean portion of the image. A portion that does not have that ugly visible 

line running.Through it. Somewhere on the lower right, perhaps. Holding ALT, 

left click on that lower right part of the image. 

 

Figure 2.44: Brush properties in Adobe Photoshop 
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Now, start painting over that line on the left side. See that small crosshair that 

shows up over on the lower right? 

 

ix. That shows you what the clone stamp tool is using as a reference for what it is 

currently painting. Make sure that crosshair doesn’t run off the edge of the page, 

or into the ugly visible line somewhere, or you are going to get a mess.  

 

x. The easiest way that I have found to do this is to hit ALT and get your reference 

point, then paint a bit over the line. Then hit ALT somewhere else and get 

another reference point, then paint over the line somewhere else. Always keep 

your eye on that crosshair to make sure it’s staying where you want it to be! 

  

xi. When you move your brush up, the reference point/crosshair moves up. It will 

follow your movements exactly. 

 
xii. That may sound complex, but just try it. You’ll see what I mean. It may take a 

few tries before you really get the hang of the clone stamp tool. It is extremely 

handy once you do, though! 

 
xiii. One thing to keep in mind. Do NOT do too much to those four corners where the 

lines meet the edges! Use a smaller brush around those areas and make sure 

that it doesn’t overlap the edge of the image at all. Remember, those edges need 

to remain seamless, and if you mess 

with them too much, they won’t be 

anymore!  

 
xiv. So, you can paint it close to the edge, 

but not all the way up to it (Figure 

2.45). (That applies to all of the edges 

of the painting, not just the four 

where the lines meet it. But those 

unsightly lines are the only part of 

the image that you should be 

changing, which is why I 

highlighted just them). 

 
xv. This is what my image looks like when I am done. You can’t see those lines 

anymore at all.Now, to check it. We need to make sure it looks seamless, right? 

 
xvi. Choose Edit > Define Pattern from the main menu. Then open a new image. I 

made mine 1000 X 1000 pixels, 72 pixels/inch, RGB Colour mode, with the 

Background Contents as White (Figure 2.46).  

 
xvii. Now, create a new layer by clicking on the “Create a New Layer” at the bottom of 

the layers palette (if your layers palette isn’t visible, choose Window > Layers 

from the main menu or hit F7). 

 

Figure 2.45: Clear image without dark 

lines representing seem less image 

 

Fig.2.46:New layer 
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xviii. Choose the Paint Bucket Tool 

from the tools palette, as shown 

here, and then click anywhere in 

the canvas. What Colour you’re 

using doesn’t matter. 

 
xix. At the bottom left of the layer’s 

palette, click on the “Add a Layer 

Style” button, as shown here. 

Choose “Pattern Overlay” from 

the menu. 

 
xx. On the window that pops up, click on the small arrow just to the right of the 

thumbnail of your currently selected pattern. Scroll to the bottom (if there’s a 

scrollbar), and choose the very last pattern. Once you’ve selected that as your 

pattern, you should see it over on your canvas. Play around with the Scale slider, 

so that you are absolutely sure that you are seeing more than one instance of 

your texture. It needs to be small enough to be able to see the edges that are 

visible, if there are any (Figure 2.47). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activities 

  
 

Activity 1: Design a 3D Model and Apply a Photoshopped Texture 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

 

Figure 2.47: Patterns in Adobe Photoshop 
using filter gallery     

 

Figure 2.46: Layer style window in 
Adobe Photoshop  
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Procedure 

• Design a 3D model of an old castle featuring stone brick walls. 

• Apply a textured Bump Mapusing the UV Texturing method to enhance the 

realism of the stone surface. 

• Render the final castle model from a perspective view. 

 

 

Check Your Progress 

 
 

 

A. Multiple Choice Questions  

 

1. What is the first step in ensuring that an image can be seamlessly used as a texture? 

a) Apply a filter to the image 

b) Trim the image to remove unwanted sections 

c) Use the Clone Stamp Tool 

d) Adjust the contrast and brightness of the image 

 

2. Which Photoshop tool is used to select the portion of the image you want to keep 

for texturing?  

a) Magic Wand Tool 

b) Rectangular Marquee Tool 

c) Crop Tool 

d) Lasso Tool 

 

3. After trimming the image, which Photoshop feature is used to move the edges and 

make them seamless?  

a) Transform Tool 

b) Offset Filter 

c) Layer Mask 

d) Gaussian Blur 

 

4. When using the Clone Stamp Tool, what is the primary purpose of holding down 

the Alt key? a) To adjust the brush size 

b) To sample a reference point for cloning 

c) To invert the brush 

d) To change the opacity 

 

5. How should the opacity be set for the Clone Stamp Tool when working on rough 

textures? a) 10-20% 

b) 25-40% 

c) 50-85% 

d) 100% 
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6. What type of brush is recommended for creating seamless textures with the Clone 

Stamp Tool?  

a) Round Brush 

b) Soft Round Brush 

c) Chalk Brush or Wet Media Brushes 

d) Square Brush 

 

7. When painting over a visible line with the Clone Stamp Tool, what should you 

monitor to ensure the cloning is correct?  

a) The layer opacity 

b) The brush flow 

c) The crosshair representing the reference point 

d) The image resolution 

 

8. What should you avoid when working with the Clone Stamp Tool on the edges of 

the image?  

a) Cloning multiple times in the same area 

b) Modifying the image's brightness 

c) Overlapping the edge of the image 

d) Using too large a brush 

 

9. What is the purpose of selecting "Pattern Overlay" in the Layer Styles menu?  

a) To apply a filter to the texture 

b) To apply the texture as a pattern to a new image 

c) To add a shadow effect to the texture 

d) To apply a gradient to the texture 

 

10. When checking the seamlessness of the texture, what action should be performed 

in Photoshop?  

a) Use the Gaussian Blur filter 

b) Define the pattern and apply it to a new canvas 

c) Resize the image 

d) Adjust the saturation of the image 
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Module 3 

 

Rendering, Compositing and File Formats 

 

 

 

Module Overview 

 

This module focuses on the essential techniques and concepts related to rendering 

and compositing in 3D modeling. It will provide students with a comprehensive 

understanding of the various file formats used in the industry, along with trouble 

shooting strategies to resolve common issues encountered during the rendering 

process. Through practical applications and hands-on exercises, learners will gain the 

skills necessary to create high-quality visual outputs and effectively manage file types 

within their projects. 

Session 1 is on “Rendering and Compositing”. It introduces the fundamentals of 

rendering, including various rendering engines and techniques for producing high-

quality images. It also explores compositing methods, focusing on how to combine 

multiple visual elements into a cohesive final image to enhance aesthetic impact. 

Through hands-on exercises, participants will set up render scenes, adjust lighting, 

and apply materials, gaining practical experience in achieving realistic visual results. 

The Session 2 is on “Working with File Formats”, and the focus shifts to 

understanding the different file formats used in 3D rendering and compositing. After 

this session understanding about the characteristics, advantages, and disadvantages 

of various formats such as JPEG, PNG, TIFF, and EXR, as well as their suitability for 

specific applications increases. Practical exercises will enable learners to effectively 

export and import files, ensuring compatibility and efficient asset management within 

their projects. 

Session 3 on “Troubleshooting” focusses common issues encountered during 

rendering and compositing and develop effective troubleshooting techniques to 

identify and resolve problems such as rendering artifacts, performance bottlenecks, 

and compositing mismatches.  

 

 

Learning Outcomes  

  
 

After completing this module, you will be able to: 

 

• Describe the various methods of rendering. 

• Identify and perform basic rendering process. 

• Identify and perform basic compositing process. 
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• Demonstrate the knowledge of various file formats used in the production 

pipeline. 

• Determine the root causes of common texturing problems, such as uneven 

texture distribution, texture stretching, or visible seams. 

 

 

Module Structure 

 
 

Session 1: Rendering and Compositing  

  
Session 2: Working with File Formats 

  
Session 3: Trouble Shooting 

  
 

Session 1: Rendering and Compositing 

 
 

 

Composition is a powerful tool for directing the viewer’s attention toward the most 

significant elements of an image, often in a deliberate sequence. A well-crafted 

composition can transform even the simplest subjects in plain environments into 

compelling visual works. Conversely, a poorly structured composition can diminish 

the impact of a photograph, regardless of the subject’s intrinsic interest. Unlike 

common issues like exposure or white balance, composition errors are challenging to 

correct in post-processing. While cropping can sometimes improve a composition, it 

is effective only when tighter framing or removal of certain elements enhances the 

overall image. Therefore, giving thoughtful attention to composition before capturing 

an image is crucial. 

Composition involves the arrangement of visual elements in a scene and how these 

elements guide the viewer’s gaze. Various techniques exist, such as using lines or 

curves to lead the viewer toward the focal point. The positioning of the main subject 

and other elements in the scene plays a significant role in shaping the viewer's 

experience. One popular compositional guideline, the rule of thirds, is loosely based 

on the Golden Ratio a mathematical principle found throughout nature in forms like 

seashells, leaves, and even the human body. This concept, often introduced in 

geometry, illustrates balance and harmony in visual arrangements. 

Rendering 

 
Rendering is the process of generating a photorealistic or non-photorealistic image 

from a 2D or 3D model by means of a computer program. The resulting image is 

referred to as the render. 
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Before rendering process, it is really necessary to understand camera angles its 

movements. The rendering stage is usually associated with computer-generated 

animation, although rendering can also refer to the process of creating final animation 

frames in traditional hand-drawn animation. Rendering is used in both 2D and 3D  

computer animation.  

Rendering is the process of extracting the final assembled animation scenes or pieces 

from the computer in the format of a sequence of individual frames. The aim of 

rendering is to generate a series of pixel-based frames or a video clip. 

Before rendering a scene, it is essential to diagnose it for common problems that can 

affect image quality and rendering times. While rendering provides a visual 

representation of the scene, visualizing it in alternative ways can often be a faster 

approach: 

To... Do this... 

Changes to a still image or a single 

frame of an animation can be seen as 

they are made. 

Use Interactive Photorealistic Rendering (IPR). 

IPR updates the display to show your most 

recent change, but there are limitations to 

what can be seen.  

See what a still image or single frame of 

an animation (or a region of it) looks 

like as the render occurs. 

Use Render View, especially Render Region. 

Render View has fewer limitations than IPR, 

allowing for a more comprehensive view, but 

it takes longer to render. Rendering regions 

of a scene can reduce the time spent 

visualizing the scene. 

See lights, objects and textures in the 

scene view without rendering. 

Use hardware texturing. This approach does 

not actually perform a render; it simply 

provides an approximation of what the 

scene looks like when rendered. 

See what a fully rendered still image, 

single frame of an animation, or an 

animation looks like quickly. 

Render at lower resolutions. 

 

Perform a final render 

To render... Do this... 

A still image or single frame of an 

animation. 

Use Render View.  

A still image or single frame of an 

animation, or an animation. 

Batch render.  
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A still image or single frame of an 

animation, or an animation. 

Command line render. 

 

i. In the main Maya window, click the 

Render Current Frame button, or select 

Render > Render Current Frame. Maya 

renders the current scene and displays 

the image as it renders in Render View. 

ii. To re-render a frame from within Maya 

iii. Select Render > Redo Previous Render 

from the main menu bar. 

iv. Maya renders the scene from the 

previous camera and displays the 

image as it renders in the Render View 

window. 

v. To cancel the in-progress render Press Esc. 

vi. To batch render from within Maya 

vii. Do any of the following: 

viii. Click Render > Batch Render to batch render. 

ix. To cancel the render, click Render > Cancel Batch Render. 

x. To show the image being rendered, click Render > Show Batch Render.  

Note:  

To set batch render options, select Render > Batch Render > to open the Batch Render 

window. For a description of the batch render options, see Batch Render Options. 

When using the Maya Batch Renderer on a remote machine the User Account 

information (i.e., username) must be consistent between the machines to ensure that 

User Authentication will function correctly. 

Use a single processor when batch rendering a scene that contains a spotlight, 

material transparency, and raytrace shadows. 

 

A scene can be rendered on a computer that has more than one processor, utilizing 

some or all of its available processors.To render on a computer with several processors 

from within Maya.  

i. From the Maya window, select Render > Batch Render >. The Batch Render 

Frame window displays. To use all available processors on your computer for 

rendering, turn on Use all available processors. 

 

ii. To use only some of the available processors on a computer for rendering, turn 

off "Use all available processors" and set "Number of Processors to Use" to the 

desired number of processors. 

 

Note: To set batch render options, 

select Render > Batch Render > to 

open the Batch Render window. For 

a description of the batch render 

options, see Batch Render Options. 

When using the Maya Batch 

Renderer on a remote machine the 

User Account information (i.e., 

username) must be consistent 

between the machines to ensure 

that User Authentication will 

function correctly. 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

159 
 

                                                                     Texturing Artist - Grade XII  

iii. Click Batch Render. Maya renders the animation. To render on a computer 

with several processors from a shell or command line (Maya software rendering 

only) 

Type:Render -r sw -n <# of processors to render on><scene> 

(If you do not use the -n option, only one processor is used for rendering.) 

Examples (for Maya software rendering only): 

To use one processor for rendering, type: 

Render <scene> 

To use two processors for rendering, type: 

Render -n 2 <scene> 

To use all processors on your computer for rendering, type: 

Render -n 0 <scene> 

 

Render View allows rendering a specific portion of a scene at any resolution, providing 

a sense of the changes made while shading, lighting, and texturing objects. Unlike 

rendering at a lower resolution, which reduces the size of the entire image, rendering 

a region can facilitate more efficient and rapid adjustments to specific areas of interest 

at full resolution. 

 

Note: If Auto Render Region is enabled (Options > Auto Render Region), changes 

appear as the marquee is drawn anywhere in Render View. Only the marquee area of 

the surface re-renders, showing the results of the adjustment. 

 

To render a region (Figure 3.1) of a scene: 

 

i. Marquee select the area that needs to be rendered in Render View. 

ii. If there is no representation of the scene in Render View for marquee selection, 

go to Render > Snapshot and select the desired camera (view) to capture. 

iii. Click the Render Region button or select Render > Render Region. 

Figure 3.1: Render view of an object showing Marquee selected region to 

render specific region of the object   
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You can isolate specific objects to render. Note that when using IPR rendering, you 

must perform another IPR render before you can see the effect of this change. 

To render selected surfaces 

 

i. Select the objects you want to render. 

ii. In the Render View window (Figure 3.2), select Render > Render Selected 

Objects Only. 

iii. Render the scene. 

 

 

 

 

 

 

 

 

 

 

 

Note: You can display a wireframe snapshot of your scene to use as a guide to select 

a region of your scene to render. 

In Render View, select Render > Snapshot and select the camera (view) you want to 

capture. 

The Maya Software renderer renders an image as a series of tiles. The renderer tries 

to use a tiling configuration that ensures memory is optimized. Thus, the tiles are 

smaller in the regions of the image where the geometry is dense. The renderer tries to 

ensure that the memory cap specified in the Render Settings window is respected. 

 

The Image resolution is the total pixel size of a Bitmap image. For example, 720 x 486 

for NTSC video output. Display resolution is the number of pixels in 1 inch on the 

screen. Display resolution is measured in pixels per inch (ppi). Most monitors have a 

display resolution of about 72 ppi. For print output, a display resolution of 

approximately 300 ppi is recommended. 

 

Note: The terms pixels per inch (ppi), and dots per inch (DPI) are often interchanged 

freely. Pixels per inch, however, applies only to screen resolution, which display 

images in pixels. Dots per inch, applies only to paper-based images, which are printed 

with dots of Colour. 

Figure 3.2: Render view of the object 
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Subfolders and custom filenames for storing rendered images can be created using 

the File Output section. This section outlines the tokens that can be used to generate 

subfolders and filenames. If none of these tokens are entered, Maya will create default 

subfolders to save the rendered images. 

Default behaviour of rendered images and directories 

By default, Maya saves rendered images to the following subfolders: 

<RenderLayer>/<Camera> 

Scenes with more than one render layer and renderable camera 

If your scene consists of more than one render layer, then a subfolder is created for 

each layer. 

Similarly, if your scene consists of more than one renderable camera, a subfolder will 

be created for each camera. 

 

Creating subfolders and filenames for rendered images 

The following rendered image filename options and tokens can be combined to create 

subfolders and custom image names for rendered images.  

 

i. Enter these options in the File Name Prefix field of the Render Settings: 

Common tab. Use the tokens in conjunction with different separators between 

them. To create subfolders, use the slash (/) separator as in <Render 

Layer>/<Camera>/<Scene>. Use any other separator, for example, underscore 

(_) and dash (-), to separate the tokens in your image file name. You can repeat 

options within the specification, and you can also specify any text you like in 

the image file name or path (for example, .TEST or _final to indicate the kind of 

render that you are performing). 

 

ii. Rendered image filename options (tokens) 

<Render Layer> 

Adds the layer name to the created subfolder or image file name (for example, 

layer1).When using render passes with the Maya software renderer, if more 

than one pass is created for the layer, then pass names are appended to the 

layer name. The format used is layer pass (for example, layer1_beauty). When 

using multi-render passes with the mental ray renderer, a directory is created 

for each pass. 

 

iii. <Scene> 

Figure 3.3: A view of file output window 
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Adds the scene name to your subfolder or image file name. 

 

iv. <Camera> 

Adds the renderable camera name to the created subfolder or image file name 

(for example, camera1).If your scene is set to render fields, then field names are 

appended to the name; for example, camera_odd or camera_even. 

 

v. <RenderPassFileGroup> 

Adds the render pass file group name to the created subfolder or image file 

name (for example, IndirectIllum). 

 

vi. <RenderPass> 

Add the render pass node name to the created subfolder or image file name (for 

example, diffuseNoShadow). 

 

vii. <RenderPassType>  

Many different types of render passes are available for selection using the 

Render Pass Attribute Editor, for example, beauty, shadow, specular, and 

refraction. When you use this render token, a unique abbreviation of the pass 

type, of less than 6 characters, is appended to your output file name, for 

example, REFR for refraction pass. 

 

viii. <Extension> 

Adds the extension to the created subfolder or image file name. 

 

ix. <Version> 

Adds the version label that you have selected to the created subfolder or image 

file name. This option can be a numeric version number, the current date, the 

current time, or any custom version label. Customize this token using the 

Version Label attribute. Setting up your file name prefix using the command 

line. 

 

x. In addition to setting up your file name prefix using the render tokens in the 

Render Settings window: Common tab, you can also use the command line to 

set up the file name prefix using the -imflag. You must include the angular 

brackets for each render token and wrap the string with quotation marks. Some 

of the shorthand notations, for example, %l for layer and %c for camera, are 

still supported for backwards compatibility. However, not all tokens have a 

shorthand equivalent.  

 

xi. Create subdirectories by adding a / (slash). Any alpha numeric text, in addition 

to underscore (_) and dash (-), can be used to separate the tokens in your image 

file name. or example: Render–r-scene-filename-im "<Camera>/ <RenderLayer 

>/Draft  _3_<Scene>_<RenderPass>" 
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OpenEXR file format 

 

Among the available multi-channel file formats, OpenEXR is the only file format where 

multi-channel is being leveraged. Therefore, multiple render passes can be 

concatenated into a single-multi-channel .exr file. Use the Frame Buffer Naming and 

Custom Naming String attributes in the Render Settings: Common tab to customize 

the naming of your OpenEXR channels. 

 

In order to use these attributes, your scene must contain at least one render pass. 

Also, you must select OpenEXR as your file format for these attributes to become 

active. 

 

Select the Automatic mode under the Frame Buffer Naming attribute to use the 

<RenderPassType>:<RenderPass>. <Camera> tokens to name your channels. This is 

the default option. 

Select the Custom mode under the Frame Buffer Naming attribute to customize your 

OpenEXR channel names. Choose from the render tokens listed in Rendered image 

filename options (tokens). 

 

Note: EXR version 1.7 supports 252-character channel names. The limit is 252 

characters to save room for an extension of up to 3 characters used to differentiate 

individual channels (for example.R for the red channel). However, EXR version 1.7 is 

currently supported by a few external applications, and embedding channel names 

longer than 31 characters may break compatibility with external applications that do 

not support it. By default, channel names are truncated to 31 characters for backward 

compatibility. You can create and set MAYA_EXR_LONGNAME to 1 to allow long 

channel names of 252 characters so that they are not truncated. See the Image format 

for more information on the OpenEXR format. See Rendering environment variables 

for more information about the MAYA_EXR_LONGNAME environment variable. 

 

Note: Do not use the <RenderPass> token in your File name prefix field if you are 

using the multi-channel OpenEXR format. Using the <RenderPass> token creates a 

file for each render pass instead of writing to a multi-channel .exr file. 

Frame/Animation Ext 

In addition to the rendered image filename tokens discussed above, you can also use 

the Frame/Animation Ext drop-down list to customize your image name by adding 

the frame number to your image name. For example, if you choose name#.ext with a 

Frame padding of 4, and the scene name is MyScene, then the rendered image would 

be named MyScene0001.iff. 

 

Examples 

1. If you choose not to enter any tokens in the File Name Prefix attribute, the following 

subfolders are created by default: 

<Layer>/<Camera>/IMAGENAME.iff 
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2. If you choose to use the Frame/Animation Ext field in conjunction with the File 

name prefix attribute, you can add the frame number to your image name also. 

Assume that you choose the name_#.ext option with a Frame padding of 2. The 

following entry produces a layer name subfolder and adds 1) the camera name, 2) the 

scene name, and 3) the frame number to the name of the rendered image. The -(dash) 

separator is added to separate the camera and scene names. 

Layer>/<Camera>-<Scene> 

For example, layer1/camera1-MyScene_01.iff 

 

3. The following entry produces no subdirectories, but simply a flat file structure. The 

_(underscore) separator separates the scene, layer and camera names (Figure 3.4). 

<Scene>_<Layer>_<Camera> 

For example, MyScene_layer1_camera2_01.iff 

 

4. The following entry produces a scene name subdirectory, then the layer 

subdirectory, then a camera subdirectory, and then adds the scene name to the name 

of the rendered image, and adds ‘TEMP’ to the image name: 

<Scene>/<Layer>/<Camera>/<Scene>TEMP 

for example, MyScene/layer1/camera1/MySceneTEMP_01.iff 

Compositing 

 

The Compositing Department brings together all of the 3D elements produced by the 

previous departments in the pipeline, to create the final rendered image ready for the 

film. After the animation has been rendered it may be necessary to add some special 

effects or to combine separate rendered elements together into one final animated 

sequence. This process is known as Compositing.  

 

Compositors are responsible for constructing the final image by combining layers of 

previously-created material. They receive material from various sources including 

rendered computer animation, special effects, graphics, 2D animation, live action and 

static background plates. The compositor's job is to assemble the different characters 

and backgrounds into single frames and sequences and so is often the first to begin 

to see the animation as intended for the final audience.  

 

 

Figure 3.4: A view of file output structure 
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The compositing stage also allows for the addition of other elements such as special 

effects which have been created using other equipment and processes. General 

compositing tasks include rendering the different passes delivered by a lighting 

department to form the final shot, paint fixes and rotoscoping, although compositors 

sometimes rely on mattes created by a dedicated rotoscoping department), as well as 

the compositing of final elements and general Colour grading. 

 

 

Activities 

 
 

 

Activity: Explain simple render process 

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure: 

• Choose the objects in your scene that you wish to render. 

• In the Render View window, navigate to Render > Render Selected Objects Only 

to focus the rendering on the selected objects. 

• Execute the render to generate the final image or animation for the chosen 

objects. 

 

 

Check Your Progress 

 
 

 

A.  Multiple Choice Questions  

 

1. What is the primary goal of composition in photography? 

a) To create random placements of objects 

b) To direct the viewer’s attention toward the most significant elements 

c) To focus only on the subject's features 

d) To use bright colours to distract the viewer 

 

2. Which compositional guideline is based on the Golden Ratio? 

a) Rule of Thirds 

b) Leading Lines 

c) Framing 

d) Symmetry 

 

3. What is the purpose of Interactive Photorealistic Rendering (IPR)? 

a) To batch render multiple frames at once 

b) To update the display to show the most recent change in a scene 

c) To visualize scenes in low resolution 

d) To increase rendering time significantly 
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4. What does "Render View" allow in Maya? 

a) Rendering only at full resolution 

b) Viewing a specific portion of a scene as it renders 

c) Rendering with reduced pixel quality 

d) Quick adjustments without rendering the scene 

 

5. What does the term 'batch render' refer to in Maya? 

a) Rendering a specific frame only 

b) Rendering an entire scene in one process 

c) Repeating the render process for an individual object 

d) Adjusting the scene’s lighting 

 

6. What does the "Render Region" function in Maya help with? 

a) Rendering the entire scene at once 

b) Isolating specific areas of the scene for quicker rendering 

c) Displaying the scene without any visual changes 

d) Saving the rendered image 

 

7. How can a user render selected objects only in Maya? 

a) Use the "Interactive Rendering" option 

b) Select Render > Render Selected Objects Only 

c) Use hardware texturing 

d) Enable Auto Render Region 

 

8. What is the purpose of 'Render Pass' in Maya’s rendering process? 

a) To create subfolders for images 

b) To specify different visual effects applied to objects in a scene 

c) To change the resolution of the output file 

d) To render the entire scene without any alterations 

 

9. Which file format is used for multi-channel rendering in Maya? 

a) JPEG 

b) TIFF 

c) OpenEXR 

d) PNG 

 

10. What does the token <RenderLayer> in Maya’s render settings refer to? 

a) The camera angle used for rendering 

b) The name of the render layer being used 

c) The type of image resolution selected 

d) The render pass type being applied 
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Session 2: Working with File Formats 
  

 

A file format is a standard way in which information is encoded for storage in 

a computer file. It specifies how bits are used to encode information in a digital 

storage medium. File formats may be either proprietary or free and may be either 

unpublished or open. 

 

There are various file formats that can provide ease in work to whole chain in the 

production pipeline Some of the commonly used file format are JPEG (Joint 

Photographic Experts Group), PNG (Portable Network Graphics), GIF (Graphics 

Interchange Format), PDF (Portable Document Format), SVG (Scalable Vector 

Graphics) and MP4 (Moving Picture Experts Group), TIF (Tagged Image File) and 

TARGA (True vision Advanced Raster Graphics Adapter). 

 

This section provides an overview of general file format support, noting that there may 

be slight variations in compatibility depending on the platform and specific file format 

variations. For instance, TIFF is a loosely defined format, and while it may be possible 

to save TIFF files in certain programs, Maya may not be able to open them. The 

following tables detail the supported data export file types, associated plugins, 

supported operating systems (OS), and file extensions, offering a thorough guide for 

industry use. 

 

Support Data Export Formats 

 

Data Export Plugin Name Windows Extension 

Maya Ascii  
 

ma 

Maya Binary  
 

mb 

MEL  
 

mel 

OBJexport  objExport 
 

obj 

move (ascii motion)  
 

mov 

apex-Clothing-Exporter physx 
 

ctp 

PhysX physx 
 

 

MayaBullet bullet.mll *1 bullet 

animExport anim-Import-Export 
 

anim 

 

 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

168 
 

                                                                     Texturing Artist - Grade XII  

Note: Starting in Maya 2014, Maya Binary (. mb) files use 64-bit indices and can be 

larger than 2.0 GB. Scenes exported as. mb files are not compatible with earlier 

versions of Maya.*1 For Windows 64 bit only 

 

Support Data Export Formats 

 

Data Import Plugin Name Windows Ext. 

Maya ASCII  
 

ma 

Maya Binary  
 

mb 

MEL  
 

mel 

audio  
 

 

animImport 
anim-Import-

Export  

anim 

OBJ  
 

obj 

studioImport studioImport 
 

wire 

move (ascii motion)  
 

mov 

EPS  
 

eps 

Adobe®Illustrator®  
 

ai 

OpenFlight® flt-Translator 
 

flt 

 

Supported image output and viewport display formats 

 

Image Output 

Windows (Maya 

Software/Hardwar

e/Hardware 

2.0/Vector) 

Extension 

Adobe ® Illustrator ® *3 ai 

ALIAS PIX 
 

als 

AVI *1, *5 avi 

CINEON *1 cin 

DDS *1 dds 

EPS *2 eps 
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GIF *1 gif 

JPEG 
 

jpg 

MacPaint  pnta 

Macromedia SWF *3 swf 

MAYA IFF 
 

iff 

MAYA 16 IFF *1 iff 

PSD  psd 

PSD Layered 
 

psd 

PNG 
 

png 

OpenEXR *6 exr 

Quantel *1 yuv 

Quantel PAL  yuv 

Quantel NTSC  yuv 

Apple® QuickDraw®  pict 

Apple® QuickTime 

Image® 
 gtif 

Apple® QuickTime 

Movie®  

mov 

RLA *1 rla 

SGI ® 
 

sgi 

SGI 16 ® *1 sgi 

Softimage ® 
 

pic 

Targa 
 

tga 

TIFF 
 

tif 

TIFF 16 *1 tif 

Windows Bitmap 
 

bmp 

Sony PlayStation *1 tim 

SVG  svg 
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XPM *1 xpm 

 

1: For Windows > Maya Software, Maya Hardware, Maya Hardware 2.0, and Vector 

2: For Windows > Maya Software, Maya Hardware, and Maya Hardware 2.0 

3: For Windows > Vector 

4: For Mac > Vector 

5: Export of .avi files limited to a size of 2GB. 

6: Batch render to. exr using the Maya Hardware 2.0 renderer. Save your rendered 

image from any renderer to Open EXR from the Render View Window File > Save 

Image menu. 

 

 

Activities 

 
 
 

Activity 1: Understanding File Format Compatibility 

 

Materials Required: Computer with access to 3D modeling software (e.g., Maya, 

Blender), Image editing software (e.g., Photoshop, GIMP), Sample files in different 

formats (JPEG, PNG, TIFF, SVG, MP4), Internet access for research on file format 

plugins and documentation 

 

Procedure: 

Research File Format Specifications: 

• Identify and list the properties of each file format (e.g., JPEG, PNG, GIF, etc.). 

• Note the typical use cases, advantages, and limitations of each format. 

Test File Compatibility: 

• Open sample files in relevant software (e.g., import a PNG into a 3D modelling 

tool or open a TIF in an image editor). 

• Check if any plugins or additional settings are needed for importing specific 

file types. 

Evaluate File Behaviour: 

• Observe how each file format behaves in different software environments (e.g., 

does TIFF load with all properties intact in Maya?). 

• Note any issues or limitations encountered, such as unsupported variations 

of a format. 

Document Findings: 
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• Record results for each file format, detailing compatibility, required plugins, 

and any adjustments needed. 

• Summarize observations in a table for clear comparison between formats. 

 

Check Your Progress 

 

A. Multiple Choice Questions  
 

1. What is the default extension for a Maya Binary file? 

a) .ma 

b). mb 

c) .obj 

d). mel 

 

2. Which file format is commonly used for exporting UV snapshots for editing in 

Photoshop? 

a) .png 

b) .obj 

c). exr 

d) .jpg 
 

3. In Maya, which plugin is required for exporting OBJ files? 

a) objExport 

b) anim-Import-Export 

c) physx 

d) bullet.mll 

 

4. Which of the following file formats can be used for saving rendered images in Maya? 

a) .avi 

b) .tga 

c) .bmp 

d) All of the above 

 

5. Which of these file formats is used for saving a motion file in Maya? 

a) .mov 

b) .avi 

c) .gif 

d) .png 

 

6. Which extension is used for exporting a file in Maya ASCII format? 

a). mb 

b) .ma 

c) .mel 

d) .obj 
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Session 3: Trouble Shooting 

 
 
 

Troubleshooting is a systematic approach to problem-solving often used to identify 

and correct issues with complex machines, electronics, computers, and software 

systems. The first step in troubleshooting involves gathering information on the issue, 

such as undesired behaviour or a lack of expected functionality. The most important 

factor in troubleshooting is identifying the error and rectifying it by eliminating the 

issue involved in any of the functions. 

 

Texture Library 

 

Texture Library is a collection of pre-made textures that can be used in 3D modeling, 

animation, and visual effects projects. These libraries contain various surface 

textures, such as wood, metal, fabric, stone, and more, which can be applied to 3D 

models to enhance realism. 

 

An important task for successful texturing is the creation of a texture library. This 

holds true for professionals as well as independent or student animators. A thoroughly 

stocked texture library can save a tremendous amount of time and supply a great deal 

of diversity for any texturing project. 

 

A Texture library is generally stocked with three types of Bitmaps: photos, scans, and 

hand-painted maps. With current technology, high-resolution digital cameras and 

flatbed scanners are relatively inexpensive and should be part of an animator’s toolkit. 

Hand-painted Bitmaps, due to their labor-intensive nature, represent the pinnacle of 

texturing. Feature, visual effects, and game studios regularly employ full-time texture 

painters. Regardless, the best hand-painted textures usually start with photos and 

scans. 

 

Animators can either create their own Bitmaps, purchase them, or download them for 

free. Texture-library CDs, such as Total Textures are available with hundreds of 

images at a reasonable price. However, due to low resolutions and a lack of useful 

diversity, such library Bitmaps are generally inferior to those created independently. 

When using a pre-made library or downloading Bitmaps, awareness of copyright 

issues is essential. For photographing textures, it is advisable to avoid strong lighting 

situations to prevent heavy shadows or intense light colours that indicate the time of 

day.  

 

A bright, noonday sun is not the best light source for photographing a chunk of rusty 

metal or a brick wall. Instead, a bright but overcast day, where the light and shadows 

are diffuse, yields the best results.  

 

Ideally, the textures in a library should be usable in a wide range of 3D lighting 

situations, so their integral lighting should be neutral. Avoid wide-angle lenses, such 
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as 24mm or 28mm, as they introduce significant perspective distortion, making the 

resulting texture difficult to apply in Maya. 

 

In terms of texture resolutions, larger is better. Although scaling down an image is 

straightforward, scaling up can lead to quality-degrading artefacts. If possible, keep 

all Bitmaps between 512 and 2048 (2K) lines of resolution.  

 

Resolutions should be high enough to maintain quality during full-screen renders. 

When rendering for video, a 1024 texture resolution, which is twice the resolution of 

the 480 lines dedicated to standard television, is a safe.  

 

Textures created for 35mm feature films may reach resolutions as large as 4096 (4K) 

lines. For small items that will never appear close to the screen, such as a button or 

sticker, the resolution can be reduced to twice the number of vertical lines the texture 

might occupy. For example, a button on a character’s shirt may never take up more 

than 10 vertical lines in the render, so a 20×20-pixel size will suffice. 

 

Quick Texturing 

 

Tight production deadlines often necessitate quick texturing jobs. One method is to 

combine generic textures within Maya. The Colour Gain and Colour Offset attributes, 

common to every texture, provide an efficient means of achieving this. For example, 

combining a Bitmap featuring a clean brick wall with rusty metal and asphalt Bitmaps 

can yield a more complex and interesting result. 

 

Technically speaking, Colour Gain functions as a multiplier. Whatever is mapped to 

Colour Gain is multiplied by the Original Map. In contrast, Colour Offset acts as an 

offset factor; whatever is mapped to Colour Offset is added to the Original Map. Thus, 

Colour Gain Maps tend to darken the result, while Colour Offset Maps tend to lighten 

it, creating a washed-out appearance. 

 

Colouring Particles 

 

Particle texturing can be divided into two main categories: hardware-rendered and 

software-rendered. 

 

Hardware-rendered particles: It includes MultiPoint, MultiStreak, Points, Spheres, 

and Streak, which can be assigned to any material. However, only the colour 

information is utilized. Additionally, rendering must occur using the Hardware Render 

Buffer window or the Hardware renderer; otherwise, the particles will not appear. 

Although the texturing capability of hardware-rendered particles is limited, unique 

colours can be assigned to individual particles. 

 

Cloud and Tube particles must be assigned to a Particle Cloud material. The colour, 

transparency, and incandescence of Cloud and Tube Particles can be based on their 

lifespan by mapping a Ramp texture to the Life Colour, Life Transparency, and Life 
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Incandescence attributes of the assigned Particle Cloud material. 

 

 Maya automatically provides an Array Mapper utility and all the necessary 

connections. In contrast, Blobby Surface particles can be assigned to Lambert, Blinn, 

Phong, PhongE, and Anisotropic materials. Blobby Surface particles support all 

standard attributes of these materials, including specularity, transparency, and the 

application of Colour Maps. However, to colour Blobby Surface particles individually, 

a Particle Sampler utility must be connected to the particle network. 

 

 

Activities 

 
 

 

Activity 1: Arranging the texture   

 

Materials Required: Computer system, and Autodesk®Maya® 

 

Procedure: 

1. Create a Custom Texture Library: 

Begin by organizing a collection of textures that suit your specific project 

needs. This can include images, patterns, and other resources that you can 

reuse across multiple projects. 

 

2. Select the Textures: 

Choose textures that match the aesthetic or style you wish to achieve in your 

3D models. This might include a variety of materials such as wood, metal, 

fabric, stone, or any custom designs. 

 

3. Organize Textures into Categories: 

Arrange your textures into logical folders based on their types (e.g., rough, 

glossy, metallic, etc.), which will help streamline your workflow when 

accessing them during the modelling process. 

 

4. Import Textures into Autodesk® Maya®: 

Once organized, you can begin importing your textures into Maya. You can 

apply these textures to your models using the appropriate material nodes 

such as lambert, phong, or blinn, depending on the desired effect. 

 

5. Customize Textures if Needed: 

If necessary, adjust the textures within Maya to better fit your models. This 

may involve scaling, tiling, or editing their UV Mapping to ensure they blend 

seamlessly with the geometry of your 3D objects. 

 

6. Save and Back Up Your Texture Library: 

Ensure that your library is saved in a secure location and backed up 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

175 
 

                                                                     Texturing Artist - Grade XII  

regularly, especially if it contains textures you’ve customized or created. This 

will prevent the loss of valuable resources and ensure quick access in future 

projects. 

 

Check Your Progress 
  

A. Multiple Choice Questions  
 

1. What is the purpose of a Texture Library? 

a) To store textures for quick access during texturing 

b) To store 3D models 

c) To store rendered images 

d) None of the above 

 

2. What are the three types of Bitmaps commonly found in a Texture Library? 

a) Photos, videos, and scans 

b) Photos, scans, and hand-painted maps 

c) Photos, animations, and textures 

d) None of the above 

 

3. What should be avoided when photographing textures for a library? 

a) Overcast days 

b) Bright sunlight causing heavy shadows 

c) Nighttime lighting 

d) Diffuse light sources 

 

4. What resolution is considered optimal for textures in a library? 

a) 256 lines 

b) 512 to 2048 lines 

c) 1024 lines only 

d) 2048 to 4096 lines 

 

5. What feature in Maya helps speed up texturing by adjusting attributes like Colour 

Gain and Colour Offset? 

a) Texture Mapping 

b) Colour Gain and Colour Offset attributes 

c) Texture Library 

d) Particle Sampler 

 

6. Which of the following types of particles in Maya can be assigned materials such 

as Lambert, Blinn, or Phong? 

a) MultiPoint particles 

b) Cloud and Tube particles 

c) Blobby Surface particles 

d) Points particles 
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Answer Key 

  
 

MODULE 1: 3D ANIMATION 

 

Session 1: Mastering the Essential Skills Tutorial Window in Maya 

 

A. Multiple Choice Questions 

1. b 

2. c 

3. b 

4. a 

5. a 

6. c 

7. c 

8. b 

 

Session 2: Introduction to 3d Modelling 

 

A. Multiple Choice Questions 

1. b 

2. c 

3. b 

4. c 

5. b 

6. c 

7. c 

8. b 

 

Session 3: Texturing Using Shaders     

  

A. Multiple Choice Questions 

1. b 

2. c 

3. b 

4. c 

5. c 

6. b 

7. b 

8. b 

9. b 

10. b 
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Session 4: Maya Material 

 

A. Multiple Choice Questions 

 1. b 

2. a 

3. b 

4. b 

5. b 

6. b 

7. b 

8. b 

9. b 

10. a                                                           

 

Session 5: Real Life 3 D Model     

 

A. Multiple Choice Questions 

1. c 
2. b 
3. b 
4. c 
5. a 
6. b 
7. a 
8. b 
 

Session 6: Properties of Surface Materials   
 

A. Multiple Choice Questions              

1. b 
2. b 
3. b 
4. a 
5. b 
6. b 
7. b 

8. b 
9. a 
10. b 
 

Session 7: Effect of Lighting Conditions on Surfaces  
 

A. Multiple Choice Questions 

1. b 
2. b 
3. c 
4. b 
5. b 
6. b 
7. b 
8. a 
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MODULE 2: SURFACE SHADING AND MAPS 

 

Session1: Surface Shading and its Properties 

 

A. Multiple Choice Questions 

1. c 

2. d 

3. c 

4. b 

5. c 

6. c 

7. c 

8. b 

9.   b 

10. b  

 

Session 2: Shading Network  

 

A. Multiple Choice Questions 

1. b 
2. a 
3. b 
4. c 
5. b 
6. a 
7. b 
8. c 
9. b 
10. b 
 

Session 3: Creating and Assigning Material to Surface 

 

A. Multiple Choice Questions 

1. c 
2. b 

3. b 
4. b 
5. b 
6. b 
7. a 
8. b 
9. b 
10. c 
 

Session 4: Texture Maps  

 

A. Multiple Choice Questions 

1. c 
2. b 
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3. b 
4. b 
5. d 
6. b 
7. b 
8. b 
9. b 
10. c 

 

Session 5: UV Texture Mapping   

 

A. Multiple Choice Questions 

1. a 

2. c 

3. a 

4. d 

5. a 

6. b 

7. a 

8. d 

9. a 

10. a 

 

Session 6: Creating Bump Map   

 

A. Multiple Choice Questions 

1. a 
2. b 
3. a 
4. b 
5. d 
6. b 
7. b 
8. a 
9. a 
10. b 
 

Session 7: Specular Map 

 

A. Multiple Choice Questions 

1. c 
2. b 
3. b 
4. b 

 
Session 8: Creating Seamless Textures in Photoshop 

 

A. Multiple Choice Questions 

1. b 
2. d 
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3. b 
4. b 
5. a 
6. c 
7. c 
8. c 
9. b 
10. b 
 

MODULE 3: RENDERING, COMPOSITING AND FILE FORMATS 

 

Session1: Rendering and Compositing 

 

A. Multiple Choice Questions                             

1. b 
2. a 
3. b 
4. b 
5. b 
6. b 
7. b 
8. b 
9. c 
10. b 
 

Session2: Working with File Formats        

 

A. Multiple Choice Questions                      

1. b 
2. a 
3. a 
4. d 
5. a 
6. b 
 

Session 3: Trouble Shooting 

 

A. Multiple Choice Questions 

1. a 

2. b 

3. b 
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Glossary 

 

2-Sided Polygon: A polygon with two surface normals, facing opposite directions, 

like a playing card. 

3D Object: An entity with a position in 3D space; can be geometric objects (polygon 

meshes, curves) or special roles (camera, light). 

3D Studio Max (3ds Max): 3D Studio Max, now called 3ds Max, is a 3D modelling, 

animation, and rendering software developed by Autodesk. It is commonly used 

for creating 3D assets for games, film, architectural visualization, and product 

design.  

aiStandardSurface: It is a physically-based shader used in Autodesk Maya's 

Arnold renderer for creating realistic materials. It is part of the Arnold shading 

system and allows artists to create a wide range of materials with accurate light 

interaction. 

Alpha Channel: One of four pixel channels (RGB + alpha) specifying transparency, 

allowing foreground/background visibility when images are overlaid. 

Alpha is Luminance: Alpha is Luminance is an option in Texture Mapping that 

treats the grayscale value of an image as the alpha (transparency) channel. Instead 

of using the image's colour information to define transparency, the brightness or 

luminance of the pixels is used to control the transparency.  

Ambient Component: Part of the reflection-illumination model; simulates 

consistent ambient light across surfaces. 

Ambient Light: Uniform light illuminating objects from all directions. 

Animation: Creating sequential images to simulate continuous motion. 

Anti-aliasing: It is a technique used in computer graphics to reduce the visual 

defects, such as jagged edges (also known as "aliasing"), that occur when 

representing a high-resolution image in a lower-resolution format.  

Array Mapper: It is a tool or technique used to apply a function or transformation 

to each element in an array or list, and it creates a new array based on the results.  

Array: A set of ordered copies of an object in 3D space. 

Aspect Ratio: Ratio of an image's width to height (e.g., 4:3 for 35 mm slides). 



`  

PSS CENTRAL INSTITUTE OF VOCATIONAL EDUCATION, NCERT BHOPAL 

 

182 
 

                                                                     Texturing Artist - Grade XII  

Attribute Editor: The Attribute Editor is a central interface in Maya for viewing 

and editing the attributes of selected objects, materials, or nodes. In the context 

of texturing, it is used to fine-tune the attributes of shaders, textures, and other 

material components.  

Attribute Spread Sheet: The Attribute Spread Sheet is a powerful tool in Maya 

that allows users to view and edit attributes for multiple objects or nodes in a 

tabular format. This tool is particularly useful when working with large scenes or 

multiple objects that share the same material or texture.  

Autodesk Maya: It is a powerful 3D computer graphics software used widely for 

creating interactive 3D applications, animations, visual effects, and models. 

Ball: A sphere defined by user dimensions. 

Bevel: Softening sharp edges by extending object faces. 

Bit: Basic unit of data (1 or 0). 

Bitmap : It is a type of image file format that represents a digital image using a 

grid of individual pixels. Each pixel in the grid holds a specific colour value, which 

collectively makes up the complete image. The term Bitmap comes from the fact 

that the image is essentially a "map" of bits, where each bit or group of bits 

corresponds to the colour or grayscale value of a single pixel. 

Black Hole: A region in spacetime with gravity so strong that nothing can escape. 

Blending: Mixing multiple textures into a final texture. 

Blobby Surface: It refers to a type of surface representation used in 3D graphics 

and computer modelling, typically to create smooth, organic shapes. It is often 

used in modelling soft, gel-like, or organic forms, such as liquids, flesh, or other 

deformable objects. 

Bump Map: Illusion of surface depth created without altering the mesh. 

Byte: Unit of digital storage (8 bits). 

Camera: Device for capturing images; in 3D, it transforms scenes into visuals. 

Channel Box: The Channel Box is a panel in Maya where the most commonly used 

attributes (e.g., translation, rotation, scale, visibility) of a selected object are 

displayed and can be edited. For texturing artists, it is useful for quick 

adjustments to parameters like transparency, diffuse colour, and other basic 

material attributes that affect the object's appearance.  

Child Object: An object influenced by a "parent" object. 

Clipping: Excluding parts of graphics outside the camera viewport. 
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Clone: Tool for creating copies with variations. 

Compositing Department: It is a key part of the visual effects (VFX) pipeline in 

film, television, video games, and animation production. This department is 

responsible for combining multiple visual elements (such as live-action footage, 

computer-generated imagery (CGI), and other assets) into a final, cohesive image 

or shot.  

Compositing: Combining separate elements into a final image. 

Curve: Representation of curves in graphics (e.g., NURBS, Bezier). 

Decal: A decal is a design, image, or graphic that is printed onto a special paper 

or material, allowing it to be transferred and applied onto surfaces. Decals are 

often used for decoration or branding and can be applied to various materials like 

glass, metal, or plastic.  

Density: Mass per unit volume (d = M/V). 

Depth of Field: Range of distance in focus in an image. 

Depth Sorting: Ordering triangles by depth for proper rendering. 

Desaturate function: The Desaturate function in image editing and 3D texturing 

software converts a colour image into a grayscale image by removing all colour 

information while retaining the image's brightness values. This function reduces 

the saturation of an image to zero, effectively transforming it into black, white, and 

shades of gray.  

Diffuse Light: Result of direct illumination. 

Diffuse Map: Texture Map simulating painted surfaces. 

Dimension: Measure of spatial extent (width, height, length). 

Dimmer: A device used to lower the brightness of light fixtures. 

Directional Light: A light that shines evenly in one direction with parallel rays, 

also known as distant light. 

Displacement Map: Modifies the actual mesh to create detailed surface features 

like wrinkles and creases. 

Dolly: Movement of the camera along its line of sight in a straight line. 

Dots per Inch (dpi): Measurement of pixel density in an image, affecting image 

quality during resizing. 
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Edge Loop: A modeling technique that creates circular flows around features on 

organic shapes. 

Edge: A line connecting two points on a polygon, fundamental to polygon 

structure. 

Environment Map: Simulates reflections of the surrounding world without ray 

tracing. 

Extrude: Creates 3D objects from 2D shapes by adding depth. 

Face Normal: A line perpendicular to a face indicating its direction in one-sided 

polygons. 

Face: The polygon shape formed by bounding points; supports 3 or 4 vertices for 

subdivision. 

Fields: Components of interlaced video, with each field containing half the scan 

lines. 

Flag: A device to create shadows by blocking light from specific areas. 

Frame: A static image in animation; multiple frames create the illusion of motion. 

Frame-rate: Speed of displaying frames, expressed in frames per second (fps). 

Gamma-Correct Blending: When gamma correction is enabled, colours are 

adjusted according to a non-linear curve (often set to a gamma of 2.2). This means 

the texture's colours are processed to look consistent under different lighting 

scenarios and on various displays.  

Geometry: The points and structure of an object in 3D space, excluding nulls. 

Global Illumination: Image generation method that accounts for both direct and 

indirect light effects. 

Glow: An optical effect producing a fuzzy halo around light sources. 

Graphical User Interface (GUI): Visual interface allowing intuitive interaction 

between user and computer. 

Grayscale images: Grayscale images are images that contain varying shades of 

gray, with each pixel representing a specific intensity level.  

High Dynamic Range Image (HDRI): An image with a wide intensity range, 

capturing more detail in highlights and shadows. 

Hypershade: The Hypershade panel in Autodesk Maya is a powerful tool used for 

creating, editing, and managing materials, textures, and shaders for 3D models. It 
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is a visual node-based editor where you can create complex shading networks that 

define the appearance of your 3D objects. 

iClone: iClone is a 3D animation software developed by Reallusion, used for 

creating animated characters, scenes, and videos. It allows users to design and 

animate 3D characters, props, and environments with ease, offering real-time 

animation creation and rendering.  

JPEG (JPG): JPEG is a widely used Bitmap image format primarily designed for 

photographs and images with smooth colour transitions.  

Material: The underlying substance applied to objects, defining their appearance 

(e.g., wood, metal). 

Mesh: An object made up of triangular faces. 

Misss_fast_shader: This is a shader in Maya used primarily for rendering realistic 

skin. The misss_fast_shader is a part of Maya’s Mental Ray rendering system and 

is optimized for simulating subsurface scattering, which is a key property of 

materials like skin, wax, and marble.  

Motion Path: The trajectory an object follows during movement. 

Node: A fundamental graph element representing items like vertices and faces. 

NTSC: A video standard in the U.S. and Japan with a frame rate of 30 fps and a 

resolution of 720x486. 

Null: A non-renderable object used for manipulating 3D objects and Texture 

Mapping. 

NURBS: Non-Uniform Rational B-Splines, a mathematical model for curves and 

surfaces in graphics. 

Object: A model representing a real-world item in a scene. 

Opacity Map: Controls transparency based on pixel intensity; black is 

transparent, white is opaque. 

Opacity: The degree of transparency. 

Opaque Material: Materials like wood and metal that do not allow light to pass 

through. 

Optical Light Effect: Visual phenomena caused by bright light sources or 

refraction. 

Origin: The absolute center (0, 0, 0) of a 3D space. 
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outAlpha attribute: The outAlpha attribute is commonly used in 3D graphics and 

shading networks, particularly within programs like Autodesk Maya, to control the 

transparency or opacity of an object or material. 

PAL: A European video standard with a frame rate of 25 fps and a resolution of 

720x576. 

Particle Sampler: It is a tool or technique used to simulate, sample, or manipulate 

particles in various digital applications such as computer graphics, physics 

simulations, and procedural generation.  

Particles: 2D objects used in large quantities to create effects (e.g., rain, 

explosions). 

Pivot Point: The central point around which an object rotates or transforms. 

Pixel: The smallest unit of a digital image. 

Plane: A two-dimensional flat surface. 

PNG: PNG is a lossless image file format used for storing digital images.  

Polygon: A geometric shape with multiple faces; used in polygonal modeling. 

Primary Colours: Red, Green, and Blue (RGB); combine to create white light. 

Primitive: Basic geometric shapes like spheres and cubes used in modeling. 

Raytrace Options: It refers to settings in 3D rendering software that control how 

light rays are traced to simulate realistic lighting and shadows.  

Raytracing: A rendering technique for calculating reflections, refractions, and 

shadows. 

Reflection Map: Simulates reflections on surfaces without full ray tracing. 

Reflection: Light bouncing off a surface; varies based on material properties. 

Refraction Index: A value indicating how much light bends in a transparent 

material. 

Refraction: The bending of light as it passes through different media. 

Render Pass: Divides a scene into aspects (e.g., highlights, shadows) for rendering. 

Render: The process of generating an image from a 3D model with applied 

properties. 

Resolution: The detail of an image, defined by the number of pixels. 
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Riggers: The correct term is riggers (with an "r"). In 3D animation and modelling, 

riggers are professionals who create and set up the "rig" for characters or objects.  

Rigging: Preparing an object for animation by creating a bone structure. 

Rotoscoping: It is a technique used in visual effects (VFX) and animation where 

elements of a video or film are manually traced or cut out from a live-action scene 

to create a matte or mask.  

Rotoscoping: Tracing over video frames to create animation. 

Scattered: The deflection of light as it passes through a medium with particles. 

Seamless: Textures that tile without visible transitions. 

Settings: Configurations for various aspects of a project. 

Silhouette: It refers to the outline or shape of an object, typically viewed as a solid, 

dark shape against a lighter background. In 3D graphics and visual effects, the 

silhouette is often used to highlight the contour of an object, particularly when it 

is backlit or when the focus is on its shape rather than its internal details. 

Space: The three-dimensional area where objects exist. 

Specularity: The quality of surface reflections; determines how shiny an object 

appears. 

Spotlight: A light source projecting in a specific direction. 

Subdivision surfaces: Subdivision surfaces are a type of polygonal surface 

modelling technique used in 3D computer graphics to create smooth, curved 

surfaces by subdividing and refining a polygonal mesh (usually a low-resolution 

mesh) into a higher-resolution surface.  

Swatch label: It in 3D graphics, particularly in software like Maya, refers to a 

small preview or sample of a material, texture, or colour used to visually represent 

the properties of that material.  

Targa (TGA): It is a raster graphics file format that supports 32-bit colour, 

commonly used for rendering still images and video sequences. 

Texture Coordinates: Coordinates that define how a Texture Maps onto an object. 

Texture Map: A two-dimensional image applied to the surface of a 3D object. 

Texture Mapping: Projecting a 2D image onto a 3D surface for added detail. 

TIFF: TIFF is a flexible and highly versatile Bitmap image format commonly used 

in professional photography, desktop publishing, scanning, and printing. It 
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supports both lossless and lossy compression, allowing for high-quality images 

with either minimal or no loss of data.  

Timeline: A slider used to represent time in animation. 

Transformation: Changing the position, scale, or orientation of an object. 

Translucence: Allowing some light to pass through while obscuring details. 

UV Mapping: UV Mapping is a process in 3D computer graphics used to map a 2D 

image (texture) onto the surface of a 3D model.  

Viewport: The window displaying a 3D model in a specific projection. 

Wireframe: A visual representation of geometry using lines between vertices. 

X-Axis: The left-right axis in a three-dimensional coordinate system, typically 

representing horizontal movement. In 3D modeling and graphics, this axis runs 

from left to right when viewing a standard front-facing object. 

Y-Axis: The up-down axis in a three-dimensional coordinate system, usually 

representing vertical movement. This axis runs from bottom to top, helping to 

define height or vertical positioning in space. 

Z-Axis: The in-out axis in a three-dimensional coordinate system, representing 

depth. This axis runs from front to back, indicating how far an object or point is 

from the viewer's perspective. 

ZBrush: ZBrush is a digital sculpting software developed by Pixologic, primarily 

used for creating highly detailed 3D models.  
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